Copyright © 1990 Digital Research Inc. All rights reserved. No part of this publication may be reproduced, transcribed, stored in a retrieval system, or translated into any language or computer language, in any form or by any means, electronic, mechanical, magnetic, optical, chemical, manual or otherwise without the prior written permission of Digital Research Inc., 70 Garden Court, Box DRI, Monterey, California 93942.


PANTONE®*

PANTONE Computer Video simulations used in this product may not match PANTONE-identified solid color standards. Use current PANTONE Color Reference Manuals for accurate color.


Pantone Inc. is the copyright owner of PANTONE Color Computer Graphics and Software which are licensed to Digital Research Incorporated to distribute for use only in combination with Artline. PANTONE Color Computer Graphics and Software shall not be copied onto another diskette or into memory unless as part of the execution of Artline.

NOTICE TO USER

DIGITAL RESEARCH MAKES NO REPRESENTATIONS OR WARRANTIES WITH RESPECT TO THE CONTENTS HEREOF AND SPECIFICALLY DISCLAIMS ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR ANY PARTICULAR PURPOSE. Further, Digital Research Inc. reserves the right to revise this publication and to make changes from time to time to the content hereof without obligation of Digital Research Inc. to notify any person of such revision or changes.

This manual should not be construed as any representation or warranty with respect to the software named herein. Occasionally changes or variations exist in the software that are not reflected in the manual. Generally, if such changes or variations are known to exist and to affect the product significantly, a release note or README file accompanies the manual and the distribution disks. In that event, be sure to read the release note or README file before using the product.

*Pantone, Inc.'s check-standard trademark for color reproduction and color reproduction materials.
TRADEMARKS

Digital Research, Artline, and GEM are registered trademarks of Digital Research Inc. DR DOS, Presentation Team, GEM Artline, GEM Draw Plus, GEM Paint, ScanXpress, and the Digital Research logo are trademarks of Digital Research Inc. We Make Computers Work is a service mark of Digital Research Inc.

IBM is a registered trademark and VGA is a trademark of International Business Machines Corporation. Adobe and PostScript are registered trademarks of Adobe Systems Inc. Microsoft and Windows are registered trademarks of Microsoft Corporation. Compaq is a registered trademark of Compaq Computer Corporation. Bitstream is a registered trademark and Fontware is a trademark of Bitstream Inc. Aldus and PageMaker are registered trademarks of Aldus Corporation. Xerox is a registered trademark of Xerox Corporation. Ventura Publisher is a registered trademark of Ventura Software, a Xerox Company. Logitech and CLICK are trademarks of Logitech Inc. QMS is a registered trademark and ColorScript is a trademark of QMS, Inc. Fontographer is a registered trademark of Altsys Corporation. Times, Helvetica, and Palatino are registered trademarks of Linotype Corporation. ITC Avant Garde, ITC Bookman, ITC Zapf Chancery, and ITC Zapf Dingbats are registered trademarks of International Typeface Corporation.

If any other trademarks are mentioned herein, they are the property of their respective owners.

Artline User Reference Guide
Second Edition: November 1990
Contents

Preface

Documentation Set .................................................. xvi
Organization of This Guide ........................................ xvii
Notational Conventions .......................................... xviii
Developing Your Own Techniques ................................. xix
Bon Voyage .............................................................. xix

1 Introduction to Artline

Artline Screen ....................................................... 1-2
Basic Mouse Techniques ......................................... 1-8
Elements ................................................................. 1-10
   Stacks .............................................................. 1-10
File Types ............................................................ 1-11
Menus ................................................................. 1-12
   Displaying Menus and Choosing Commands .......... 1-12
   "Undisplaying" Menus ........................................... 1-13
   Unavailable Commands ....................................... 1-13
   Keyboard Commands ........................................... 1-13
Dialogs ................................................................. 1-14
   Moving Dialog Boxes .......................................... 1-19
Alerts ................................................................. 1-19
Using the Item Selector ......................................... 1-20

2 Toolbox

Selector Tool ......................................................... 2-2
Selecting Elements ................................................. 2-2
Selecting Overlapping Elements .............................. 2-4
Selection Techniques ............................................ 2-5
De-selecting Elements .......................................... 2-6
Scaling Elements ........................................... 2-7
Moving Elements .......................................... 2-8
Copying Elements .......................................... 2-9
Moving the Guide Lines ................................. 2-10
Selector Options ........................................... 2-11
Using Other Tools as a Selector ..................... 2-12
Layer Tool .................................................. 2-13
  Active Layer ............................................. 2-13
  Adding Layers ......................................... 2-13
View Tool ................................................... 2-14
  Preset Views ........................................... 2-14
  Custom Views ........................................... 2-16
Magnifier Tool ............................................. 2-17
Drawing Tools ............................................. 2-19
  Default Color and Line Attributes .................. 2-19
  Anchor Points ......................................... 2-20
  Maximum Number of Points ......................... 2-20
  Automatic Closure of Non-Hollow Elements .... 2-21
Quill Tool .................................................. 2-22
  Elements Drawn with the Quill ....................... 2-22
  Drawing Curves ........................................ 2-23
  Closing Elements ..................................... 2-24
  Drawing Polygons .................................... 2-25
  Drawing Elements that Combine Curves and Lines 2-25
  Additional Techniques ................................. 2-26
Sketch Tool ............................................... 2-28
Trace Tool ................................................ 2-29
Text Tool ................................................. 2-30
  Create Text Element Dialog ......................... 2-31
  Symbol and Wombat Characters ..................... 2-35
Rectangle Tool ........................................... 2-36
  Drawing with the Rectangle Tool ................... 2-36
  Rectangle Options .................................... 2-38
Rounded Rectangle Tool ............................... 2-38
Circle Tool ............................................... 2-39
  Drawing with the Circle Tool ....................... 2-39
Line Tool ................................................. 2-41
  Line Options .......................................... 2-41
### Using the Color Tools
- Assigning Colors or Fountains
- Hollow Elements
- Creating New Colors or Fountains
- Setting Color Tool Options
- When to Set Color Tool Options

### Line Width Tool
- Setting Line Width
- Setting Line Attributes

### Rotator Tool
- Rotator Options

### Plane Tool
- Selecting Points
- Moving Anchor Points
- Editing Curves
- Plane Tool Pop-Up
- Copying Portions of a Curve

### Thumbtack

### Flipper

### Rolling Pin

### File Menu

<table>
<thead>
<tr>
<th>Command</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Abandon/Save Alert</td>
<td>3-2</td>
</tr>
<tr>
<td>New Command</td>
<td>3-2</td>
</tr>
<tr>
<td>Open Command</td>
<td>3-3</td>
</tr>
<tr>
<td>Merge File Command</td>
<td>3-4</td>
</tr>
<tr>
<td>Save Command</td>
<td>3-5</td>
</tr>
<tr>
<td>Save As Command</td>
<td>3-6</td>
</tr>
<tr>
<td>Export Command</td>
<td>3-7</td>
</tr>
<tr>
<td>Abandon Command</td>
<td>3-9</td>
</tr>
<tr>
<td>Page Layout Command</td>
<td>3-10</td>
</tr>
</tbody>
</table>
PostScript Command ........................................... 3-13
PostScript Output Dialog ................................. 3-13
PostScript Screen Options ............................... 3-17
To App Command ............................................. 3-21
To Output Command ....................................... 3-24
Quit Command ................................................. 3-24

4 Image Menu

Load Image Command ......................................... 4-1
Valid Image File Formats .................................. 4-2
Unload Image Command ..................................... 4-3
Image Options Command .................................. 4-3

5 View Menu

Image Command ................................................ 5-2
Colors Command .............................................. 5-2
Fountains Command ......................................... 5-3
Rulers Command ............................................. 5-3
Status Line Command ....................................... 5-4
Grid Command .................................................. 5-6
Snap to Grid Command ..................................... 5-6
Set Grid Command ............................................ 5-7
Guide Lines Command ...................................... 5-8
Set Guide Lines Command ................................ 5-9
Toolbox Command ............................................. 5-10

6 Element Menu

Send to Back Command ...................................... 6-2
Bring to Front Command ................................... 6-2
Step in Back Command ..................................... 6-2
Step in Front Command .................................... 6-2
Lock Command .................................................. 6-4
Unlock Command ............................................. 6-4
Group Command ................................................. 6-5
7 Edit Menu

Undo Command .............................................. 7-2
Cut Command .................................................. 7-2
  Paste Buffer .................................................. 7-2
Copy Command ............................................... 7-3
Paste Command .............................................. 7-3
  Cutting and Pasting Between Files or Layers ....... 7-3
Delete Command ............................................. 7-4
Select All Command ........................................ 7-4
Duplicate Command ......................................... 7-5
Clone Command .............................................. 7-5
Move Command ................................................ 7-6
Rotate Command ............................................. 7-7
Scale Command ............................................... 7-9
Repeat Command ............................................. 7-12

8 Combine Menu

Mask Command ............................................... 8-1
Merge Elements Command ................................ 8-4
  Creating a Window ......................................... 8-6
  Creating Text Characters ................................ 8-7
Blend Command ............................................... 8-8
Text Along Path Command ................................ 8-14
  Text Along a Path Dialog ................................ 8-14
  Changing Options ......................................... 8-17
  Editing Text Along a Path ................................ 8-17
Convert to Curves Command ................................. 8-18
  Text Elements and Text Along a Path .................. 8-18
  Blends ....................................................... 8-19
Split Element Command .................................... 8-20
9 Options Menu

Preferences Command .................................................. 9-2
Save Preferences Command ............................................. 9-5
  Restoring the Original Defaults .................................... 9-6
Layer Manager Command ................................................. 9-6
Color Manager Command ................................................ 9-6
Font Manager ............................................................... 9-7
Tools Manager Command ................................................ 9-10

10 Layers

Layer Tool and Layer Manager ......................................... 10-2
  Displaying the Layer Manager ....................................... 10-2
Layer List ................................................................. 10-3
Activating Layers ......................................................... 10-3
Adding Layers ............................................................. 10-4
Changing Layer Order ................................................... 10-5
Copying and Moving Elements Between Layers ..................... 10-6
Combining Elements into a Single Layer ............................. 10-6
Slides ........................................................................... 10-8
  Creating Slides ............................................................ 10-8
  Printing Slides ............................................................. 10-11
  Slide Shows on the Screen ............................................. 10-12
Layer Manager Command Reference .................................. 10-13
Edit Menu ..................................................................... 10-13
  Add Layer Command ..................................................... 10-13
  Modify Layer Command ................................................. 10-14
  Remove Layer Command ................................................. 10-14
  Close Command .......................................................... 10-14
Display Menu ..................................................................... 10-15
  All Command ............................................................... 10-16
  Active Command .......................................................... 10-16
  Visible Command ........................................................ 10-17
  Slides Command .......................................................... 10-19
  Auto Redraw Command ............................................... 10-20
  Redraw Command ........................................................ 10-20
11 Image Tracing

Image Files and Vector Files ........................................ 11-1
Autotracing and Hand Tracing ........................................ 11-2
Loading Images ......................................................... 11-2
  Image Frame .......................................................... 11-3
Image Options .......................................................... 11-4
  Saving Image Options ................................................ 11-6
Autotracing ............................................................... 11-7
  Tracing Options ...................................................... 11-7
  Autotrace Direction .................................................. 11-9
  Autotracing Techniques .............................................. 11-10
Trace Segments ........................................................ 11-11
Stopping Autotrace ..................................................... 11-12
Preview Curve Dialog ................................................ 11-12
Tracing Grayscale Images .......................................... 11-14
Hand Tracing ........................................................... 11-16
  Tips for Hand Tracing .............................................. 11-17

12 Color Manager

Colors and Fountains .................................................. 12-2
  Colors ............................................................... 12-2
  Fountains .......................................................... 12-2
  Color and Fountain Availability ................................ 12-3
  Color Files ........................................................ 12-3
  Picture Colors and Fountains .................................... 12-4
  Unaffiliated Colors and Fountains .............................. 12-4
Color Models .......................................................... 12-5
  CMY Color Model .................................................. 12-5
  RGB Color Model .................................................. 12-6
  HSB Color Model .................................................. 12-6
  Comparison of Color Models .................................... 12-8
  Converting CMYK Colors to CMY ................................. 12-8
Creating and Modifying Colors .................................. 12-9
  Creating Colors ................................................... 12-9
  Modifying Colors .................................................. 12-10
Adding Colors to Color Files .................................. 12-11
Removing Colors from Color Files ............................. 12-11
Creating and Modifying Fountains .............................. 12-12
Creating Fountains .............................................. 12-12
PostScript Fill Options ........................................ 12-15
Modifying Fountains ............................................ 12-18
Adding Fountains to Color Files ............................... 12-19
Removing Fountains from Color Files .......................... 12-19
Creating Color Files ............................................ 12-20
PANTONE Colors ................................................ 12-21
Color Manager Command Reference ............................. 12-23
File Menu .......................................................... 12-23
  Reset Command ............................................... 12-23
  Load Command ............................................... 12-23
  Merge Command ............................................... 12-24
  Save Command ............................................... 12-24
  Save As Command ........................................... 12-24
  Close Command ............................................. 12-24
Edit Menu .......................................................... 12-25
  Delete Command ............................................. 12-25
  Duplicate Command ....................................... 12-25
  Add Color/Fill Command ................................ 12-26
  Modify Command ........................................... 12-26
View Menu .......................................................... 12-27
  Colors Command ........................................... 12-27
  Fills Command ............................................. 12-27
  Sort by Name Command ................................ 12-28
  Sort by Hue Command .................................. 12-28
  Sort by Bright Command ................................ 12-28

13  Tools Manager

  Tools Manager Functions ..................................... 13-2
  Tools Files .................................................. 13-2
    Default Toolbox ......................................... 13-2
    Tools File Backups ...................................... 13-3
Toolbox Design .................................................. 13-3
Toolbox Size .................................................... 13-3
Tool Arrangement ............................................... 13-4
Custom Tools ...................................................... 13-4
  Standard Tools ............................................... 13-4
  Menu Tools ................................................... 13-5
  Container Tools ............................................... 13-5
Creating Tools .................................................. 13-6
  Standard Tools and Menu Tools ............................. 13-6
  Container Tools ............................................... 13-7
Tool Attributes ................................................ 13-9
Icon Editor ...................................................... 13-12
  Basic Drawing Techniques .................................. 13-15
Tools Manager Command Reference ....................... 13-18
File Menu .......................................................... 13-18
  Reset Command ............................................... 13-18
  Load Command ............................................... 13-19
  Save Command ................................................. 13-19
  Save As Command ............................................ 13-19
  Close Command ............................................... 13-20
Edit Menu ........................................................ 13-20
  Add Command ................................................. 13-20
  Delete Command .............................................. 13-20
  Duplicate Command ......................................... 13-21
  Attributes Command ......................................... 13-21
  Function Command ........................................... 13-22
  Icon Command ................................................ 13-22
  Organize Command .......................................... 13-22

A                       Resident PostScript Fonts
B  Artline and Memory

Memory and Disk Requirements ........................................... B-1
  Not Enough Memory ....................................................... B-2
Expanded Memory .......................................................... B-2
Paging Files ..................................................................... B-3
  Lost Clusters ................................................................... B-3
Memory Status ................................................................. B-3

C  Custom Toolboxes

1_COLUMN.TLS ................................................................. C-2
4_COLUMN.TLS ................................................................. C-3
ALIGN.TLS ..................................................................... C-4
CUSTOM.TLS ................................................................. C-6
TRACE.TLS ..................................................................... C-8

Index
Preface

THE Artline User Reference Guide provides detailed descriptions of the many features of Version 2.0 of Artline®, the most productive graphics illustration program for the IBM® PC, Compaq®, and other PC-compatible computers.

Artline offers features and speed, which, combined with your own creativity, add up to outstanding graphics for business and design professionals, full-time or part-time—someone like you, who needs a full range of tools for any kind of design challenge.

Artline, Version 2.0, is an entirely new program, although it shares some features with its predecessor, GEM® Artline™. New features in this version of Artline include:

- interactive autotracing
- layers
- custom tools
- custom color management
- full PostScript® font support
- masking, merging, and blends
- text along a path
- extensive clip art selection
The Artline documentation set includes these books:

- **Artline User Reference Guide**

- **Artline Installation/Startup/Tutorial**
  This book is actually three books in one, containing instructions on how to install Artline on your system, how to start Artline (including starting Artline from Microsoft® Windows®), and a tutorial that introduces you to most of the features of Artline, Version 2.0.

- **Artline Utilities Guide**
  This book describes three Artline utilities:
  - The filter programs for converting fonts from the Bitstream® .PFA, Adobe® Type 1, and Fontographer® formats to the Artline .AF4 format.
  - The Output program, with which you can print or display your Artline files and save “output lists” of files for future printing or display.
  - The MAGICorp® service, which you use in combination with Output to produce slides, overhead transparencies, and photographic prints of your Artline pictures.

- **Artline Clip Art Gallery**
  This book contains illustrations of the over 200 pieces of clip art included in the Artline package, as well as information on how to order additional pieces from the vendors represented.
Organization of This Guide

The *Artline User Reference Guide* is not meant to be read from beginning to end. It is intended primarily to be used as a “dictionary,” to look things up as questions arise. Using the Index and the chapter listings in the Contents, you should be able to find the information you need at the moment you need it.

The following is an overview of the contents of the *Artline User Reference Guide*:

- Chapter 1, “Introduction to Artline,” describes several of the basic features and concepts used in Artline.
  
  If you have used other programs with a similar user interface—for example, GEM Artline or GEM® Draw Plus™—some of the information in this chapter may be familiar to you. However, make sure you are familiar with all the material in this chapter, as several of the key features are new and unique to this version of Artline.

- Chapter 2 describes the tools in the Artline toolbox. These are the tools you use to draw, enter text, assign and create colors, and perform many of the special graphics editing functions of the program.

- Chapters 3 through 9 describe the commands in each of Artline’s menus. Each menu has a chapter to itself.

- Chapters 10 through 13 describe additional important features of Artline: layers, autotracing, color management, and tools creation and management.

- Appendix A lists the names of the Artline fonts that correspond to the resident PostScript fonts.

- Appendix B describes how Artline uses memory. Note that expanded memory (EMS) is *not* required for tracing.

- Appendix C illustrates and describes the custom toolboxes provided with Artline.
Notational Conventions

This section describes the notational conventions employed in the Artline User Reference Guide.

Bullets

Bullets (•) set off a list of items or a set of equally valid options or choices. Bullets do not indicate a sequence of steps to be followed.

Instructions

Instructions are preceded by a brief statement of what you will be doing, followed by a single instruction, bullets (indicating options), or a numbered sequence of steps. Below are examples of the three possibilities.

To do this action:

You can do only this one thing.

To do this action:

You can do option #1.
You can do option #2.

To do this action:

You must do this step first.
You must do this step next.
You must do this step third in the sequence.

Return Key Symbol

The symbol ↓ represents the computer's Return (or Enter) key.

Marginal Notations

The guide frequently uses marginal notations (like those used above) to provide additional information, supplementing the information contained in the main text body.
Developing Your Own Techniques

The *Artline User Reference Guide* provides specific instructions on how to do many things with Artline, Version 2.0. However, as you gain familiarity with the program, you will certainly develop your own techniques. Feel free to experiment and to learn.

One word of caution (if you’re an experienced user, you don’t need to be reminded of this): *save your files* before you branch off into uncharted waters.

Bon Voyage

Welcome to Artline, Version 2.0.

We hope you find this exciting program the perfect outlet and the ideal medium for your creative work.
Introduction to Artline

THIS chapter describes some of the basic concepts, terms, and techniques that apply throughout Artline, including:

- components of the Artline screen
- basic mouse techniques
- elements
- file types
- menus
- dialogs and alerts
- the Item Selector
This section describes the components of Artline’s screen as it appears when you first start the program.

Artline Window

The Artline screen includes a window that can be moved and whose size can be changed. The window is bordered by the title bar, toolbox, and scrollers.

Toolbox

The toolbox contains icons (pictures) of the tools with which you can draw and manipulate the elements that make up your Artline pictures.

The standard Artline toolbox is described in Chapter 2. You can also use Artline’s Tools Manager to create your own custom tools and save custom toolboxes. The Tools Manager is described in Chapter 13.
Menu Bar

The menu bar contains the names of Artline's command menus.

Basic menu techniques are described on page 1-12. The commands in each menu are described in Chapters 3 through 9.

Title Bar

The title bar contains the name of the file currently open on the drawing surface.

If you have not opened a file or have not named the picture you are working on, the title bar reads UNTITLED.

The title bar also lists the name of the picture's active layer. Layers are described in Chapter 10.

Moving the Window

You can move the window down or to the right. To move the window, drag the title bar. You cannot move the window off the left side of the screen or up into the menu bar.
In these two views, the workspace entirely encloses the drawing surface.
Workspace, Drawing Surface, and Surround

The *workspace* and the *drawing surface* are not the same thing. One way of stating it is that you draw *in* the workspace, but you draw *on* the drawing surface.

The workspace is the area of the screen enclosed by the title bar, toolbox, and scrollers. It is like a frame, through which you view the drawing surface.

The drawing surface is where your picture is actually created, like a piece of paper of certain dimensions.

The *surround* is the area surrounding the drawing surface. You can place elements and reference points like the Thumbtack in the surround.

The amount of drawing surface visible in the workspace at a given time can vary considerably. You can zoom in so that only a small portion of the drawing surface is visible, and you can zoom out so that the entire drawing surface is visible.

*In this view, the workspace encloses only a portion of the drawing surface.*
Scrollers

Scrolling is only meaningful when some of the drawing surface is not visible in the workspace. In that case—for example, when you have zoomed in on the drawing surface—the scrollers allow you to bring other parts of the drawing surface into view in the workspace frame.

The scrollers consist of:

- arrows (up and down, left and right);
- scroll bars;
- sliders.

Arrows

To scroll a small, fixed distance in a given direction, click on the appropriate arrow. For example, to scroll toward the top of the drawing surface, click on the up-arrow.

Scroll Bars

To scroll a larger distance (roughly one screen’s worth) in a given direction, click on the scroll bar.
Sliders

The sliders serve two purposes:

- They allow you to scroll as much or as little as you like. To use a slider, drag it in the direction you want to scroll. For example, you can use the vertical slider to scroll quickly to the top or bottom of the drawing surface, or you can use it to adjust the position of the drawing surface in the workspace.

- They also indicate how much of the drawing surface is visible in the workspace. If the slider entirely fills the scroll bar, the drawing surface is entirely visible in that direction. If the slider half fills the scroll bar, half of the drawing surface is visible in that direction.

Size Box

By dragging the size box, you can change the window's size, making it smaller or larger.

Full Box

Clicking on the full box returns a window to its full-screen size.

Redrawing the Screen

To force a screen redraw, press the Esc key.
Basic Mouse Techniques

If you are familiar with these techniques, you can skip this section.

Artline uses three basic mouse techniques:

- click
- double-click
- drag

NOTE: All three techniques use only the left button of the mouse.

Click

To click the mouse, press and immediately release the left button.

In Artline, clicking is used for selecting elements and tools, choosing commands, selecting options in dialogs, and many other tasks. The click affects whatever is directly under the tip of the mouse pointer.

Double-Click

To double-click the mouse, press and release the left button twice in rapid succession.

In Artline, double-clicking is used for selecting files, displaying tool options dialogs, and a variety of other tasks. The double-click affects whatever is directly under the tip of the mouse pointer.
Drag

_Dragging_ is a technique that is used for—among other things—drawing with Artline’s drawing tools, placing a selection frame around elements, and moving elements.

To drag with the mouse:

1. With the pointer at the starting point (see the illustration below), press and hold down the left button.
2. With the button still down, move the mouse to the end point.
3. Release the mouse button.

In this case, the mouse pointer has dragged a selection frame around the drawing of the guitar.
Elements

The individual pieces of the pictures you create in Artline are *elements*.

Elements can range from simple geometric shapes like circles and squares to complex forms made of connected lines and curves. Text characters are one example of the more complex kinds of elements.

Stacks

In most respects, the drawing surface is like a sheet of paper. However, it differs from a sheet of paper in that the elements in your picture sit on the drawing surface in a *stack*, one element on top of another. Each time you add a new element, it is placed on top of the stack.

The only time you really need be concerned with elements stacks is when elements overlap each other (see the exploded view of the guitar above). In that case, the position of an element in the stack determines how you select it (described in Chapter 2). In addition, you can change the position of the element in the stack (Chapter 6).
File Types

Artline uses many different extensions to identify the kinds of files associated with the program. The following table gives a brief description of each file type.

<table>
<thead>
<tr>
<th>extension</th>
<th>description</th>
</tr>
</thead>
<tbody>
<tr>
<td>.GEM</td>
<td>An Artline picture file. Also an exported file format. Several other programs create files with the .GEM extension. Some can be opened in Artline (those created by GEM Draw Plus, for example), while others (those created by GEM® Paint™) result in an empty drawing surface.</td>
</tr>
<tr>
<td>.COL</td>
<td>A color palette file.</td>
</tr>
<tr>
<td>.TLS</td>
<td>A tools file.</td>
</tr>
<tr>
<td>.IMG, .TIF, .PCX</td>
<td>An image format valid for tracing.</td>
</tr>
<tr>
<td>.C00</td>
<td>The PostScript File output format.</td>
</tr>
<tr>
<td>.GMP</td>
<td>An exported multiple-page format.</td>
</tr>
<tr>
<td>.AF4</td>
<td>The Artline font file format. Do not confuse with .AFF, the GEM Artline font file format. See the Artline Utilities Guide.</td>
</tr>
</tbody>
</table>
Menus

This section describes some of the basic Artline menu command techniques, including:

- displaying menus
- choosing commands
- keyboard commands

Chapters 3 through 9 describe the commands in each of the menus.

Displaying Menus and Choosing Commands

To display menus and choose commands, move the pointer to the menu bar. Depending on your choice in the Preferences dialog (see the description of the Preferences command in Chapter 9), the menus can operate as either drop-down or pull-down menus.

Drop-Down Menus

To display the menu, touch the menu’s name with the pointer. The menu automatically drops down from the menu bar.

To choose a command, click on its name in the menu.

Pull-Down Menus

When menus are set to Pull-Down, you can display menus and choose commands in either of two ways:

- Click on the menu name to make the menu appear and then click on the command name.
- Press and hold down the mouse button over the menu name, and then drag through the menu until the command you want is highlighted (white letters on a black background). To choose the command, release the mouse button over the highlighted command name.
“Undisplaying” Menus

If you accidentally display a menu (often because your menu preference is set to Drop-Down and you’ve made a random mouse excursion into the menu bar), move the pointer out of the menu and click. The menu will go away, and you will not inadvertently execute a command.

Unavailable Commands

Commands that are dimmed (that don’t become highlighted) are unavailable and cannot be selected. A command is unavailable when its action is not meaningful.

For example, if you have not grouped any elements, the Ungroup command (Element menu) is unavailable because there is nothing to ungroup.

Keyboard Commands

You can choose many of Artline’s commands directly from the keyboard. These keyboard commands are listed in the menu to the right of the command name. The Ctrl key is represented by a caret (^); the Alt key is represented by a diamond (♦).

For example, the keyboard equivalent of the New command is ^W, which means you hold down the Ctrl key as you press W. The keyboard command for Cut is ♦X—hold down the Alt key as you press X.

If a menu command is unavailable, its keyboard equivalent is also unavailable.
Dialogs

A *dialog* is a box that appears on the screen, often when you choose a command. Dialogs are used for many purposes, including specifying the size and orientation of your page, creating colors, and moving or scaling elements by precise amounts.

This section describes these components of dialogs:

- radio buttons
- check boxes
- direct entry fields
- pop-up sliders
- pop-up menus
- exit buttons

Radio Buttons

*Radio buttons* are so named because they resemble the station selector buttons on a car radio. One button must always be chosen, and choosing a new button automatically cancels the previous choice.

Radio buttons are identified by a circle. The selected option is indicated by the solid dot inside the circle.

In the Text Along a Path dialog illustrated above, there are three Text Scaling options: None, Change Spacing to Fit, and Change Size to Fit. In the illustration the None option is selected. If you click on Change Size to Fit, the dot moves to indicate your new selection (see left).
Check Boxes

A check box is like a light switch: it turns something on and off.

Check boxes are identified by a square. When the check box is turned on, the square is filled with an X.

Show Path
on

Show Path
off

In the Text Along a Path dialog illustrated on the previous page, there are two check boxes—one for Show Path and the other for Rotate Text Around Path. Either state can be on or off completely independently of the other. For example, turning the Show Path option on has no effect on whether the text is oriented to the path.

Direct Entry Fields

A direct entry field is one in which you can type directly into the field. As soon as you start typing, the field is automatically cleared, and your entry appears.

Active Field

The active field is the one in which your entry appears. Only one direct entry field can be active at a time.

On color screens the active field is identified by a light blue background. On monochrome screens ("black and white"), the active field has white letters or numbers on a black background.

Moving From Field to Field

You can make another field active by:

- clicking on it with the mouse;
- pressing the Tab or down-arrow key to move to the next field; pressing the up-arrow key to move to the previous field.
Types

There are two kinds of direct entry fields: text and numerical. Each type is represented in the illustration of the Add Color dialog.

- Color Name is a text direct entry field; it accepts text—letters or numbers.
- % Red, % Green, and % Blue are all numerical direct entry fields. They accept numbers only.

Numerical direct entry fields are associated with pop-up sliders, described on page 1-17.

NOTE: The range of values accepted by numerical direct entry fields varies according to the field's function. If you type a value that is too large or too small for the given field, Artline displays an alert and then automatically resets the value to the allowed maximum or minimum.

Text Field Editing Keys

To move the cursor in a text direct entry field, press the left-arrow or right-arrow keys on the numeric keypad. To delete the character to the left of the cursor, press the Backspace key.

Numerical Field Editing Keys

You can change the value in an active numerical field by pressing these keys:

- The plus (+) key on the numeric keypad increases the value; the minus (-) key decreases the value. The amount of change varies from one field to another, depending on the field's range of values.
  
  Holding down the Shift key as you press the plus or minus key changes the value by a smaller amount.

- The PgUp key automatically sets a field to its maximum value; the PgDn key sets the field to its minimum value. If the field is already set to its maximum or minimum, the key clears the field instead.
Pop-up Sliders

You can also enter values into numerical direct entry fields by using the pop-up sliders.

To display a pop-up slider, move the pointer to the field you want and press the mouse button.

As you drag the pop-up slider’s handlebar, the values appear in the field.

If you press the Shift key as you drag the slider, the values change by smaller increments.

In most cases the pop-up sliders can enter values only in set increments—like 10%, 20%, 30%, and so on. To enter a value of 18%, you must type it into the field.

Pop-up Menus

Many dialogs also use pop-up menus to offer a choice of several options. Pop-up menus are identified by a downward-pointing arrow at the right end of the menu bar.

To display a pop-up menu and choose an option, you can:

- click on the pop-up menu bar (to display the menu) and then click on the option you want;
- press and hold down the mouse button over the menu bar (to display the menu), move the pointer through the menu until the choice you want is highlighted, and then release the mouse button.
Dialogs

Exit Buttons

Each dialog has a pair of exit buttons—labeled OK and Cancel—with which you close the dialog.

If you click on the OK button, the options and values in the dialog are put into effect.

If you click on the Cancel button, the options and values in the dialog are discarded and nothing is changed.

Exit Button Keystrokes

In addition to clicking on an exit button with the mouse, you can use the keyboard to exit Artline’s dialogs.

- To choose an exit button that has a heavy outline (usually the OK button), press J.
- To choose the Cancel button, press the Esc key.

Layer Manager, Color Manager, and Tools Manager

The Layer Manager, Color Manager, and Tools Manager are special kinds of dialogs that have menus instead of exit buttons. To close these dialogs, choose the menu Close command or click on the dialog’s close box.

NOTE: In this guide, the phrase “exit the dialog” indicates that you should accept the settings in the dialog and exit, usually by clicking on OK or pressing J.
Moving Dialog Boxes

You can move dialog boxes so you can see the drawing surface underneath.

To move a dialog box:

Place the pointer on the dialog's title bar and drag the dialog where you want it.

The next time you display that dialog in the current Artline work session, it will appear where you last left it.

The next time you start Artline, the dialog will appear in its default location.

Alerts

Artline uses alerts to display error messages and messages requesting additional information or instructions.

Exit Buttons

To exit an alert, click on the appropriate exit button or use the keyboard as follows:

- To choose an exit button that has a heavy outline (usually the OK button), press .
- To choose the Cancel button, press the Esc key.
Using the Item Selector

The Item Selector is a special dialog used for opening, loading, and naming files. The Item Selector is displayed by several commands, including:

- **Open** (File menu)
- **Save As** (File menu)
- **Load Image** (Image menu)
- **Save As** (Color Manager’s File menu)
- **Save As** (Tools Manager’s File menu)

The illustration below shows the Item Selector and its components:
List Window and Directory Line

The list window identifies the subdirectories and files contained in the current directory. Subdirectory names (if any) always appear first in the list and are marked with a diamond.

The Directory line identifies:

- the current disk drive;
- the current directory;
- the filename and extension specification for the names listed in the window. For example, the Directory line

  C:\ARTLINE\ARTWORK\*.GEM,*\ EPS

tells you that the list window contains the names of all files with the .GEM or .EPS extension in the directory \ARTLINE\ARTWORK on drive C.

The list window can display nine names at a time. You can scroll the window with the arrows, scroll bars, and slider (see page 1-6).

Wildcards

You can use the asterisk or question mark wildcard characters in the filename or extension specification. The asterisk wildcard takes the place of as many as eight characters; the question mark wildcard takes the place of a single character.

<table>
<thead>
<tr>
<th>wildcard</th>
<th>what it means</th>
</tr>
</thead>
<tbody>
<tr>
<td>B*.GEM</td>
<td>all .GEM files whose filename starts with B, like B.GEM, BEAR.GEM, or BROTHERS.GEM</td>
</tr>
<tr>
<td>*.?OL</td>
<td>all files with a three-character extension ending with “OL”</td>
</tr>
</tbody>
</table>
Using the Item Selector

Editing Keys

When the Item Selector first appears after you choose a command, its text cursor is in the Selection line. To move the cursor to the Directory line, you can:

- click on the Directory line;
- press the up-arrow key.

To move the cursor in the Directory line, use the left-arrow and right-arrow keys. To delete characters, use the Backspace and Del keys. To clear the entire line, press Shift-Del.

Changing the Directory Path

To open or load a file from a directory or disk other than the current one, or to save a picture to another directory or disk, you must first change the directory path in the Item Selector.

- To move down a level in the directory tree, to a subdirectory below the current directory, click on the subdirectory's name in the list window.
- To move up, toward the root directory, click on the Item Selector's close box. Each click on the close box moves you up one level in the directory tree.
- To change to another disk drive, go to the root directory and then click on the close box once more. The disk drive identifiers now appear in the list window. Click on the identifier for the disk you want. The contents of that disk’s root directory will appear in the list window. You can then click on subdirectory names to move down the directory tree of the new disk.
Choosing a File

When opening or loading a file, you must choose its name from the current directory in the Item Selector. There are three ways you can do this:

- Double-click on the file’s name in the list window. The name is chosen, and you automatically exit the Item Selector. This is usually the fastest way to choose a name.

  If the name is not initially visible in the list window, scroll the window to bring the name into view.

- Click on the file’s name in the list window to make the name appear in the Item Selector’s Selection line. To put this selection into effect, press ↓.

- Type the filename into the Selection line and then press ↓.

Naming a File

When providing a name for a new file the first time you save, you must type the name into the Selection line.

You need not, however, type the extension. When saving a picture file for the first time, Artline automatically supplies the .GEM extension. Similarly, these other extensions are automatically supplied: .C00 or .EPS (PostScript file output, depending on the format chosen), .COL (color files), .TLS (tools files), and .GMP (exported multiple-page files).
Toolbox

This chapter describes the tools in the standard Artline toolbox, as shown below.

You can also create your own custom tools, as described in Chapter 13. In addition, several ready-made custom toolboxes are included in your installation. See Appendix C.
Hiding the Toolbox

To make a larger workspace available, you can “hide” the toolbox so that it no longer appears on the screen.

To hide the toolbox, choose the Toolbox command from the View menu. To re-display the toolbox (to select a tool, for example), choose the Toolbox command again.

Selector Tool

The Selector tool’s functions include:
- selecting elements;
- scaling elements (changing their size);
- moving elements;
- copying elements;
- moving the guide lines.

Selecting Elements

Many of Artline’s functions require that elements first be selected. For example, you must select an element before you can:
- change its fill color or line color;
- copy it;
- delete it;
- move it to the foreground or background.

A selected element is identified by a selection frame with handles at the corners and midpoints.
To select a single element:

- Click on the element or anywhere within the area of its selection frame.
  
  If you click on an element that is one of several elements that are already selected, the other elements are automatically de-selected.

- Drag a selector box around the element.

To select more than one element:

- Drag a selector box around the elements.

- If a selector box would enclose elements you do not want, *Shift-click* to select the elements you want.

**NOTE:** When two elements exactly coincide—for example, a circle inscribed in a square—their selection frames visually cancel each other out, even though the elements are selected. This effect is true for all *even* numbers of coincident selected elements. For odd numbers of coincident selected elements, the selection frames are visible.
To select the element on the bottom of the stack:

*Ctrl-click* on the element—hold down the *Ctrl* key as you click on the element.

To select all elements on the drawing surface:

Choose the **Select All** command from the Edit menu. The Selector tool does not have to be highlighted when you choose the **Select All** command.

### Selecting Overlapping Elements

When elements overlap, the topmost element at the point where you click is always selected. If this element's selection frame entirely encloses the selection frames of the elements underneath, there is a special technique for selecting the other elements.

To select an element lower in the stack:

Press the **F4** key. The **F4** key "steps" the Selector down through the stack, selecting only those elements *directly under the tip of the Selector arrow* at the time you click.

If you select the bottom element in the stack with *Ctrl*-click, the **F4** key selects upward.

In the illustration below, element A is on top and is the first element selected in each case.

![Diagram of elements](image)

If you click here, the **F4** key selects element B and then element C. These are the only elements under the Selector arrow.

If you click here, the **F4** key selects element B, then C, D, and E. All five elements are under the Selector.

If you click here, the **F4** key selects element B and then skips to element E. Elements C and D are not selected because they are not under the Selector arrow.
Selection Techniques

The following table describes all the ways you can select elements.

<table>
<thead>
<tr>
<th>techniques for selecting elements</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>click</td>
<td>Selects the element whose selection frame is under the tip of the pointer. If more than one element, selects the topmost.</td>
</tr>
<tr>
<td>Ctrl-click</td>
<td>Selects the element on the bottom of the stack under the tip of the pointer.</td>
</tr>
<tr>
<td>selector box</td>
<td>Selects all elements whose selection frames fall entirely within the selector box.</td>
</tr>
<tr>
<td>Shift-click</td>
<td>Selects additional non-overlapping elements individually.</td>
</tr>
<tr>
<td>F4</td>
<td>Selects the next element under the point at which you clicked. If starting from the top of the stack, F4 selects downward; if starting from the bottom, F4 selects upward. In either case, the previous element is de-selected.</td>
</tr>
<tr>
<td>Shift-F4</td>
<td>Selects additional elements toward the bottom or top of the stack.</td>
</tr>
<tr>
<td>Ctrl-Shift-click</td>
<td>Selects additional overlapping elements individually.</td>
</tr>
<tr>
<td>Shift-drag</td>
<td>Adds elements enclosed within selector box to current selection.</td>
</tr>
<tr>
<td>Alt-click</td>
<td>Makes a selected tool function as a Selector. See page 2-12.</td>
</tr>
</tbody>
</table>
De-selecting Elements

You will often need to de-select elements, so that they are no longer selected.

To de-select all elements:

1. Click on the Selector tool.
2. Click in an empty part of the workspace, including the area surrounding the drawing surface. As long as you are not clicking inside an element’s selection frame, all elements are de-selected.

If you have zoomed in on the drawing surface, you can de-select elements without zooming out. Display the status line (see the description of the Status Line command on page 5-4) and then press the F4 key until the status line indicates that no elements are selected.

To de-select individual elements:

Shift-click on the elements you want to de-select.
Scaling Elements

You can scale a selected element with the Selector—making it larger or smaller.

To scale an element with the Selector:

Drag a corner or midpoint handle on the element.

- Dragging a corner handle scales in two dimensions.
- Dragging a midpoint handle scales in one dimension only, either vertically or horizontally.

When more than one element is selected, the other elements are not scaled, but they remain selected.

You can also scale elements with the Scale command in the Edit menu (page 7-9) and the Element Info command in the Element menu (page 6-13).

To scale more than one element, use the Scale command, or group the elements (page 6-5) and then drag one of the handles on the selection frame enclosing the group.

Status Line

The status line (page 5-4) displays scaling percentages.
Moving Elements

Using the Selector, you can move selected elements to a different position in the workspace.

To move elements with the Selector:

1. Place the pointer inside the selection frame of one of the selected elements.
2. Drag the elements to their new position.

You can move elements as selection frames or outlines. See the description of the Selector Options on page 2-11.

You can also move elements with the Move command (page 7-6) and the Element Info command (page 6-13).

Status Line

The status line (page 5-4) displays the changes in the mouse’s position as you drag the elements.
Copying Elements

Using the Selector, you can copy selected elements.

To copy elements with the Selector:

1. Press and hold down the **Shift** key.
2. Place the pointer inside the selection frame of one of the selected elements. Press and hold down the mouse button.
3. Drag the elements' selection frames or outlines to where you want the copies.
4. Release the mouse button.

The original elements remain where they were, and the copies appear at the new position.

The table below lists all the ways you can copy elements.

<table>
<thead>
<tr>
<th>techniques for copying elements</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>command or tool</strong></td>
</tr>
<tr>
<td>Duplicate command (Edit menu)</td>
</tr>
<tr>
<td>Clone command (Edit menu)</td>
</tr>
<tr>
<td>Copy command (Edit menu)</td>
</tr>
<tr>
<td>Selector tool (Shift key held down)</td>
</tr>
<tr>
<td>Rotator tool (Shift key held down)</td>
</tr>
<tr>
<td>Flipper tool (Shift key held down)</td>
</tr>
<tr>
<td>Move command (Make Copy turned on)</td>
</tr>
<tr>
<td>Scale command (Make Copy turned on)</td>
</tr>
<tr>
<td>Rotate command (Make Copy turned on)</td>
</tr>
</tbody>
</table>
Moving the Guide Lines

You can use guide lines:

- to align elements on the drawing surface;
- as a reference point for rotating and scaling elements.

To move the guide lines with the Selector:

Place the tip of the pointer on the guide line you want to move, and drag the guide line where you want it. The status line (page 5-4) displays the guide line's position as you drag it.

For the greatest accuracy in placing the guide lines, use the Set Guide Lines command (page 5-9).
Selector Options

Your choices depend on personal preference and the task you are trying to accomplish.

Double-clicking on the Selector tool displays the Selector Options dialog:

![Selector Options Dialog]

Move Elements As
This option determines how a moving element is drawn on the screen. See the illustration on page 2-8.

Selection Frames
The element's position is indicated by its selection frame.

Outlines
The element's position is indicated by its outline.
Of the two options, Selection Frames is suited to moving complex elements or text elements. The Outlines option is preferable when accuracy of position is desired.

Handle Size
This option sets the size of the handles in an element's selection frame, ranging from two to eight pixels.

![Handles Example]
Using Other Tools as a Selector

You can use any of the tools listed below as a Selector by holding down the **Alt** key. For example, **Alt**-click with the Magnifier selects an element; **Alt**-drag with the Rotator selects or moves an element or changes its size (depending on where you place the pointer).

The **Alt** key turns the following tools into a Selector:

- Magnifier
- Sketch tool
- Trace tool (only after an image is loaded)
- Text tool
- Rectangle tool
- Circle tool
- Rounded Rectangle tool
- Line tool
- Rotator
- Thumbtack
- Flipper
- Rolling Pir.

**NOTE:** One Selector technique is not available for these tools—**Ctrl**-click to select the element at the bottom of the stack. The **Alt** and **Ctrl** keys convert any of the tools listed above to a Magnifier. See page 2-18.
Layer Tool

The Layer tool displays a pop-up menu from which you can select an active layer or add a new layer to your picture.

Layers are described fully in Chapter 10.

Active Layer

The name of the active layer appears in the window’s title bar.

In a picture that has more than one layer, you can only work in one layer at a time—the active layer.

To make a layer the active layer:

1. Click on the Layer tool. A pop-up menu of layer names is displayed.
2. In the pop-up menu, click on the name of the layer you want to make the active layer.

You can also activate layers by pressing the PgUp or PgDn keys.

Adding Layers

To add a new layer:

1. Click on the Layer tool.
2. In the pop-up menu, click on the New Layer option. The Add Layer dialog is displayed.
3. Type a name for the new layer and exit the dialog.

The Add Layer dialog contains additional options for creating slides. These options are described on page 10-8.

NOTE: Merging a file into your current file always creates at least one new layer. See the description of the Merge File command on page 3-4.
The View tool displays a pop-up menu from which you can select a view of the drawing surface—one of three preset views or a “custom” view you have defined.

To select a view:

Click on the View tool to display the pop-up menu of available views and choose the name of the view you want.

The New View option is for defining your own views. See “Custom Views” (page 2-16).

Preset Views

Three preset views of the drawing surface are available:

Full View
The entire drawing surface appears in the workspace.

Normal View
Normal View shows about one quarter of a standard letter size page in the workspace. See the illustration on the next page.

Reduced View
The drawing surface is centered in the workspace with space around it on all sides. You can drag elements partially or entirely off the drawing surface and place them in this surrounding space.

The illustrations on the next page show the three preset views and one possible use of the surround.
This illustration shows the workspace in Reduced view. The two rectangles show how much of the drawing surface is visible in Full view and Normal view.

You can use the surround to drag the direction lines of large curves, as a temporary holding place for elements, or to create a perspective grid, as in the illustration below.
Custom Views

With the View tool's **New View** option, you can define and save views of specific parts of each picture.

To define a custom view:

1. Use the Magnifier (described next) or the scrollers (or both) to bring a particular part of your drawing into the workspace.
2. Click on the View tool.
3. In the View tool pop-up, click on **New View**.
4. In the New View dialog, enter a name for this view and exit the dialog.

The new view name now appears in the View tool pop-up. To return to this exact place on the drawing surface at any time, click on the View tool and choose this view’s name.

To remove a custom view:

1. Go to that view by choosing it from the View tool menu.
2. Display the View tool menu again. Note that the last option in the menu has changed to **Remove View** and the view name has a marker next to it.
3. Choose **Remove View** from the View tool menu.
Magnifier Tool

The Magnifier zooms in or out on a specific portion of the drawing surface.

To zoom *in* on the drawing surface:

1. Click on the Magnifier. The pointer changes to a magnifying glass.
2. Place the magnifying glass over the center of the area you want to zoom in on. Drag in any direction.
   
   As you drag, a frame appears, centered on the point where you started.

   To drag from the upper left corner of the frame, instead of the center, press the *Shift* key before you begin dragging.

3. When the frame encloses the area you want, release the button.

To zoom *out* one level:

Click anywhere on the drawing surface.

To display the entire drawing surface:

Double-click with the Magnifier anywhere on the drawing surface. This is the same as choosing the Full View option of the View tool.
Other Ways to Change Views

You can also zoom in or out or change the view in the following ways:

- You can press the plus key (+) on the numeric keypad to zoom in one level toward the center of the drawing surface and the minus (-) key to zoom out one level.

- You can use any of the other selectable tools (like the Quill, Rectangle tool, or Flipper) as a temporary Magnifier tool. To do so, select the tool, hold down the Ctrl and Alt keys, and drag.

The other Magnifier techniques—Shift to drag from the upper left corner of the frame, click to zoom out one level, and double-click to display the entire drawing surface—are also available.

- You can use the View tool options—Full View, Normal View, and Reduced View—as well as any custom views (see page 2-14).

A Note to Logitech Bus Mouse Users

If you have a Logitech® Bus Mouse (which uses its own "bus board" and requires the file MOUSE.COM) and if you are using the CLICK™ utility, the Ctrl-Alt-drag technique described above will change the pointer’s speed (as indicated by a beep), causing it to move more slowly than before. To restore the pointer’s normal speed, press Ctrl-Alt and the mouse’s middle button.

This feature is described in the chapter “CLICK Mouse Control” in Getting the Most from Your Mouse in the current Logitech documentation set.

2-18 Artline User Reference Guide
Artline has several tools for drawing circles, squares, curves, lines, and other shapes. These tools are described in the next several sections.

Default Color and Line Attributes

Defaults are preset choices or values that are used automatically. For example, if you set the default fill color for elements to a solid blue, each new element you draw automatically has a solid blue fill. (You can always change the fill color of individual elements after you draw them.)

You can set these defaults in the toolbox:

- fill color or fountain
- line color
- line width and other attributes

To set defaults:

1. De-select all elements by clicking on an empty part of the drawing surface or by pressing the F4 key. De-selecting elements is described on page 2-6.

2. Click on the appropriate tool to set defaults:
   - interior fill: Fill Color tool (page 2-42) or Fountain tool (page 2-42). See the note below.
   - line color: Line Color tool (page 2-42)
   - line attributes: Line Width tool (page 2-47)

Any color or line attribute chosen while no elements are selected becomes a default.

Defaults remain in effect until you set new defaults or until you quit Artline.

NOTE: You can have a default solid fill color or a default fountain, but not both. The last one you choose becomes the default. For example, if you choose a solid fill color and then a fountain, the fountain is the default.
Anchor Points

Elements are defined by any of three types of anchor points:

- **Tangent points** lead from one curve to another. Each tangent point has a tangent line passing through it and a direction point at either end of the tangent line.

- **Junction points** lead from a curve to a straight line or from a straight line to a curve. A junction point has half a tangent line and a single direction point on the side of the curve.

- **Corner points** lead from one straight line to another. They have no tangent lines or direction points.

Maximum Number of Points

Because some output devices cannot reproduce large or complex elements, Artline has a limit of 255 points per element, including anchor points and direction points (page 2-23). With practice, you should be able to draw complex figures without exceeding this limit.
How to Count Points

The total number of points in an element is the sum of its anchor points and its direction points.

To add up the points in an element, follow these rules:

- Each tangent point, except for the first or last point on the element, accounts for three points—the tangent point itself, plus two direction points. The first or last tangent point on an element accounts for two points—the tangent point and one direction point.

- A junction point accounts for two points—the junction point itself and one direction point.

- A corner point accounts for a single point.

- The first and last points of closed elements like circles and squares are separate points, even though they occupy the same position on the drawing surface. A circle, for example, has thirteen points (see left).

To find out how many points there are on a single element, select it and then choose the **Element Info** command from the Element menu.

Automatic Closure of Non-Hollow Elements

Artline automatically closes elements that contain a fill color or fountain, connecting the first and last points with a straight line that uses the current line color and width.

If the element is hollow (no fill color or fountain), the first and last points are not automatically connected.
Quill Tool

The Quill tool draws curves, polygons, and elements made of combinations of lines and curves.

Pointer Form

The Quill tool pointer can take two forms on the drawing surface:

- **crosshair** → ☐ The Quill is active but you have not begun to draw.
- **cross** → + The Quill is active and you are in the process of drawing. When you complete your drawing, the pointer changes back to a crosshair to indicate that you can draw something else.

Default Fill Color and Line Attributes

Elements drawn with the Quill tool take the current default for fill color, line color, and line width.

See page 2-19 for a description of how these default values are set.

Outline on Hollow Elements

The outline on elements with Hollow fill is not necessarily "closed." Refer to the section "Automatic Closure of Non-Hollow Elements" (page 2-21).

Elements Drawn with the Quill

You can draw three types of elements with the Quill:

- curves
- polygons
- combinations of curves and lines
Drawing Curves

You can draw two basic kinds of curves with the Quill tool:

- a simple curve—like the letter U
- a compound curve—like the letter S

A curve is defined by two tangent points, each with a tangent line and two direction points (see the illustration on the next page). Tangent points mark the beginning and end of the curve, and the tangent lines and direction points determine its direction and shape.

The length of the tangent line determines how “tall” the curve will be. With practice, you should soon be able to gauge the curves accurately. (If it is not quite right, you can adjust it later with the Plane tool.)
To draw a curve:

1. Position the Quill tool crosshair where you want to start the curve.
2. Press and hold down the mouse button to set the first tangent point. *Do not release the button.*
3. Drag the first tangent line with the mouse. Release the button when you finish the tangent line.
4. Move to the second tangent point. Again, press and hold down the mouse button.
5. Drag the second tangent line with the mouse. The curve connects the two tangent points.

6. To continue drawing and add another curve, move the pointer to another tangent point, press the mouse button, and drag a new tangent line.

Closing Elements

You must *close* the current element before you can draw additional elements.

To close an element:

Double-click anywhere in the workspace. The element is closed and is automatically selected. The Quill is still active, and you can continue drawing.
Drawing Polygons

A polygon is a shape made up of connected straight lines.

To draw a polygon:

1. Select the Quill tool and click to set the first point.
2. Click to set each additional point of the polygon. Each new point is connected to the previous one by a straight line.
3. Close the element by double-clicking.

Drawing Elements that Combine Curves and Lines

Elements drawn with the Quill can combine curves and straight lines.

To add a straight line to a curve, click with the Quill pointer to set the end point of the line.

To add a curve to a straight line, hold down the Alt key and drag from the end point of the line. A tangent line appears, and you can draw the curve. You can release the Alt key when the tangent line appears.
Additional Techniques

This section describes the following Quill tool techniques:

- breaking tangents
- correcting errors
- re-opening a curve or polygon

Breaking Tangents

When drawing connected curves, you can “break” the tangent so that the first curve approaches the tangent point along one tangent line and the second curve leaves the point along a different tangent line.

To break a tangent and draw a new curve:

Press the Alt key and then press the mouse button. The tangent line is now broken at the anchor point, and you can drag the first tangent line of the new curve.

1. Draw the first curve.  
2. Break the tangent by Alt-dragging the direction point. 
3. Draw the second curve.

NOTE: The angle between the two curves does not have to be dramatic. You can use this technique to make subtle adjustments in the direction of connected curves.
Correcting Errors

If you are not satisfied with where you set an anchor point, you can easily delete it.

To delete a point:

Press the **Backspace** key. Artline deletes the point and the line or curve connecting it to the previous point. You can then set a new anchor point and continue drawing.

Each time you press the **Backspace** key, Artline deletes another anchor point until it reaches the first point.

You cannot delete the first point of an element with the **Backspace** key. To delete the first point of any element, double-click.

Re-Opening a Curve or Polygon

After you have closed a curve or polygon, you can re-open it and continue drawing with the Quill tool.

To re-open a curve or polygon:

1. Choose the Selector tool.
2. Click on the element you want to re-open. The element is now selected.
3. Choose the Quill tool.
4. Double-click anywhere on the element.

Artline re-opens the element. You can continue drawing from the last point of the element. You can also edit curves, polygons, and other elements with the Plane tool (page 2-53).
Sketch Tool

The Sketch tool draws “freehand” shapes. You can use the mouse much as you would a pencil or pen.

To draw with the Sketch tool:

1. Select the Sketch tool.

2. Press the mouse button and move the mouse. The crosshair follows the movement of the mouse, drawing on the screen the same design you make with the mouse.

3. Release the mouse button when you have finished drawing. Your design will disappear for a moment while Artline calculates and draws the curves you have sketched.

Default Fill Color and Line Attributes

Elements drawn with the Sketch tool take the current default for fill color, line color, and line width.

See page 2-19 for a description of how these default values are set.

Outline on Hollow Elements

The outline on elements with Hollow fill is not necessarily “closed.” Refer to the section “Automatic Closure of Non-Hollow Elements” (page 2-21).

Grid Snap

To enable you to draw truly freehand elements, points drawn with the Sketch tool never snap to the grid, regardless of the state of the Snap to Grid command.
Trace Tool

The Trace tool automatically draws lines and curves that follow the contours of scanned images, images created with paint programs, or other images converted to the IMG, PCX, or TIFF formats.

When you double-click on the Trace tool, Artline displays the Trace Options dialog. Autotracing and the Trace Options dialog are described in detail in Chapter 11.

Outline on Hollow Elements

The outline on elements with Hollow fill is not necessarily "closed." Refer to the section "Automatic Closure of Non-Hollow Elements" (page 2-21).
The Text tool adds text to your pictures—using many typefaces and an almost limitless variety of point sizes.

To add text to your picture:

1. Select the Text tool.

2. Click the I-beam in the workspace. The text will appear where you clicked.

   You do not have to click exactly where you want the text to be. It is often easier to enter text into an empty part of the workspace, work on it there, and then move it to its final position.

3. Artline displays the Create Text Element dialog. Enter your text in the dialog, set the text attributes, and exit the dialog.

   Pressing \[J\] inserts a carriage return in your text. To exit the Create Text Element dialog and add the text to the workspace, you must click on the OK button.

**NOTE:** Line Width tool options, including width and caps, can be applied to text. See page 2-47. In addition, see the descriptions of the Text Along a Path command (page 8-14) and the Convert to Curves command (page 8-18).
Create Text Element Dialog

The Create Text Element dialog contains a window into which you enter your text; pop-up menus for choosing the typeface, point size, line spacing, and alignment; and a kerning check box. The word “Sample” appears in the lower left corner of the dialog to illustrate the currently selected typeface.

Font Pop-up

The Font pop-up lists the available fonts (typefaces) for your text. To select a font, click on its name in the list.

<table>
<thead>
<tr>
<th>Font Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Advantage Bold</td>
</tr>
<tr>
<td>Advantage BoldItalic</td>
</tr>
<tr>
<td>Advantage Normal</td>
</tr>
<tr>
<td>Advantage Italic</td>
</tr>
<tr>
<td>Booker Demi</td>
</tr>
<tr>
<td>Booker DemiItalic</td>
</tr>
<tr>
<td>Booker Light</td>
</tr>
<tr>
<td>Booker LightItalic</td>
</tr>
<tr>
<td>Courier</td>
</tr>
<tr>
<td>Courier Bold</td>
</tr>
<tr>
<td>Courier BoldItalic</td>
</tr>
<tr>
<td>more...</td>
</tr>
</tbody>
</table>

You can scroll the list if the name you want is not visible.

- To scroll down the list, touch the pointer to the word “more” when it appears at the bottom of the menu.
- To scroll up the list, touch the pointer to the word “more” when it appears at the top of the menu.

To stop scrolling in either direction, move the pointer into the list of font names.

Adding Fonts to the List

You can convert fonts to the Artline format and add them to the list.

Converting fonts is described in the Artline Utilities Guide.

To add fonts to the list, use the Font Manager (page 9-7.)
Point Size

The Size pop-up offers seven preset point sizes and a Custom option.

Custom Point Sizes

The Custom option displays the Custom Size dialog over the Create Text Element dialog. Type a number directly into the “New Size” field or use the pop-up slider to enter a value. You can specify any point size (whole numbers only) from two points to 500 points.

Line Spacing

The line spacing setting in the Create Text Element dialog controls the distance between lines of text separated by a carriage return in the text entry window.

Type is commonly specified as one point size on another—for example, “10 on 12.” The first number is the point size of the text characters; the second number is the line spacing. Thus, “10 on 12” is 10-point type with 12 points between baselines—the invisible horizontal line on which the characters sit. (In traditional typography, 10 on 12 is also known as 10-point type with two points of lead, recalling the days when lines of type were separated by quantities of lead.)

Line spacing is set in the pop-up menu that follows the Size pop-up. The number in the pop-up bar depends on the selection you make from the menu’s three options, Solid, Auto, and Custom.
Solid

The line spacing is the same as the point size of the text—for example, 12 on 12. The text has “zero points of lead.” When text is set to Solid, there is typically little or no space between the lowest point (descender) of a letter on one line and the highest point (ascender) of a letter on the line below.

Auto

The line spacing is automatically set by Artline based on the point size of the text. See the table below.

<table>
<thead>
<tr>
<th>point size</th>
<th>line spacing</th>
<th>specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>2-7 (custom)</td>
<td>1 point more than type size</td>
<td>5 on 6, e.g.</td>
</tr>
<tr>
<td>8-11 (custom)</td>
<td>2 points more than type size</td>
<td>9 on 11, e.g.</td>
</tr>
<tr>
<td>12</td>
<td>14</td>
<td>12 on 14</td>
</tr>
<tr>
<td>14</td>
<td>17</td>
<td>14 on 17</td>
</tr>
<tr>
<td>18</td>
<td>22</td>
<td>18 on 22</td>
</tr>
<tr>
<td>24</td>
<td>29</td>
<td>24 on 29</td>
</tr>
<tr>
<td>36</td>
<td>43</td>
<td>36 on 43</td>
</tr>
<tr>
<td>48</td>
<td>58</td>
<td>48 on 58</td>
</tr>
<tr>
<td>72</td>
<td>86</td>
<td>72 on 86</td>
</tr>
<tr>
<td>above 72 (custom)</td>
<td>20% more than type size</td>
<td>80 on 96, e.g.</td>
</tr>
</tbody>
</table>

Custom

The **Custom** option displays the Custom Line Space dialog. Type a number directly into the New Line Space field or use the pop-up slider to set a value. You can specify a baseline distance smaller than the text point size so that the lines of text actually overlap.
Alignment

The Align pop-up gives three choices for aligning your text on the drawing surface.

Quo usque tandem abutere, Catalina, patientia nostra?

Left alignment  Center alignment  Right alignment

Auto Kerning

*Kerning* is a reduction in the space between specific pairs of letters, intended to produce a more visually pleasing letter spacing.

In the example below, the A in the un kerned version of WAVE appears separated from its surrounding letters. Kerning reduces the space on both sides of the A so that the spacing between all the letters in the word appears uniform.

```
WAVE
↑↑
unkerned
```

```
WAVE
↑↑
kerned
```

Text Entry Window

Type your text directly into the text entry window. To start a new line, press ↓.

The window can display four lines of text at a time. To bring a line that is not visible into the window, use the scrollers at the right side of the window.
Cursor Keys

Use these keys on the numeric keypad to move the cursor in the text entry window:

<table>
<thead>
<tr>
<th>key</th>
<th>cursor movement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Home</td>
<td>to beginning of line</td>
</tr>
<tr>
<td>End</td>
<td>to end of line</td>
</tr>
<tr>
<td>PgUp</td>
<td>up four lines</td>
</tr>
<tr>
<td>PgDn</td>
<td>down four lines</td>
</tr>
<tr>
<td>left-arrow/right-arrow</td>
<td>left/right one character</td>
</tr>
<tr>
<td>up-arrow/down-arrow</td>
<td>up/down one line</td>
</tr>
<tr>
<td>Backspace</td>
<td>deletes character to left of cursor</td>
</tr>
<tr>
<td>Delete</td>
<td>deletes character to right of cursor</td>
</tr>
</tbody>
</table>

Re-opening Text for Editing

To re-open a text element for editing, use the Selector to select it and then double-click on it. The Create Text Element dialog appears, with the text in the text window.

You can re-open text for editing as long as it has not been converted to curves.

Symbol and Wombat Characters

Characters in the Symbol and Wombat fonts cannot be displayed in the text window. You will see the standard character for that ASCII decimal value, but the correct Symbol or Wombat character will appear on the drawing surface and in your picture.

See Appendix A for a list of Artline's font names and their PostScript equivalents.
The Rectangle tool draws rectangles, rounded rectangles, and squares.

Default Fill Color and Line Attributes

Elements drawn with the Rectangle tool take the current default for fill color, line color, and line width. See page 2-19 for a description of how these default values are set.

Drawing with the Rectangle Tool

The steps for drawing rectangles and squares are almost identical.

To draw a rectangle:

1. Select the Rectangle tool. The pointer becomes a crosshair when it is in the workspace.
2. Position the crosshair at one of the corners of the rectangle.
3. Drag the mouse diagonally to the opposite corner of the rectangle. As you drag, an outline of the rectangle follows the crosshair.
4. To finish the rectangle, release the mouse button.

To draw a rounded rectangle:

Set a Corner Radius in the Rectangle Options dialog (page 2-38) and then follow the steps for drawing a rectangle.
To draw a true square:

Follow the steps for drawing a rectangle, but hold down the **Ctrl** key as you drag.

To draw a square with rounded corners, first set a Corner Radius in the Rectangle Options dialog.

**NOTE:** The aspect ratio of the pixels on some display monitors can affect how squares appear on the screen. On an EGA screen, for example, a square can appear as a vertical rectangle. This effect is less pronounced on a VGA™ screen. The distortion will not appear in your printed output.

To draw around a center point:

To draw a rectangle from the center, hold down the **Shift** key as you drag. To draw a square from the center, hold down both the **Ctrl** key and the **Shift** key.

*Both rectangles were drawn from the same starting point. The rectangle on the right was drawn from the center.*
Rounded Rectangle Tool

Rectangle Options

When you double-click on the Rectangle tool, Artline displays the Rectangle Options dialog.

![Rectangle Options dialog]

Corner Radius

This option sets the radius of the curves at the corners of a rounded rectangle. The default value of zero draws a rectangle with right-angle corners.

After you set a corner radius value to draw a rounded rectangle, you must reset the value to zero to draw a normal rectangle.

Draw Squared

This option makes the Rectangle tool draw only squares.

Rounded Rectangle Tool

The Rounded Rectangle tool is simply a Rectangle tool with a pre-set corner radius. You can change this corner radius to your own preference by double-clicking on the Rounded Rectangle tool to display the Rectangle Options dialog.

In all other respects the Rounded Rectangle tool is identical to the Rectangle tool.
The Circle tool draws circles and ellipses.

Default Fill Color and Line Attributes

Elements drawn with the Circle tool take the current default for fill color, line color, and line width.

See page 2-19 for a description of how these default values are set.

Drawing with the Circle Tool

The steps for drawing circles and ellipses are almost identical.

To draw an ellipse:

1. Select the Circle tool. The pointer becomes a cross-hair when it is in the workspace.

2. Imagine a rectangle enclosing the ellipse you want to draw. Position the crosshair at one of the corners of this imaginary rectangle.

3. Press the mouse button and drag to the diagonally opposite corner of the rectangle.

   As you drag, an outline of the ellipse follows the crosshair.

4. To finish the ellipse, release the mouse button.
To draw a true circle:

Follow the steps for drawing an ellipse, but hold down the Ctrl key as you drag.

**NOTE:** The aspect ratio of the pixels on some display monitors can affect how circles appear on the screen. On an EGA screen, for example, a circle can appear as a tall ellipse. This effect is less pronounced on a VGA screen. The distortion will not appear in your printed output.

To draw around a center point:

To draw an ellipse from the center, hold down the Shift key as you drag. To draw a circle from the center, hold down both the Ctrl key and the Shift key.

*Both ellipses were drawn from the same starting point. The ellipse on the right was drawn from the center.*
Line Tool

The Line tool draws straight line segments.

Lines drawn with the Line tool take the current default values for line color and line width (see page 2-19).

To draw a line:

1. Select the Line tool. The pointer becomes a cross when it is in the workspace.
2. Place the cross where you want the line to begin.
3. Drag to draw the line.

To draw connected line segments, use the Quill tool (page 2-22) or join individual line segments with the Plane tool (page 2-59).

To draw vertical, horizontal, and 45° lines:

Press the Ctrl key as you drag. The line snaps to the nearest 45° interval.

Line Options

When you double-click on the Line tool, Artline displays the Line Options dialog.

The Snap Angle set in this dialog restricts the Line tool to multiples of this angle. For example, if you set the snap angle to 15 degrees, you can draw lines only at 15°, 30°, 45°, 60°, and so on.
Fill Color Tool

A fill color (in contrast to a fountain) is a solid color or a shade of gray. Using the Fill Color tool, you can:

- assign fill colors to selected elements (see page 2-43);
- create new fill colors (see page 2-44);
- choose default fill colors (see page 2-19);
- set color tool options (see page 2-44).

Fountain Tool

A fountain (in contrast to a fill color) is a gradual blending of one color into another. Using the Fountain tool, you can:

- assign fountains to selected elements (see page 2-43);
- create new fountains (see page 2-44);
- choose default fountains (see page 2-19);
- set color tool options (see page 2-44).

Line Color Tool

In Artline’s initial default, elements are drawn with a thin black outline. Using the Line Color tool, you can:

- assign colors to the outlines around selected elements (see page 2-43);
- create new line colors (see page 2-44);
- choose a new default line color (see page 2-19);
- set color tool options (see page 2-44).
Using the Color Tools

Assigning Colors or Fountains

To assign a color or fountain:

1. Select the elements to which you want to assign the color or fountain.

2. Click on the appropriate tool—Fill Color, Fountain, or Line Color—to display the color selector.

   - The type of selector—List or Palette—is determined by your selection in the Color Tool Options dialog (page 2-44).

3. Click on the color you want.

   **NOTE:** If you click on the Fountain tool when the current color file contains no fountains, the Add Fountain dialog is automatically displayed. Color files and the Add Fill dialog are described in Chapter 12.

Hollow Elements

The Hollow fill option produces an outline of the element, using only the current line color and width values.

**NOTE:** The outline on elements with a Hollow fill is not necessarily "closed." See “Automatic Closure of Non-Hollow Elements” (page 2-21).
Creating New Colors or Fountains

The color selectors include an option for creating a new color or fountain.

To create a new color or fountain:

1. Display the appropriate color list or palette—Fill Color, Fountain, or Line Color.
2. Click on the Add Color option or, for fountains, the Add Fill option.

In the color palette, the option appears at the bottom of the palette window. See the illustration on the next page.

In the color list, the option is the last item in the list.

Artline displays the Add Color or Add Fill dialog.

3. Fill out the Add Color or Add Fill dialog.

The Add Color and Add Fill dialogs are described fully in Chapter 12.

Setting Color Tool Options

Double-clicking on the Fill Color tool, Fountain tool, or Line Color tool displays the Color Tool Options dialog. The options you choose apply only to the tool on which you double-clicked.

<table>
<thead>
<tr>
<th>Color Tool Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display As</td>
</tr>
<tr>
<td>○ List</td>
</tr>
<tr>
<td>○ Palette</td>
</tr>
<tr>
<td>Color Type</td>
</tr>
<tr>
<td>○ Solid</td>
</tr>
<tr>
<td>○ Fountain</td>
</tr>
<tr>
<td>Assign To</td>
</tr>
<tr>
<td>○ Interior</td>
</tr>
<tr>
<td>○ Outline</td>
</tr>
<tr>
<td>OK</td>
</tr>
<tr>
<td>Cancel</td>
</tr>
</tbody>
</table>
Display As

This option determines how the selected tool displays colors. See the illustration below.

List

The list format is most suited to comparatively small color files.

To scroll the list of colors, touch the pointer to the word “more” that appears at the bottom or top of the list. To scroll more rapidly, move the pointer out of the list, just above or below “more.”

To stop scrolling, move the pointer into the list.

Palette

The palette format is suited to large color files like the PANTONE files.

To scroll the Palette, drag the slider or click on the arrows. Note that a color’s name appears in the Palette’s title bar only when the pointer is on the color itself.

The order in which the colors are displayed is set by the Sort commands in the Color Manager (Chapter 12).
Color Type

Solid
The selected tool assigns solid colors. This option is valid for any kind of color tool.

Fountain
The selected tool assigns fountains. This option is valid only for tools for which the Assign To option (next) is set to **Interior**.

Assign To

Interior
The selected tool’s color type—**Solid** or **Fountain**—is assigned to the element’s interior.

Outline
The selected tool’s color type—**Solid** only— is assigned to the element’s outline.

When to Set Color Tool Options

You can change a color tool’s display format at any time, according to your preference or needs. Do not, however, change the Assign To or Color Type settings for the standard color tools.

If you create a custom color tool with the Tools Manager (Chapter 13), you can set all available color tool options.
Line Width Tool

The Line Width tool sets the width and attributes of the outline around selected elements (including text) and of lines drawn with the Line tool.

You can also use the Line Width tool to set a default line width and attributes. Setting defaults is described on page 2-19.

Setting Line Width

To set the line width:

1. Select the elements whose line width you want to set.
2. Click on the Line Width tool to display the line width menu.
   The line widths in this menu use the unit of measure currently set in the Page Layout dialog (page 3-10).
3. Click on a line width in the menu.
   The No Outline option results in an element with no outline. (No Outline has no effect when applied to hollow elements or single line segments.)
4. To set a line width not listed in the menu, click on the Attributes option. Artline displays a dialog (see the next page) that includes a custom line width option.

Note the following, imposed by limitations in the resolution of screens and printers:

- Most screens cannot display all line widths, especially at Full or Reduced views. As the line width increases, the displayed line width increases in distinct steps.
- For phototypesetter output, a minimum line width of 0.019 inches is recommended. Artline's default line width (0.003 inches) prints as an extremely fine line on a phototypesetter, but appears as a heavier line on a laser printer.
Setting Line Attributes

In the line attributes dialog you can set:

- a custom line width;
- line end styles;
- the style of the angle where two lines meet;
- the line's "pattern"—solid or several dotted line styles.

To set line attributes:

1. Select the elements whose line attributes you want to set.
2. Click on the Line Width tool.
3. Click on the **Attributes** option. Artline displays the **Line Attributes** dialog.

![Line Attributes Dialog](image)

**Width**

To set a custom line width, type a value directly into the field or use the pop-up slider.

**Caps**

These buttons set the style of the beginning and end points of the line or outline. The left column sets the style for the beginning of the line, the right column for the end of the line.
The rounded end caps and long squared end caps extend past the end points of the line you draw. The extra length is roughly half the current width of the line. For example, if you draw a .2-inch wide line that is four inches long and has a single rounded end cap, the line is actually 4.1 inches long, to allow for the rounded end cap.

Joins

These buttons set the style of the angle between two lines at a corner point.

Pattern

This pop-up menu contains a selection of dotted, dashed, and dot-dash line styles.

*NOTE:* Patterned lines greater than one pixel in width will appear as solid lines on the screen and in output to non-PostScript printers, but they will print correctly on PostScript printers and phototypesetters.
Rotator Tool

The Rotator tool rotates selected elements around a specified point and also makes rotated copies. You can also set Rotator tool options before you rotate elements.

To rotate elements:

1. Select the elements you want to rotate.
2. Set rotator options (described below). If you do not set rotator options, Artline will use the defaults or your current settings.
3. If you chose the Thumbtack or the guidelines as your rotation center, set them in place now.
4. Click on the Rotator tool.
5. Rotate the selected elements by dragging with the mouse. The pointer does not have to be on top of the elements being rotated.
   - As you move the mouse, a line radiating out from the center of rotation follows the pointer.
   - If you have set a rotation angle, the elements snap to a new position each time they move through one rotation of that angle.
6. When you finish rotating, release the mouse button.

To make rotated copies:

Press and hold down the Shift key and then drag with the Rotator tool.

Here are two additional rotation techniques:

- You can rotate elements using the Rotate command in the Edit menu (page 7-7).
- You can create special Rotator tools for specific angles of rotation that you use frequently. Creating custom tools is described in Chapter 13.
Fountained Elements

If a rotated element contains a fountain, the fountain does not rotate with the element. To create a rotated fountain, use the Color Manager (Chapter 12).

Rotator Options

The Rotator Options dialog sets parameters that will be in effect when you use the Rotator tool. To display the Rotator Options dialog, double-click on the Rotator tool.

![Rotator Options dialog](image)

Rotate Around

Selection Center

A single element is rotated around the center of its selection frame.

Grouped elements are rotated around the center point of the selection frame enclosing the group.

Multiple selected (but ungrouped) elements are treated as if they were a group, and are rotated around the center point of an imaginary selection frame enclosing them.

Thumbtack

Elements are rotated around the point set with the Thumbtack (see page 2-63).

If the Thumbtack has not been set, an alert is displayed.
Guide Lines
Elements are rotated around the point of intersection of the guide lines. The guide lines are described on page 5-8. If the guide lines have not been set, an alert is displayed.

Rotate Elements As

Selection Frames
The elements’ selection frames are rotated.

Outlines
Outlines of the elements themselves are rotated.

Of the two options, Selection Frames is suited to rotating complex elements or text elements. The Outlines option is preferable when accuracy of position is desired.

Rotation Angle
This option determines the angle through which the selected elements can be rotated. Type a value directly into the field or drag the pop-up slider.

Elements can be rotated only through multiples of the set value. For example, if you set a value of 25°, the elements will be drawn only at rotations of 25°, 50°, 75°, and so on.

When the value is set to 0°, you can rotate elements freely.
Plane Tool

Using the Plane tool, you can change the shape of elements by:

- moving anchor points or direction points;
- adding or deleting points;
- converting a curve to a line or a line to a curve;
- joining or splitting points;
- making curves symmetric or smooth (words that have special meaning in connection with the Plane).

Remember the following about the Plane tool:

- When you select the Plane, the fill and line attributes of all elements are automatically turned off, to give you a clear view of curves, lines, and points and to increase the speed with which elements are drawn.

- You cannot use the Plane on grouped elements (including text characters that have been converted to curves) or on blended elements.

Selecting Points

Before you can modify a curve or line, you must select the point (or points) with which you want to work.

Selected points are displayed as black squares; the remaining points on the element are displayed as hollow squares. When you select a single point, its tangent line (if any) is shown, as is the half-tangent (if any) of the point on either side of the selected point.
To select points:

- To select a single point, click on it.
- To select more than one point, Shift-click on each point.
- If you are not sure where a point is, drag a selector box. (You can also use this technique to select more than one point.) Artline selects all points within the selector box.

If the selector box includes points you do not want, deselect the unwanted points by Shift-clicking on them.

- To add several additional points to an existing selection, Shift-drag a selector box around the area where the points are located.

To select all points on an element:

- Hold down the Alt key and click on the element, or drag a selector box around the whole element.
- To select all points on additional elements, hold down the Shift key as you Alt-click on the elements.

Selecting Adjacent Points

To select a point on either side of the currently selected point, press the left-arrow or right-arrow. By continuing to press the left-arrow or right-arrow, you can “walk the points” to the first or last point of the element.

Selecting Points in Stacked Elements

When elements are stacked on top of each other, the Plane can select unwanted points. To avoid selecting points on other elements, you can do the following:

- Separate elements into layers. The Plane selects points only on elements in the active layer.
- Lock the elements whose points you do not want to select. To lock an element, select it and then choose the Lock command from the Element menu.
Moving Anchor Points

Moving an anchor point (or several selected anchor points) changes the shape of the element. You could, for example, change a square into a rectangle. The illustration below shows one example of the effect of moving anchor points.

Note the following:

- All selected points move with the one you are dragging.
- The position of the selected points relative to each other does not change.
- Unselected points do not move.
- The angle and length of tangent lines are unchanged when you drag an anchor point (see below).
Editing Curves

Direction points mark the ends of a tangent line. When you draw a curve with the Quill, the tangent line is a solid line, and the direction points are the same distance on either side of the tangent point.

Moving a direction point changes the shape of the curves at the tangent point. There are two kinds of curve edits:

- solid tangent edits
- broken tangent edits

Solid Tangent Edits

When you drag a direction point on a solid tangent line, you change the length and angle of the tangent line, and the shape of the curves on both sides of the tangent point changes to remain tangent to the modified line.
Broken Tangent Edits

By breaking the tangent, you can change the shape of the curve on one side of the tangent point.

To break the tangent, press the Alt key and then drag a direction point. You change the curve only on that side of the tangent point; the opposite direction point does not move.

Once the tangent is broken, it remains broken; you need not press the Alt key again to drag the direction point. You can make a broken tangent solid again by choosing the Symmetric command from the Plane tool pop-up menu (described next).
Plane Tool Pop-Up

The Plane tool pop-up menu contains commands for additional editing of curves.

To display the Plane tool pop-up menu:

1. Select the point (or points) on which you want to work.
2. Double-click in the workspace, preferably away from the selected points.

The menu appears at the pointer’s location, and double-clicking near the points could cause the menu to appear on top of them.

Note that the line from the selected point to the next point (in the order in which the points were drawn) has become a dotted line. This dotted line is affected by several of the commands in the Plane tool pop-up menu.

Add Point Command

The **Add Point** command adds a new point to the element, located at the midpoint of the dotted line.

If the selected point is the last point on the element, **Add Point** adds a straight line segment to the element. To convert this line segment to a curve, select the next-to-last point on the element and then choose the **To Curve** command (described below).

Delete Point Command

The **Delete Point** command deletes the selected point.

When you delete a junction point, the two points on either side of the deleted point are connected by a straight line.

To Line Command

The **To Line** command converts the dotted line from a curve to a straight line. This command is available only when the dotted line is a curve.
To Curve Command

The To Curve command converts the dotted line from a line to a curve. This command is available only when the dotted line is a straight line.

The newly created curve initially appears to be a straight line, but it now has tangent lines and direction points. You can drag these direction points to give the new curve the shape you want.

Split Point Command

The Split Point command splits a single selected point into two points. The element that contained the point is split into two elements that can be separately selected, moved, rotated, and so on.

This command is available for any single point, except for an element's beginning and end points.

Join Points Command

The Join Points command makes a single point of two selected end points. You can use the Join Points command to:

- bring the first and last points of an element together;
- join two elements.

Joining points can change the shape and color of your elements in the following manner:

- If you join the first and last points of the same element, the last point moves to the first, and the shape of the element changes accordingly.
- If you join points on separate elements, the point on the element on the bottom (lower in the stack) moves to the point on the top. Again, the shape of the element changes accordingly.
- If you join points on separate elements, the resulting element has the color and line attributes of the element on the bottom.
Symmetric Command

The **Symmetric** command turns a broken tangent line (see page 2-57) back into a solid line with direction points equidistant from the tangent point.

A symmetric tangent line has these characteristics:

- The “outgoing” half of the tangent line (the half on the side of the curve leading to the end point of the element) is matched to the incoming half of the line.
- The curve flows continuously and smoothly through its tangent point.
- Moving a direction point moves the entire tangent line, not just the half-tangent on the side of the direction point.

Smooth Command

The **Smooth** command removes the angle between curves at a broken tangent or between a curve and line at a junction point.

Smoothed Broken Tangents

When you **Smooth** a broken tangent, the result is a straight tangent line, but a smooth tangent is different from a symmetric tangent in two important respects:

- Although straight, the tangent line is still broken. You can drag the direction points independently, without pressing the **Alt** key.
- The lengths of the half-tangents are not changed; they can be different lengths. In a smoothed tangent, the outgoing half of the line moves to line up with the incoming half.
Junction Points

When you Smooth a junction point, the curve is changed so that it passes smoothly into or out of the line segment. There is no apparent angle where the curve meets the line.
Align Vert

The **Align Vert** command moves all selected points to the left or right so that they line up vertically with the *first* selected point—the point nearest the element’s starting point.

Align Horiz

The **Align Horiz** command moves all selected points up or down so that they line up horizontally with the *first* selected point—the point nearest the element’s starting point.
**Copying Portions of a Curve**

To copy portions of a curve or polygon:

1. Use the Plane to select *all points* on the segment you want to copy.
2. Choose the **Duplicate** or **Clone** command from the Edit menu. A **Duplicate** copy is offset by one grid increment (regardless of the state of the grid snap); a **Clone** is copied directly on top of the original.

---

**Thumbtack**

The Thumbtack, more of an accessory than a tool, is used for setting a center of rotation or an alignment point.

To set the Thumbtack:

1. Select the Thumbtack in the toolbox.
2. Click the pointer where you want the center of rotation or the alignment point. The Thumbtack form appears on the drawing surface at that point.

To remove the Thumbtack from the workspace:

1. Select the Thumbtack in the toolbox.
2. Click anywhere in the workspace to “pick up” the pointer from the drawing surface.
Flipper

The Flipper tool moves or copies selected elements to a "mirror-image" position. By dragging a flip line, you control the placement and angle of the flipped elements.

To flip an element:

1. Click on the Flipper tool.
2. Drag a flip line. When the flip line is long enough, a preview of the flipped element is displayed.
3. Release the mouse button. All selected elements are flipped across the line.

To constrain the flip angle to 45° increments:
Hold down the Ctrl key as you drag the flip line.

To copy an element over the flip line:
Hold down the Shift key as you drag the flip line.

To abandon after you start dragging the flip line:
1. Drag a short flip line (so that no preview appears) and then release the mouse button. Artline displays an alert saying that the flip line is too short.
2. Click on the alert's OK button.
Rolling Pin

The Rolling Pin *skews* a selected element or group, distorting it from its original shape.

To use the Rolling Pin tool:

1. Select an element.
2. Click on the Rolling Pin tool.
3. Drag one of the element’s corner handles or a midpoint handle, depending on the effect you want.

   - Dragging a corner handle can skew the element in two directions at once—for example, up and to the right, or down and to the left. The element’s other corner handles remain fixed.

   - Dragging a midpoint handle skews the element along the plane on which the handle is located.

**NOTE:** The Rolling Pin tool works only on single selected elements or groups. If you select more than one element or group, the Rolling Pin works only on the element whose handle you are dragging.
THIS chapter describes the commands in the File menu, which are primarily concerned with file operations like opening and saving files, reading files into Artline, various kinds of output, and defining the Artline page layout.

<table>
<thead>
<tr>
<th>File</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>^W</td>
</tr>
<tr>
<td>Open...</td>
<td>^O</td>
</tr>
<tr>
<td>Merge File...</td>
<td>^B</td>
</tr>
<tr>
<td></td>
<td>-----</td>
</tr>
<tr>
<td>Save</td>
<td>^U</td>
</tr>
<tr>
<td>Save As...</td>
<td>^M</td>
</tr>
<tr>
<td>Export...</td>
<td>^X</td>
</tr>
<tr>
<td>Abandon</td>
<td>^A</td>
</tr>
<tr>
<td></td>
<td>-----</td>
</tr>
<tr>
<td>Page Layout...</td>
<td>^S</td>
</tr>
<tr>
<td>PostScript...</td>
<td>^P</td>
</tr>
<tr>
<td></td>
<td>-----</td>
</tr>
<tr>
<td>To App...</td>
<td>^U</td>
</tr>
<tr>
<td>To Output</td>
<td>^Q</td>
</tr>
<tr>
<td>Quit</td>
<td></td>
</tr>
</tbody>
</table>
Abandon/Save Alert

If you choose the **New, Open, Abandon, To Output**, or **Quit** command when the drawing surface contains work you have not saved, Artline displays this alert:

<table>
<thead>
<tr>
<th>Abandon/Save changes to this picture?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Abandon</td>
</tr>
<tr>
<td>Save</td>
</tr>
<tr>
<td>Cancel</td>
</tr>
</tbody>
</table>

The alert’s exit buttons give you three options:

- **Abandon**: Unsaved work is discarded and the command is carried out.
- **Save**: The file is saved under its current name and the command is carried out. If the picture has not yet been saved, Artline displays the Item Selector so you can give the file a name and save it.
- **Cancel**: The command is canceled. You return to the current picture.

**New Command**

The **New** command clears the drawing surface so you can start a new picture.

The **New** command automatically loads the color file ARTLINE.COL and makes the Color Manager’s **Load** command available. Color files and the Color Manager are described in Chapter 12.
Open Command

The **Open** command displays the Item Selector so you can select a file to open onto the drawing surface.

To select a file, double-click on its name in the directory window (the fastest method) or type the name into the Selection line and then click on the OK button. The Item Selector is described on page 1-20.

The length of time required to open a file (indicated by the rotating "clock face") depends on:

- the complexity of the picture
- your computer’s processor speed
- the current Redraw Speed setting (see page 9-4)

Valid File Formats

You can open files in either of these formats:

- **.GEM**
  
  In addition to Artline, these are some of the programs that create files in the .GEM format:
  
  - Presentation Team™ by Digital Research®
  - GEM Artline (Release 1.0 - Digital Research)
  - GEM Draw Plus by Digital Research
  - PerFORM by Delrina Technology Inc.

- **encapsulated PostScript—Adobe Illustrator format** (extension .EPS or .AI)
  
  Much clip art is provided in this format.

**CAUTION:** The EPSF files produced by Artline are intended for use with desktop publishing programs and cannot be opened in Artline itself. If you create an EPSF file of a picture that you want to be able to edit later, make sure you also save the picture as a .GEM file. See the description of the **Save As** command (page 3-6).
The **Merge File** command loads any file in the .GEM format (including other Artline files) or the Adobe Illustrator encapsulated PostScript format into the current file. The **Merge File** command makes it possible to assemble libraries of pictures you can read into your Artline files.

When you choose the **Merge File** command, the Item Selector is displayed. Select the file you want by double-clicking on its name in the directory window or by typing the name into the Selection line.

**Files with Layers**

Merging a file always adds at least one new layer to the current file.

- If you merge a one-layer file, a single layer is added. The new layer takes the name of the merged file and is placed on top of all other layers.
- If the merged file has more than one layer, Artline displays this alert:
Layers

The file is merged with its layer structure intact. The new layers are placed on top of the other layers in the file and keep the names they had in the original file.

Duplicate layer names are possible in this case, but the new layers are always added on the top—farther down the list displayed by the Layer tool.

Combine

Artline combines all the layers in the merge file into a single new layer in the current file. The new layer’s name is the same as the merge file’s, and the new layer is on top of any other layers at the time it is added.

Valid File Formats

You can merge files in the .GEM and encapsulated PostScript formats. (See the description of the Open command on page 3-3.)

Save Command

The Save command saves the current picture under the name that appears in the title bar. Save your work at regular intervals to protect it from power failures or other unexpected occurrences.

The current display status of the Layer Manager (Active, Visible, All, or Slides) is saved with the file. For example, a file that is saved in Slides mode will automatically be in Slides mode the next time you open it. Display status is discussed on page 10-15.

You can set your preferences so that the last version of your picture file is saved as a backup each time you save. Backups are described on page 9-2.
Save As Command

The **Save As** command displays the Item Selector so you can:

- name and save a picture for the first time;
- save an existing picture under a new name, permitting you to keep two distinct versions;
- save a picture to another directory or disk.

The Item Selector is described on page 1-20.

**Saving for the First Time**
To name and save a picture for the first time, choose the **Save As** command, set the path in the Item Selector to the directory in which you want to save the file, and type a name into the Selection line of the Item Selector.

Artline saves files to the \ARTLINE\ARTWORK directory unless you change the path specification in the Item Selector.

**Saving Under a New Name**
To save a file under a new name, choose the **Save As** command and type the new name in the Item Selector’s Selection line.

Note that the name in the window’s title bar changes to the new name. Any additional work on the picture takes place in the new version of the file, and the original picture is unchanged.

**Saving to Another Disk or Directory**
To save a picture to another disk or directory, first change the path in the Item Selector’s Directory line, and then enter the filename in the Selection line.

You do not have to type the .GEM extension. Artline supplies it automatically.
Export Command

You do not have to save the current file before exporting it.

The Export command displays the Export Picture dialog so you can create a variety of other files from part or all of the current file.

Export From

The Export From pop-up menu determines what is exported.

Active Layer

Only the active layer is exported.

Visible Layers

All layers flagged as Visible in the Layer Manager (Chapter 10) are exported.
Export Command

Slides
All layers are exported. If a layer is designated as the background to one or more slides (page 10-8), it is exported only with the layers to which it is linked; it is not exported separately.

Spot Colors
All elements currently displayed on the drawing surface are exported, including elements hidden from view by overlapping layers.

Spot color separation produces one page or file for each color exported. All occurrences of a given color are exported to a single page or file, regardless of the layer on which they occur.

Remember the following about spot colors:

☐ Any small variation in a color causes it to be treated as a distinct color that is exported separately. For example, a color that is 66.6% red is exported separately from a color that is 66.7% red, although the two colors might otherwise be identical.

☐ The actual colors are not exported to the file (or files). Instead, the area occupied by the color is exported as solid black or (in the case of fountains and blends) as shades of gray. This allows you to go directly to offset plates.

Selected Elements
All selected elements on the drawing surface are exported.
Export To

The Export To options determine what kind of file is produced by the Export command. The availability of the options depends on the Export From option chosen above.

Single-Sheet .GEM File

The result is a single file containing the active layer, visible layers, or selected elements. This file can be opened in Artline or merged into an Artline file.

Multiple .GEM Files

The result is a separate file for each exported layer, slide, or color. Each file can be opened in Artline or merged into an Artline file.

When exporting to multiple .GEM files, the filename you specify cannot be more than five characters long. Artline uses the remaining three characters for automatic numbering of the files—for example, SLIDE000.GEM, SLIDE001.GEM, and SLIDE002.GEM. Note that the numbering starts with 000.

Multiple-Page .GMP File

The result is a single file with separate pages for each exported layer, slide, or color. Using the Output program, you can print this file or display it on the screen. For example, using the Slides option and a series of layers sharing one or more backgrounds, you can create an entire on-screen slide presentation in a single file.

Abandon Command

The Abandon/Save alert is displayed (see page 3-2).

The Abandon command discards all unsaved changes to the picture you are working on and opens the current saved version of the file.
Page Layout Command

The **Page Layout** command displays the Page Layout dialog.

![Page Layout Dialog]

**Page Options**

The Page options menus allow you to specify the size of your paper, its page orientation, and the current unit of measure.

**Size**

The Size pop-up menu lists the standard American and European paper sizes, plus two special options:

- The Slide option sets a page size with the same aspect ratio (height-width ratio) as a 35mm slide.
- The Custom option displays the Custom Page Size dialog so you can set a custom page size.
Orientation
Portrait is a vertical page orientation; Landscape is a horizontal page orientation.

Unit of Measure
The unit of measure chosen in this pop-up menu is reflected throughout Artline in the rulers and in all dialogs that have measurement fields.

Marks Options
The Marks options turn on registration marks and trim marks and set offsets for these marks.

Registration Marks
Registration marks are used for printing color separations. The marks, which are placed outside the picture's trim area (see the description of trim marks below), ensure that each color is accurately placed as the paper passes through the press.

Trim Marks
Trim marks indicate the actual size of the finished page. All paper outside the trim marks is cut away after the page is printed.

NOTE: Some programs refer to trim marks as "crop marks," a term that more commonly refers to the marks used to indicate where a photograph should be cut before it is pasted onto a layout page.

Offsets
The offset values make it possible to specify a trim size smaller than the specified paper size. The values are measured from the edges of the paper and determine where the trim marks are placed on the page.
To calculate the trimmed size, subtract *twice* the offset value from each dimension. For example, on 8.5 by 11-inch paper, Horizontal and Vertical values of 1.0 and 1.5 inches, respectively, define a trim size of 6.5 inches by 8 inches.

You can use offset values of zero when preparing files for a phototypesetter, where the actual sheet size is usually considerably larger than a standard piece of paper. To place trim marks that define your true page size, specify the actual trim size in the Size option and set the Marks offsets to zero.

**NOTE:** For trim marks and registration marks in PostScript output, you must turn them on in the PostScript dialog. See page 3-20.
PostScript Command

You do not have to save the current file before starting PostScript output.

The **PostScript** command displays the PostScript Output dialog so you can print directly to a PostScript printer or create a file in the standard PostScript or the encapsulated PostScript format.

PostScript Output Dialog

To stop PostScript output, press the **Esc** key.

Device Options

The "Output to" menu lists a choice of three parallel PostScript devices (LPT1 through LPT3), three serial devices (COM1 through COM3), and two file options.

For all options except encapsulated PostScript (described on the next page) you can specify as many as 99 copies. Type the number of copies directly into the field or use the pop-up slider.
File

The File option creates a file (with extension .C00) that you can print on a PostScript device. You could, for example, print to a file on a floppy disk and then:

- go to a print shop and print on a phototypesetter;
- take the disk to a computer connected to a PostScript printer.

To print on the PostScript device, use the operating system's Copy command in this format:

```
COPY FILENAME.C00 LPT1
```

[or LPT2, COM1, COM2, etc.]

If you are on a network and your printer's device number is higher than those available in the "Output to" menu—LPT6, for example—you can print to a file whose name is the same as the device number. If, for example, you print to a file called LPT6, the operating system will intercept the file and send it to device LPT6.

EPSF

The encapsulated PostScript option produces a file specifically intended for inclusion in documents created with programs like Xerox® Ventura Publisher® or Aldus® PageMaker®.

The Include Preview option adds a TIFF-format "snapshot" of the drawing surface to the file, so the file can be displayed in PageMaker or Ventura (Release 2.0 or higher). This option replaces the "# of copies" field.

The TIFF preview increases the size of the EPSF file by an amount ranging from 5Kb to 25Kb, according to the resolution of your screen and the size of the picture relative to the full drawing surface. The more the picture fills the drawing surface, the larger the preview.

For files created with the preview option turned off, a large X fills the frame in Ventura. Although not visible on the screen, the picture will print correctly.
Printer Paper Options

These options specify the size and orientation of the printer paper and a percentage for scaling the picture to the output page.

Size

The Size menu lists the standard American and European paper sizes, plus two special options:

- The Slide option sets a page size with the same aspect ratio (height-width ratio) as a 35mm slide.
- The Custom option displays the Custom Page Size dialog (page 3-10) so you can set a custom page size.

Orientation

The orientation options in the PostScript dialog refer to how the paper is inserted into the printer; they are not the same as the options in the Page Layout dialog.

The Portrait option is for most typical PostScript printers; the paper is inserted vertically. The Landscape option is for wide-carriage PostScript printers and phototypsetters; the paper is inserted in a horizontal orientation.

Scaling

These options determine the size of the picture on the printed page.

"Fit to Paper" enlarges or reduces the picture as needed to fit the selected paper size. The percentage field allows you to scale the picture to a specific size, ranging from 10% to 500% of its size in the file. At 100% the picture is printed in its original size.

If the picture size is larger than the paper size, the picture is cropped.
Separation Options

The Separation pop-up menu gives you these options:

<table>
<thead>
<tr>
<th>Options</th>
<th>Spot Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>*</td>
</tr>
<tr>
<td>4-Color</td>
<td></td>
</tr>
<tr>
<td>Spot Color</td>
<td></td>
</tr>
<tr>
<td>Layers</td>
<td></td>
</tr>
<tr>
<td>Slides</td>
<td></td>
</tr>
</tbody>
</table>

None

There is no separation. Everything appears on one page or in a single file.

4-Color

The colors in the file are divided into the four process printing colors—cyan, magenta, yellow, black (CMYK). A separate page is printed for each color. (In file output, each color is stored as a separate page within the file.)

Spot Color

Each color in the file is printed on a separate page or is stored as a separate page within a file.

Layers

Every layer in the file is printed on a separate page or is stored as a separate page within a file.

Slides

The layers in the file are printed on separate pages or are stored as separate pages within a file. Background layers are printed only with the layers to which they are linked. Slides are described on page 10-8.
PostScript Screen Options

When you click on the Screen Options button, a new dialog appears on top of the PostScript Output dialog.

![PostScript Options Dialog]

**NOTE:** PostScript Screen Options are not available for EPSF output. However, any fountain screens set with PostScript Fill Options (see page 12-15) do appear in EPSF output.

Halftone Options

The Halftone Options give you greater control over how your picture is printed in PostScript output.

**Screen Function**

You can use the PostScript device's values for screen type, resolution, and angle or you can set your own values.

If you set your own values, first choose between a Round Dot screen and a Line screen. In a Dot screen, colors and shades of gray are created by varying the weight of colored or black and white dots. In a Line screen, colors and shades of gray are created by varying the thickness of parallel lines. Dot screen and line screen are illustrated on page 12-16.

---

File Menu 3-17
Resolution

Screen resolution (also known as “halftone screen frequency”) allows you to control the sharpness of halftones. Resolution for both dot screens and line screens is measured in lines per inch (lpi).

Because the resolution of output devices is fixed—for example, 300 dpi for a typical laser printer and 2540 dpi for a phototypesetter—increasing the halftone resolution significantly reduces the number of available gray levels. This equation shows how the two are related:

\[ lpi = \frac{dpi}{\sqrt{grays}} \]

or, stated another way:

\[ grays = \left(\frac{dpi}{lpi}\right)^2 \]

For example, on a 300 dpi printer, a resolution of 50 lpi produces thirty-six gray levels; a resolution of 100 lpi produces only nine gray levels. The resolution is twice as great, but the number of gray levels is one fourth what it was. (The effective resolution of solid colors is unchanged.)

Screen Angle

*Screen Angle* refers to the physical angle at which screens are printed relative to each other. This option is intended primarily for creating special effects in unseparated output and in spot color separations.

In 4-color separation, the screen angles are set automatically (to avoid undesirable moiré patterns in the ink) and override anything set with this option.
Output Options

This portion of the Set Screen Options dialog allows you to turn on the following:

- color correction
- separation names
- trim marks
- registration marks

Color Correction

Color correction is intended to compensate for two problems commonly encountered in printing color separations:

- Typical CMY inks are "contaminated," containing sometimes significant amounts of the other colors. For example, cyan usually contains 30% magenta, and magenta contains 50% yellow.

  This aspect of color correction is called undercolor removal, as it removes the colors that are "underneath" the main color. For example, without undercolor removal, an area where magenta overlaps cyan might contain too much magenta because of the magenta already in the cyan.

  The specifics of undercolor removal are:

  - Where yellow and magenta overlap, the yellow separation is reduced by 50% of the amount of magenta.
  - When magenta and cyan overlap, the magenta separation is reduced by 30% of the amount of cyan.

- The only way to get a good black is to use black ink, not by combining cyan, magenta, and yellow. Color correction adds enough black to give the colors extra intensity and contrast.

  For more information on colors, see the discussion of color models in Chapter 12.
Separation Names

This option places the name of the color separation on each page.

Trim Marks

This option places trim marks on each page. Trim marks are important when the page size is different from the sheet size, often the case with phototypesetters. See the discussion of trim marks on page 3-11.

Registration Marks

This option places registration marks on each page. Registration marks are essential for proper alignment of colors in color separations. See the discussion of registration marks on page 3-11.

NOTE: To get trim marks and registration marks in PostScript output, you must turn on these options in the PostScript dialog, regardless of their state in the Page Layout dialog.
To App Command

The **To App** command allows you to start another application from Artline, pass a file to that application, and then return to Artline when you are done.

When you choose the **To App** command, Artline displays the Run Application dialog:

![Run Application dialog](image)

The Run button displays the Item Selector so you can choose an application. The application does not have to be on the same drive as Artline.

The Item Selector is described on page 1-20.

**Parameters**

These options determine the information passed to the application you are running. The information is often the name of a file, which is automatically opened when the other application starts.

**Current File**

Select this option to pass the name of the current file to the other application.
Current Image
Select this option to pass the name of the current background image to the other application, typically ScanXpress™, or GEM® Paint™.

Request
Select this option to display the Command Line dialog, which allows you to specify something other than the current picture or image.

If you are running an application like Presentation Team, enter a filename. Give the entire path, as in this example:

C:\REPORTS\MONTHLY\JANUARY.PTP

If you are running a DOS executable program, enter any parameters in this dialog.

None
Select this option if you want to run the application without supplying a filename or any parameters.

Application Type
These options identify the type of application you are starting.

GEM
The application is a graphics-based program running under the same “system software” as Artline. Select this option if you are running applications like Presentation Team, GEM Draw Plus or GEM® Desktop Publisher™.
CAUTION: Some GEM-based applications, including Xerox Ventura Publisher, should not be started in this manner. Ventura uses its own system software, different from Artline's.

DOS

The application is a “non-graphics” application—perhaps a word processor, database, spreadsheet, or one of the operating system executable files.

When you specify a DOS application, you can also identify it as a “Full Memory” application—one that requires a large amount of memory.

When a full-memory application is started, most of the underlying GEM system software is removed from memory to make room for your DOS application. As a result, returning to Artline takes slightly longer than it would if you had not requested full memory.

Options

These two choices determine what occurs before and after you run the other application.

Auto-Save Current Picture

Artline automatically saves the current picture file before the other application is started.

Return to Artline

When you exit or Quit the other application, Artline is automatically re-started. When this check box is turned off, you exit to the operating system command line or wherever you were when you started Artline.
To Output Command

The To Output command starts the Output program so you can print the current picture file, display it in screen output, or make transparencies with a camera. Output is described in the Artline Utilities Guide.

Quit Command

The Quit command ends your session with Artline and returns you to the point from which you started, either the operating system command line or the GEM Desktop.
This chapter describes the Image menu commands, which are used in connection with image tracing. Chapter 11 describes image tracing in detail.

### Load Image Command

Image files serve only as a drawing aid for tracing. They cannot be edited with Artline, and they cannot be saved as Artline files.

The **Load Image** command loads an image into the drawing surface background. You can use the Trace tool, Quill, or other drawing tools to trace the image.

You can load files in the IMG, PCX or TIFF formats (see "Valid Image File Formats" on the next page). If you change the extension in the Item Selector to anything else (.GEM, for example), Artline displays this alert:

![Wrong file type. The file extension must be *.IMG, *.PCX, *.TIF.](retry_cancel)

Only one image can be loaded at a time. If you load a new image, the old image is removed; no alert is displayed.
Valid Image File Formats

This section provides more information on the supported IMG, PCX, and TIFF formats.

IMG and PCX Files

The following kinds of files can be loaded:

- black and white Line Art images: no restrictions.
- color Line Art images: a maximum of sixteen colors is supported.
- Grayscale images: files with sixteen or 256 grayscale values are supported.

TIFF Files

There are several different formats used by programs generating TIFF files. The following are general guidelines describing the supported formats:

- black and white Line Art images: compressed and uncompressed formats are supported.
- color Line Art images: uncompressed and some compressed formats, both with a maximum of sixteen colors, are supported.
- Grayscale images: only uncompressed images with sixteen or 256 grayscale values are supported. Because of the dithering scheme used, images with 256 grayscale values will lose some information when displayed.

Invalid Formats

If the file you are trying to load is not in one of the supported image file formats, Artline displays this alert:

Wrong image file format.

Image files must be in supported IMG, PCX, or TIFF file formats.

Cannot load image.
Unload Image Command

The **Unload Image** command removes the currently loaded image from the drawing surface background and from memory.

The image is deleted immediately; Artline does not display an alert. Do not use this command if you only want to check the progress of your tracing; use the **Image** command in the View menu or the F9 key instead.

Image Options Command

The **Image Options** command displays the Image Options dialog. The settings in this dialog control how an image is displayed.

The Image Options dialog and its settings are described on page 11-4.
THIS chapter describes the commands in the View menu. Several of these commands enable you to use features of Artline that make possible great precision in your drawings.

<table>
<thead>
<tr>
<th>View</th>
</tr>
</thead>
<tbody>
<tr>
<td>▶ Image F9</td>
</tr>
<tr>
<td>▶ Colors F10</td>
</tr>
<tr>
<td>▶ Fountains</td>
</tr>
<tr>
<td>▶ Rulers</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>▶ Snap to Grid</td>
</tr>
<tr>
<td>Set Grid...</td>
</tr>
<tr>
<td>▶ Guide Lines</td>
</tr>
<tr>
<td>Set Guide Lines...</td>
</tr>
<tr>
<td>▶ Toolbox</td>
</tr>
</tbody>
</table>

Toggles

Most of the View menu commands are toggles. They function like a light switch, turning something on and off. For example, the Rulers command turns the rulers on (displays them) or, if the rulers are already on, turns them off (removes them from the screen).

When in its “on” state, the command is flagged with a marker in the menu. (In the illustration above, the Colors command is one of several that are toggled on. The Rulers command is toggled off.)
Image Command

Image tracing is described in Chapter 11.

The **Image** command toggles the display of an image loaded for tracing on and off. Its keyboard command equivalent is F9.

You can check the progress of a tracing with the image turned off. (The image is still in memory. To remove an image from memory, choose the **Unload Image** command from the Image menu.)

Colors Command

When colors are turned off, all elements appear as thin black outlines.

The **Colors** command toggles the display of all fill colors, fountains, line colors, and other line attributes on and off. The keyboard command equivalent is F10.

Turning off colors reduces the amount of time required to draw elements on the screen and can greatly speed your work in Artline. (There is one exception. See the Caution below.)

Colors are automatically turned off when you select the Plane tool.

---

**CAUTION:** Do not turn off colors when working with masked elements, especially complex ones. The redraw time for masks can be substantially longer with colors turned off.
Fountains Command

The **Fountains** command toggles the display of fountains off and on. Turning off fountains can improve Artline’s speed in drawing elements, especially those that contain fountains drawn at an angle.

When fountains are turned off, the fountain is replaced by the fill pattern shown below.

![Fill Pattern](image)

The **Colors** command overrides the **Fountains** command. If colors are turned off, the fountained element appears as an outline. When colors are turned back on, the state of the fountained element is determined by the **Fountains** command.

Rulers Command

The **Rulers** command toggles the display of the rulers on and off. The rulers use the Unit of Measure set in the Page Layout dialog.
Status Line Command

The Status Line command is a toggle that turns the display of the status line on and off.

The status line always gives this information:

- current defaults for fill and line color
- name of current tool selected
- number of elements selected
- X and Y values of the pointer's current position

The pointer's X and Y values are measured from the upper left corner of the drawing surface. The values use the current Unit of Measure from the Page Layout dialog. When the pointer is off the left side of the drawing surface or above it, the status line shows negative values.
The additional information displayed in the status line depends on the currently selected tool or action:

- **Selector tool:** The status line display depends on what you are doing:
  - moving elements: the change in the mouse’s X and Y positions. Positive values indicate that you are moving the element down or to the right; negative values indicate movement up or to the left.
  - scaling elements: horizontal and vertical scaling values.
  - moving the guide lines: the guide lines’ current position, measured from the upper left corner of the drawing surface.

- **Rectangle tool:** the width and height of the rectangle you are drawing.

- **Circle tool:** the horizontal and vertical “radius” of the circle or ellipse you are drawing.

- **Line Tool:** the angle of the line you are drawing.

- **Rotator Tool:** the current rotation angle.

- **Flipper Tool:** the current flip angle.

- **Rolling Pin Tool:** horizontal and vertical scaling percentages.
Grid Command

The Grid command is not available when the grid spacing is set to zero. See the description of the Set Grid command.

The Grid command toggles the display of the grid on and off. The grid is a pattern of dots—at intervals set with the Set Grid command—that aid in the drawing and placement of elements.

Snap to Grid Command

The Snap to Grid command is not available when the grid spacing is set to zero. See the description of the Set Grid command.

The Snap to Grid command toggles the grid snap on and off. Grid snap has two meanings, depending on when you use it.

- When you are drawing elements:
  All points—corners of rectangles, anchor points, and so on—automatically “snap” (attach themselves) to the grid point nearest to the location at which you clicked or to which you dragged.

  Grid snap allows you to draw elements in precise sizes and at precise locations on the drawing surface.

- When you are moving or scaling elements with the Selector or moving anchor points or direction points with the Plane:
  The pointer moves by exact multiples of the grid's current horizontal and vertical spacing (see the Set Grid command, next). Elements or points snap to a grid point only if they start from one.

  In this case, the command is more “Snap by Grid Increments” than Snap to Grid.

NOTE: When Snap to Grid is turned on, elements snap to the grid or move by grid increments whether the grid is visible or not. The one exception is the Sketch tool, which never snaps to the grid, regardless of the state of this command.
Set Grid Command

The **Set Grid** command displays the Set Grid dialog.

![Set Grid dialog](image)

**Spacing**

These fields set the Vertical and Horizontal spacing of the grid points, using the Unit of Measure currently set in the Page Layout dialog. Note the following:

- Acceptable values vary according to the current unit of measure. For Inches, the acceptable values are multiples of one sixteenth of an inch (0.0625).
  
  If you enter an invalid number, the field is automatically reset to the nearest valid multiple lower than the number you entered.

- The default value for grid spacing is a single unit of the current unit of measure—for example, 1 inch if the Unit of Measure is Inches.

- If you try to enter a value larger than the maximum allowed in these fields, Artline displays an alert and then sets the value to the maximum.

- The Vertical and Horizontal values do not have to be the same; the grid does not have to be a square.

When the Spacing values are set to zero—in other words, when there is no grid—the **Grid** and **Snap to Grid** commands are not available.
Guide Lines Command

The **Guide Lines** command toggles the guide lines on and off.

The purpose of the guide lines is to help you place elements on the drawing surface. In addition, you can use the guide lines in conjunction with specific commands to:

- align elements (**Align** command, page 6-9)
- rotate elements (**Rotate** command, page 7-7)
- scale elements (**Scale** command, page 7-9)
Set Guide Lines Command

The Set Guide Lines command displays the Set Guide Lines dialog so you can locate the guide lines precisely on the drawing surface.

The position of the guide lines is measured from the upper left corner of the drawing surface.

The value in the Vert. Line field sets the position of the vertical guide line relative to the left edge of the drawing surface.

The value in the Horiz. Line field sets the position of the horizontal guide line relative to the top edge of the drawing surface.

When initially displayed, the guide lines intersect at the center of the drawing surface, and the values are half the width and height of the current page size.

You can also move the guide lines by dragging them with the Selector tool. For greater accuracy, display the status line first.
Toolbox Command

The **Toolbox** command toggles the display of the toolbox off and on.

When the toolbox is turned off, a somewhat larger workspace is available. Before turning off the toolbox, make sure you select the tool you want to use; you cannot select tools while the toolbox is not displayed.
Element Menu

This chapter describes the commands in the Element menu, which affect only selected elements in the active layer.

<table>
<thead>
<tr>
<th>Element</th>
</tr>
</thead>
<tbody>
<tr>
<td>Send to Back</td>
</tr>
<tr>
<td>Bring to Front</td>
</tr>
<tr>
<td>Step in Back</td>
</tr>
<tr>
<td>Step in Front</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Element</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lock</td>
</tr>
<tr>
<td>Unlock</td>
</tr>
<tr>
<td>Group</td>
</tr>
<tr>
<td>Ungroup</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Element</th>
</tr>
</thead>
<tbody>
<tr>
<td>Align to Grid</td>
</tr>
<tr>
<td>Align...</td>
</tr>
</tbody>
</table>

| Element Info |

Element Order

Several of Artline's features—including blends and masks—are affected by the order of elements in the stack. (See the discussion of stacks in Chapter 1.)

The first four commands in the menu—Send to Back, Send to Front, Step in Back, and Step in Front—change the order of selected elements in the stack.

Each command can work on a single element, on several elements, and on grouped elements.
Send to Back Command

Keyboard command: down-arrow.

The Send to Back command moves selected elements to the bottom of the stack. If you select several elements to Send to Back, all are sent to the bottom of the stack, but their order relative to each other is maintained.

Bring to Front Command

Keyboard command: up-arrow.

The Bring to Front command moves selected elements to the top of the stack. If you select several elements to Bring to Front, all are brought to the top of the stack, but their order relative to each other is maintained.

Step in Back Command

Keyboard command: Shift-down-arrow.

The Step in Back command moves a single selected element down one level in the stack.

Step in Front Command

Keyboard command: Shift-up-arrow.

The Step in Front command moves a single selected element up one level in the stack.
Step in Front Command

Send to Back

Bring to Front

Step in Back

Step in Front

Element Menu

6-3
The **Lock** command "locks" selected elements or groups so that they cannot be changed in any way. You cannot delete or move locked elements, change their fill or outline colors, mask or blend them. The only thing you can do to locked elements is unlock them.

Locking elements is especially useful if you are creating a complex picture and want to safeguard specific parts of the picture from accidental changes. (You can also protect parts of your pictures by separating them onto layers. See Chapter 10.)

When you click on a locked element with the Selector, Artline indicates that it is locked by using a different kind of handle—a hollow square at the corners only, as shown below.

---

**Unlock Command**

The **Unlock** command changes selected locked elements or groups back to their regular state. The standard element handles are restored, and you can again delete, copy, move, change color, and so on.
Group Command

The **Group** command makes all selected elements into a group, which Artline then treats as a single element. The group is enclosed within a single selection frame.

You can do almost anything to a group that you can do to a single element: move, copy, delete, rotate, and so on.

**Characteristics of Groups**

- When you group elements, they are automatically brought to the top of the element stack. The order of the elements in the group relative to each other is unchanged.

- When you change the size of a group, you change the size of every element in the group proportionally.

- Elements in a group can have different colors or fountains and different line attributes. However, if you assign a color, fountain, or line attribute after you make the group, it will appear in every element in the group.
The appearance of fountains in grouped elements depends on whether you assign the fountain to the elements before or after you make the group.

- If you assign the fountain before you group the elements, each element contains the full color range of the fountain.
- If you assign the fountain after you group the elements, the entire group is treated as a single element, and the color range of the fountain is applied to the entire group.

Groups cannot be merged or blended and cannot be used as a path element for text along a path.

You can nest groups within groups, up to a maximum of ten “levels.” For example, you could group two elements, then select a third element and group it with the group.

The **Ungroup** command breaks a selected group into its component elements or groups.

**Ungroup** is the exact reverse of **Group**. If you create a nested group with a series of five **Group** commands, it takes five **Ungroup** commands to break it apart entirely.
Align to Grid Command

The **Align to Grid** command snaps selected elements to grid points in the following manner:

- **single element or group**
  
  The upper left corner of the selection frame snaps to the first grid point *above and to the left* of its current position. If the element or group is already on a grid point, it does not move.

- **two or more elements**
  
  The elements are aligned as if they were a group. The upper left corner of an imaginary frame enclosing the selected elements snaps to the first grid point above and to the left. The position of the elements relative to each other is unchanged.

**NOTE:** **Align to Grid** works whether or not the grid is visible or the grid snap is turned on. The command is not available when the grid spacing is set to zero—in other words, when there is no grid. See the description of the **Set Grid** command on page 5-7.
Align Command

The **Align** command allows you to align selected elements several different ways and to several reference points. When you choose the **Align** command, Artline displays the Element Alignment dialog.

![Element Alignment dialog](image)

**Align To**

This option determines the point of reference used for alignment.

**Selection Frame**

Elements are aligned to the center, corners, or midpoints of an imaginary frame enclosing them.

**Thumbtack**

Elements are aligned to the position of the Thumbtack.

**Guide Lines**

Elements are aligned to the guide lines. The guide lines are described on page 5-8.
Horizontal and Vertical Alignment

Use Horizontal settings to align elements to the left, center, or right and Vertical settings to align to the top, middle, or bottom. You can combine Horizontal and Vertical alignment options. See the examples on the next page.

To select an alignment option:

☐ Display the Horizontal or Vertical menu and choose the alignment from the menu.

☐ Drag the alignment tool bars to the position you want. The name of the alignment you have chosen appears in the pop-up bar.

Note that the vertical bar controls Horizontal alignment (left to right) and the horizontal bar controls Vertical alignment (top to bottom).

☐ Click in the gray area of the alignment tool where you want the elements aligned. For example, for an upper right alignment, click in the upper right corner of the alignment tool.

To turn off alignment in one direction:

Click on the box to the left of the alignment name so that no X appears. When an alignment is turned off, its pop-up bar is grayed out, and the aligning tool for that direction is not displayed.
Element Info Command

Double-clicking on the selected element has the same effect as choosing the **Element Info** command.

The **Element Info** command displays one of several different dialogs, depending on the type of element that is currently selected, as described below.

The command is available only for a single element or group—anything within a single selection frame. You cannot choose **Element Info** when more than one element has been selected.

The following table lists the dialogs displayed by the **Element Info** command.

<table>
<thead>
<tr>
<th>element type</th>
<th>dialog displayed</th>
</tr>
</thead>
<tbody>
<tr>
<td>elements drawn with Quill, Trace, Sketch, Rectangle, Circle, and Line tools</td>
<td>Element Info</td>
</tr>
<tr>
<td>groups</td>
<td>Element Info</td>
</tr>
<tr>
<td>merged elements</td>
<td>Element Info</td>
</tr>
<tr>
<td>text converted to curves</td>
<td>Element Info</td>
</tr>
<tr>
<td>text (not converted to curves)</td>
<td>Create Text Element</td>
</tr>
<tr>
<td>text along a path</td>
<td>Text Along a Path</td>
</tr>
<tr>
<td>blends</td>
<td>Blend Elements</td>
</tr>
<tr>
<td>masks</td>
<td>Mask Elements</td>
</tr>
</tbody>
</table>
Element Info Dialog

<table>
<thead>
<tr>
<th>Element Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Position &amp; Size</strong></td>
</tr>
<tr>
<td><strong>Vertical</strong></td>
</tr>
<tr>
<td><strong>Horizontal</strong></td>
</tr>
</tbody>
</table>

This element has 59 points.

You can use the Element Info dialog to place an element precisely on the drawing surface, set an exact size, or to find out how many points or elements it contains.

To set an element's position:

Enter values in the Vertical and Horizontal fields. These values set the location of the upper left corner of the frame enclosing the selected elements. The distances are measured from the upper left corner of the page.

To set an element's size:

Enter values in the Width and Height fields. These values set the width and height of the frame enclosing the selected elements. This frame is always a rectangle.

Counter

The Element Info dialog's counter tells how many points an element contains or, in the case of groups, how many elements are contained in the group.

When the selected element is a group or text converted to curves (which is treated as a group), the counter tells how many "child" elements the group contains. See the illustration on the next page.
Text Elements

For selected text, **Element Info** displays the Create Text Element dialog so you can edit the text or choose a different font, point size, line spacing, or alignment.

Masked Elements

For selected masks, **Element Info** displays the Mask Elements dialog so you can choose whether to draw the mask element. Masking elements is described on page 8-1.

Blended Elements

For selected blends, **Element Info** displays the Blend Elements dialog so you can choose a different number of steps for the blend or reverse the curve direction. Blending elements is described on page 8-8.

Text Along a Path

For selected text along a path, **Element Info** displays the Text Along a Path dialog so you can choose a different text scaling option, whether to show the path element, or whether to rotate the text around the path. Text along a path is described on page 8-14.
Edit Menu

This chapter describes the commands in the Edit menu. Most of the Edit menu commands affect the currently selected element or elements on the drawing surface.

<table>
<thead>
<tr>
<th>Command</th>
<th>Key</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo</td>
<td>U</td>
</tr>
<tr>
<td>Cut</td>
<td>X</td>
</tr>
<tr>
<td>Copy</td>
<td>C</td>
</tr>
<tr>
<td>Paste</td>
<td>P</td>
</tr>
<tr>
<td>Delete</td>
<td>E</td>
</tr>
<tr>
<td>Select All</td>
<td>S</td>
</tr>
<tr>
<td>Duplicate</td>
<td>D</td>
</tr>
<tr>
<td>Clone</td>
<td>L</td>
</tr>
<tr>
<td>Move</td>
<td>H</td>
</tr>
<tr>
<td>Rotate</td>
<td>R</td>
</tr>
<tr>
<td>Scale</td>
<td>Q</td>
</tr>
<tr>
<td>Repeat</td>
<td>F1</td>
</tr>
</tbody>
</table>
Undo Command

The **Undo** command allows you in several cases to cancel your last action and restore the drawing surface to the way it was.

You can undo the effects of these tools and commands:

- Delete command
- Selector tool (move or scale)
- Rotator tool
- Flipper tool
- Rolling Pin tool
- Align command
- Align to Grid command
- Move command
- Rotate command
- Scale command
- Repeat command

The command name that appears in the menu is **Undo** followed by the name of the action to be undone—like Move, Scale, or Align.

Cut Command

The **Cut** command removes the selected elements from the drawing surface and places them in the **paste buffer**.

Paste Buffer

The paste buffer is an area of your computer’s memory reserved for elements that you cut or copy. The contents of the paste buffer can then be pasted back onto the drawing surface.

The paste buffer is “one level deep.” Each time you cut or copy something to the buffer, the previous contents of the buffer are cleared out and can no longer be pasted.
Copy Command

The *Copy* command places copies of the selected elements in the paste buffer. The original elements remain on the drawing surface.

Paste Command

The *Paste* command takes the contents of the paste buffer and places it on the active layer of the picture.

Pasting does not empty the buffer. You can *Paste* the contents of the buffer as often as you want. When you quit Artline, however, the paste buffer is emptied.

Cutting and Pasting Between Files or Layers

You can use *Cut* and *Paste* (or *Copy* and *Paste*) to take something from one file or layer to another file or layer.

To cut and paste between files:

1. Select and *Cut* (or *Copy*) the elements you want.
   
   Because the paste buffer is only one level deep, you must select and cut *all* the elements you want.

2. Choose the *New* command or the *Open* command, depending on whether you want to paste the elements into a new file or an existing file.
   
   When the "Abandon/Save" alert is displayed, save or abandon the current file.

3. Choose the *Paste* command to paste the elements into the file now in the workspace.

---

*The New command and Open command do not affect the contents of the paste buffer.*
Delete Command

To cut and paste between layers:
1. Select and Cut (or Copy) the elements you want.
2. Use the Layer Selector to select the layer into which you want to paste the elements.
3. Choose the Paste command to paste the elements into the active layer.

Delete Command

The Delete command removes the selected elements from the drawing surface, but does not place them in the paste buffer.
Delete is the command to use when you want to throw something out. You can still “undelete” the elements by choosing the Undo Delete command, as long as you have not done anything else in the meantime that can be undone (see page 7-2).

Select All Command

The Select All command selects all the elements on the drawing surface. If the picture is divided into layers, the command selects all the elements on the active layer only.

CAUTION: Remember that, depending on the current view, the workspace might enclose only a portion of the drawing surface. The Select All command can select elements that are not visible in the workspace. Actions that affect selected elements (like Delete) can affect elements you don’t see.
Duplicate Command

The Duplicate command copies the selected elements directly onto the drawing surface. The copies are offset slightly below and to the right of the originals and are selected. If grid spacing has been set, the duplicate elements appear one grid increment below and to the right of the originals. (See the description of the Set Grid command on page 5-7.)

NOTE: The Duplicate command does not use the paste buffer, so copying elements in this manner does not affect what is in the buffer.

Clone Command

The Clone command copies the selected elements directly onto the drawing surface. Unlike the Duplicate command, Clone places the copies directly on top of the originals.

The Clone command can be used, among other things, in creating multi-color blends. See page 8-13.
Move Command

You can also move elements with the Selector tool or the Element Info command.

The Move command displays the Move Elements dialog so you can move the selected elements a specified distance. This method of moving elements gives you greater precision than does moving elements with the Selector Tool. For example, to move an element exactly 1.6 inches, use the Move command.

![Move Elements Dialog]

Type directly into the Horizontal and Vertical fields, or use the pop-up sliders to enter values. To move the elements to the left or toward the top of the drawing surface, enter negative values in the Horizontal and Vertical fields, respectively.

The Make Copy option makes copies. The original elements remain where they were, and the copies are moved by the distances specified in the dialog.
Rotate Command

You can also rotate elements with the Rotator tool.

The **Rotate** command displays the Rotate Elements dialog so you can rotate the selected elements.

![Rotate Elements dialog box](image)

Rotate Around

Use these buttons to select a center of rotation for the selected elements.

**Selection Center**

A single element is rotated around the center of its selection frame. If you select more than one element to rotate, the elements are treated as if they were a group and are rotated around the center of an imaginary selection frame enclosing them.

**Thumbtack**

The Thumbtack serves as the center of rotation for a single element or for the imaginary selection frame enclosing more than one selected element.

**Guide Lines**

The intersection point of the guide lines serves as the center of rotation for a single element or for the imaginary selection frame enclosing more than one selected element.
Rotate Command

Rotate Around: Selection Center

Rotate Around: Thumbtack

Rotate Around: Guide Lines

Rotation Angle

This field determines the angle through which the element (or elements) will be rotated. Type directly into this field or drag the pop-up slider to enter a value. Elements are rotated clockwise.

Make Copy

The Make Copy option makes copies rotated by the angle specified in the dialog. The original elements remain where they were.
Scale Command

You can also scale elements with the Selector tool or the Element Info command.

The Scale command displays the Scale Elements dialog so you can scale (change the size of) selected elements.

![Scale Elements dialog]

Scale Options

Use these options to choose uniform or non-uniform scaling and to choose the scaling percentage.

NOTE: The scaling values are percentages of the original. 100% is the element’s original size. 50% is half size; 200% is twice the original size.

Uniform

The height and width of the elements are scaled equally, and the proportions of the elements are unchanged from the original.

When you choose Uniform scaling, a single Size field is available. Type a percentage directly into the field, or use the pop-up slider to set a percentage. This percentage is used for both horizontal and vertical scaling.
Non-Uniform
The height and width of the elements are scaled separately, allowing you to change the proportions of the originals.

When you choose Non-Uniform scaling, separate Horizontal and Vertical fields are displayed. Type percentages directly into the fields, or use the pop-up slider to set percentages.

Relative To
Use these buttons to select a point relative to which the selected elements will be scaled.

Selection Center
A single element is scaled around the center of its selection frame. If you select more than one element to scale, the elements are treated as if they were a group and are scaled around the center of an imaginary selection frame enclosing them.

Thumbtack
The Thumbtack serves as the scaling point for a single element or for the imaginary selection frame enclosing more than one selected element.

Guide Lines
The intersection point of the guide lines serves as the scaling point for a single element or for the imaginary selection frame enclosing more than one selected element. The guide lines are described on page 5-8.
When you scale relative to the Thumbtack or guide lines, the distance of the element from the scaling point changes as well. In the illustration below, the element was scaled uniformly 130% relative to the guide lines.

The width and height of the element is 130% of the original, and its distance from the intersection of the guide lines is also 130% of the original.

If you scale an element non-uniformly—for example, 50% horizontal scaling and 200% vertical scaling—the resulting element is half as wide and twice as tall. The horizontal distance from the rotation center is half what it was before, but the vertical distance is now doubled.

Make Copy

The Make Copy option makes copies scaled by the percentage (or percentages) specified in the dialog. The original elements are unchanged.
Repeat Command

The **Repeat** command repeats the last action of these tools and commands on selected elements:

- Selector tool (moving or copying)
- Rotator tool
- **Move** command
- **Rotate** command
- **Scale** command
Combine Menu

This chapter describes the commands in the Combine menu. These commands include some of the most powerful features of Artline.

#### Mask Command

To restore a masked element to its component elements, choose the Split Element command.

The **Mask** command creates a "cookie cutter" effect, making it possible for you to insert patterns and designs of your own creation into the elements you draw.

The **Mask** command combines a *mask* element with a background to create a single element. The shape of the final masked element is the shape of the area where the mask and background overlap, as in the illustration on the next page.
Mask

The mask is the cookie cutter. Its shape determines the shape of the element created by the Mask command.

These rules apply to the mask element:

- The mask must be a single element, drawn with one of the drawing tools (like the Quill or the Rectangle tool) or created by the Merge Elements command (page 8-4). Merged elements are treated as a single element.

  You cannot use grouped elements as a mask.

- The mask must be the topmost of the selected elements.

To make sure the mask element is on top:
Select the element and then choose the Bring to Front command from the Element menu.

Background

The background is the design that will appear inside the mask shape. It can include:

- one or more separate elements;
- grouped elements;
- merged elements.
Draw Mask Element Option

The Mask Elements dialog, displayed when you choose the Mask command, gives you the option of drawing the mask element. When Draw Mask Element is turned on, the mask element's complete outline is visible.

To re-display the Mask Elements dialog and change the setting of the Draw Mask Element option, double-click on the masked element.

Text as a Mask

To use text as a mask, you must convert it to a single non-text element.

To use text as a mask:

1. Using the Text tool, enter the text into the Create Text Element dialog. Choose the typeface, point size, alignment, and other attributes you want, and exit the dialog.

   At this point the text does not have to be where you will want it located as the mask. In fact, it is easier to do the text manipulations in the next step in an open part of the workspace.

2. Using the Selector, Rotator, or other appropriate tools, make the text the size and shape you want.
Merge Elements Command

Once converted to curves, the text can no longer be edited as text.

3. If you haven't already, display the Combine menu and choose the Convert to Curves command. You may have already converted the text to curves, since that is required before you can manipulate the text with the Plane or Rolling Pin tools.

4. Display the Element menu and choose the Ungroup command.

5. Display the Combine menu and choose the Merge Elements command. The text is now merged into a single element that can be used as a mask element.

NOTE: Because text characters generally contain a larger number of points than other elements, you may find that you can use only a few words in your mask. To mask longer text strings, break the string into several separate masks.

Merge Elements Command

To restore a merged element to its component elements, choose the Split Element command.

The Merge Elements command merges selected elements together to make a single element. In this new element, the areas where the original elements overlapped become hollow.

The two main characteristics of merged elements—that a single element is created and that the common areas become hollow—make it possible to do the following:

- create a mask element (including text)
- create a "window" to an element below (page 8-6)
- create your own text characters

Creating text characters (described on page 8-7) takes advantage of both features of merged elements.
In some respects, merging is the opposite of masking—a kind of "reverse cookie cutter." When you mask elements, Artline draws only the area shared by the two elements. When you merge elements, Artline draws everything but the area shared by the two elements.

Merged elements are not the same as groups. There are some important differences.

- You can use merged elements as mask elements; you cannot use groups as mask elements.
- You can edit the points of a merged element with the Plane tool; you cannot edit the points of a group.
- In a group, each element retains its original attributes: color, line width, and so on.
  In a merged element, all the elements take on the attributes of the element on the top.
- In a group, elements can sit on top of other elements. For example, you can put a red square on top of a blue circle.
  In a merged element, overlapping elements create a hollow area. A square inside a circle creates a circle with a square hole cut out of it.
- Artline treats merged elements as a single element.
  If you select a merged element and then display **Element Info**, the Element Info dialog tells you how many points the element has.
  If you select a group and then display **Element Info**, the Element Info dialog tells you how many elements the group contains.

**NOTE:** You can merge as many elements as you wish, as long as the resulting merged element does not exceed the 255 point limit.
Creating a Window

Merged elements can create a window or border to elements underneath, a “picture frame” effect.

To create a simple window:

1. Draw and align the elements you want to merge—in this case, a rounded rectangle and a guitar.

2. The merged element will take the color and line attributes of the element on the top. Select one element, bring it to the top (if it is not already there), and assign its color and line attributes.

3. Select the elements you want to merge, display the Combine menu and choose the Merge Elements command. The elements are now merged.

4. Drag the merged element on top of the background design, which will now appear through the circular picture frame.

You can use text in your merge, although it must first be converted to curves and ungrouped.
To use text in a merge:

1. Enter the text using the Text tool and the Create Text Item dialog.
2. With the text selected, choose the **Convert to Curves** command from the Combine menu.
3. With the text still selected, choose the **Ungroup** command from the Element menu.
4. Select all the elements you want to merge and choose the **Merge Elements** command.

Creating Text Characters

By merging a letter’s outline and its interior shape—in typographical terms, the *counter* or the *bowl*—you can create your own custom text characters.

This method is especially useful for creating custom display characters for use in advertising, logos and letterheads, and presentations. Here is an example of a custom text character:

This technique is necessary only for letters with fully enclosed counters or bowls—like A, B, or g.

![Image of letter A](image)

...to create the merged letter. Note that the background shows through the interior of the letter.

**NOTE:** Text characters created in this manner are actually graphic elements shaped like letters; they are not true text characters. You cannot enter or edit them with the Text tool.
Blend Command

The **Blend** command creates an element where the shape and color of one element blend over a specified series of steps into the shape and color of another element.

You can use blends for a variety of effects, including these:

- **metamorphosis**—changing one object into something else entirely

  ![Image of guitar and star blending](image1)
  
  From guitar to star in 20 steps, with no outline, over a black background

- **even spacing of elements**—horizontal, vertical, or diagonal

  ![Image of guitars blending](image2)
  
  The two rows were created by blending from one guitar to the other in four steps (top row) and five steps (bottom row).

- **shading effects**

  ![Image of guitar shading](image3)

- **“rainbows”**—blends of colors that produce the effect of a fountain containing more than two colors

  ![Image of rainbow shades](image4)
  
  Creating rainbows is described on page 8-13.
To blend elements:

1. Select the two elements you want to blend.
2. Display the Combine menu and choose the **Blend** command.
   
   Artline displays the Blend Elements dialog.

<table>
<thead>
<tr>
<th>Blend Elements</th>
</tr>
</thead>
<tbody>
<tr>
<td># of Steps: 10</td>
</tr>
<tr>
<td>Reverse Curve Direction</td>
</tr>
<tr>
<td>OK Cancel</td>
</tr>
</tbody>
</table>

3. Type a number directly into the "# of Steps" field or use the pop-up slider to enter a value. The number of steps—which refers to the number of intermediate steps between the start element and the end element—can range from one to ninety-nine.

   Turn the "Reverse Curve Direction" option on or off. See the description and illustrations on the next page.

4. Exit the Blend Elements dialog. Artline draws the blended element.

**NOTE:** Blends always go from the element that is lower in the stack to the element that is higher in the stack.

To choose a different number of blend steps:

2. Enter a new number into the "# of Steps" field.
3. Exit the dialog. Artline re-blends the two elements, using the new number of steps specified in the dialog.
Point Mapping

In a blend, the points on one element are mapped to the points on the other element. You could draw lines from a point on the start element through the intermediate steps to the corresponding point on the end element.

If one element has fewer points than the other, Artline adds points to it so that both have the same number. (These points are added only for blending; they go away if you split the blend.)

Reverse Curve Direction

On some elements the direction of the points from first to last is clockwise; on other elements the direction is counterclockwise. (You can check the point direction with the Plane tool—see page 2-54.) If you blend from a clockwise element to a counterclockwise element, the result can be an undesirable corkscrew effect, as in the example below.

The “Reverse Curve Direction” option solves this problem by treating the end element of the blend as if its points were arranged in the reverse direction. For example, a counterclockwise element is treated as if it were a clockwise element, with the results shown below.
Blending Dissimilar Elements

Creating visually pleasing blends of dissimilar elements can require modification of the elements before blending. For example, blending a square to a letter C results in the effect on the left below. The desired effect is on the right.

The unmodified blend does not work successfully because the two starting points are located in different relative positions (the arrow in the illustration below shows how the starting points map from one element to the other) and the elements have a different number of points.

Remember that the letter must first be converted to curves and then ungrouped.

To blend successfully, you must move the square’s starting point and, because in this case you want the points on the square’s right side to map to the inside of the C, you must add points to specific locations on the square (instead of letting Artline do it for you).
To modify the square:

1. Use the Plane tool (page 2-53) to add one point to the top and bottom of the square and four points to the right side.

2. Select the point on the right side nearest the upper right corner and split it (Split Point command—page 2-59).

   These points will become the new start and finish points of the square.

3. Select the old start and finish points at the square's upper left corner and join them (Join Points command—page 2-59).

   You can now blend the square to the letter. (You might have to reverse the curve direction to get the desired effect.)

Elements Not Allowed in Blends

These types of elements cannot be included in blends:

- grouped elements
- masked elements
- merged elements
- fountained elements
- text along path

Merged elements include text characters with fully enclosed counters—like “A” or “B”—and dotted letters like the lowercase “i.” These characters are formed by merging a background shape with the counter or the main letter body with the dot.

Colors in Blends

The intermediate colors contained in the blend are not added to the current color file. Artline keeps track of the colors for screen display and output to a printer or file. See the description of the Convert to Curves command (page 8-18).
Creating Rainbows

Using the **Blend** command, you can create a rainbow of colors and shapes. The technique involves multiple blends and precise placement of elements.

Rainbow blends are especially effective when the elements have no outline.

There are many ways you can create an effect like this. Several of Artline's commands and other features are especially useful—notably the **Clone** command and the use of the **F4** key to select elements lower in the stack.

The example above was created with six blends of twenty-five steps each. With the exception of the squares at each end of the design, each element was cloned. The blend numbers below indicate the order of the blends in the stack, with the first blend on the bottom and the sixth on the top.
Text Along Path Command

To restore text along a path to its component elements, choose the **Split Element** command.

The **Text Along Path** command fits a selected text element to a selected *path* element.

The path can be any single element, like curves drawn with the Quill or shapes drawn with the Circle, Rectangle, or Rounded Rectangle tools. You can also use merged elements, but the effect can be a little odd.

Groups or other combined elements cannot be used as paths.

```
call it macaroni
```

Text Along a Path Dialog

When you choose the **Text Along Path** command, Artline displays the Text Along a Path dialog.

```
Text Along a Path

Text Scaling
- None
- Change Spacing to Fit
- Change Size to Fit

Options
- Show Path
- Rotate Text around Path

[OK] [Cancel]
```
Text Scaling

These options determine whether the text is scaled to fit the path element and, if so, how it is scaled.

None

The text is not scaled. Its point size and letter spacing are unchanged. If the path is shorter than the text, the text is cut off at the end of the path.

Change Spacing to Fit

The space between letters is increased or decreased to make the text fit the path. The text's point size is unchanged. If the path is shorter than the text, the letters will overlap each other to the degree required to make the text fit the path.

Change Size to Fit

The point size of the text is increased or decreased to make the text fit the path. The spacing between letters varies according to the point size. With this option the letters will not overlap each other.

Options

Show Path

When this option is turned on, the path element is drawn along with the text element. When the option is turned off, the text element is drawn to the shape of the path, but the path element itself is not drawn.
Text Along Path Command

Rotate Text Around Path

When this option is turned on, the text orients itself to the curve of the path element. When the option is turned off, the text retains its orientation.

Other Text to Path Effects

When you combine text to a path, the text string always starts from the first point of the path. The illustration below shows text combined to a circle.

If this is not the effect you seek, you can rotate the path element before or after you combine it with the text.

To place inside a path, combine the text to the path as you would normally, and then flip the combined element.
Changing Options

You can change the options at any time by re-displaying the Text Along a Path dialog.

To change text along a path options:

1. Select the text along a path element.
2. Double-click on the element.
   Artline displays the Text Along a Path dialog.
3. Choose the options you want, and exit the dialog. Artline will redraw the text along a path element according to the new options you have chosen.

Editing Text Along a Path

Text along a path cannot be edited directly. First you must split the text apart from the path and then re-open the Create Text Element dialog.

To edit the text you have placed along a path:

1. Select the text along a path element.
2. Display the Combine menu and choose the **Split Element** command. The text along a path element is split back into separate text and path elements.

   The **Split Element** command is described on page 8-20.

3. Select the text element and double-click on it. This displays the Create Text Element dialog.
4. Edit the text and then re-combine it with the path element.
The **Convert to Curves** command works on only two kinds of elements:
- text elements and text along a path
- blends

**Text Elements and Text Along a Path**

**Convert to Curves** converts a text element to a graphic element with the same properties as an element drawn with the Quill, Rectangle tool, or any of the other tools.

Text must be converted to curves before you can:
- use the Plane tool
- use the Rolling Pin
- merge text (for example, to use it as a mask element)

Before you convert text or text along a path to curves, keep these facts in mind:
- Any text element that is converted to curves—even if it is only a single character—is a **group**.
  - A number of operations—merging, for one—cannot be done with groups. For that reason, you may still need to **Ungroup** the text after you convert it to curves.
- Once converted to curves, text can no longer be edited and cannot be converted back to a text element.
  - If you have created a complex or lengthy text element or have scaled it very precisely, double-check the text one last time before you convert it to curves. If you have made a text-entry error, you can save yourself from having to re-enter the entire text element.
- Only what is visible on the screen is converted to curves. If the Show Path option is turned off, the path element is lost when text along a path is converted to curves.
Blends

When a blend is converted to curves, it becomes a group containing the original start and end elements and the intermediate steps of the blend as elements.

You can break the group and select any of its component elements.

The intermediate elements take on the color and line attributes of the start element. (Otherwise, all the intermediate color steps would be added to your picture's color palette, creating a potentially very large color file.)
The **Split Element** command takes any of the combined elements—mask, merge, blend, or text along a path—and splits it back into its original components.

You might split combined elements:

- to reposition elements;
- to use another element;
- to change color in the elements;
- to edit text that has been placed along a path.

Before splitting elements, remember the following:

- Do not split a mask, blend, or text along a path if you simply want to change the options you chose when you combined the elements in the first place. To re-display the Mask Elements, Blend Elements, or Text Along a Path dialogs, double-click on the combined element.

- When merged elements are split, they are split into all their components. Keep this fact in mind when splitting merged elements containing text. Letters with fully enclosed counters—like A and O—and dotted letters are actually merged elements. Splitting them breaks them apart entirely—for example, making two circles out of an O.

- After you split a merged element, the separate elements all take on the color and line attributes of the merged element. The colors and line attributes the elements had before they were merged—if different from those of the merged element—are not restored.
This chapter describes the commands in the Options menu. These commands allow you to set many of the characteristics of your Artline work environment.

<table>
<thead>
<tr>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preferences...</td>
</tr>
<tr>
<td>Save Preferences</td>
</tr>
<tr>
<td>Layer Manager...</td>
</tr>
<tr>
<td>Color Manager...</td>
</tr>
<tr>
<td>Font Manager...</td>
</tr>
<tr>
<td>Tools Manager...</td>
</tr>
</tbody>
</table>
Preferences Command

The Preferences command displays the Global Preferences dialog:

![Global Preferences dialog]

Make Backups Of

The last saved version of your picture file, tools file, or color files can be kept as backups. Turn backups off if you want to save disk space.

<table>
<thead>
<tr>
<th>Make Backups Of</th>
<th>Open Files With</th>
</tr>
</thead>
<tbody>
<tr>
<td>Picture Files</td>
<td>Color On</td>
</tr>
<tr>
<td>Tools Files</td>
<td>Color Off</td>
</tr>
<tr>
<td>Color Files</td>
<td>Current Settings</td>
</tr>
</tbody>
</table>

- **Picture Files**
  - When this check box is marked, Artline keeps a backup of your picture file when you choose the **Save** command from the main File menu.

- **Tools Files**
  - When this check box is marked, Artline keeps a backup of the tools file when you choose the **Save** command from the File menu in the Tools Manager.

- **Color Files**
  - When this check box is marked, Artline keeps a backup of your color file when you choose the **Save** command from the File menu in the Color Manager.
Open Files With

This setting determines whether colors are displayed when you open a file.

Colors On

When you open a file, all colors and fountains are displayed. This setting overrides the current setting of the Colors and Fountains commands in the View menu.

Opening a file with Colors On automatically turns the Colors command on (if it isn’t already).

Colors Off

When you open a file, no colors and fountains are displayed. This setting overrides the current setting of the Colors and Fountains commands in the View Menu.

Opening a file with Colors Off automatically turns the Colors command off (if it isn’t already).

Turning colors off can speed up the display of your pictures. Pictures with a lot of colors or fountains or with many blends can take a long time to draw with colors turned on.

NOTE: There is one exception to this general rule. Some masks—depending on their complexity—can actually take longer to draw with colors turned off.

Current Settings

When you open a file, colors and fountains are displayed according to the current settings of the Colors and Fountains commands in the View menu.

Menus

This option determines how you display Artline’s menus, in the main window and in the Layer Manager, Color Manager, and Tools Manager. Artline’s menu functionality is described on page 1-12.
Redraw Speed

This option lets you choose between how precisely and how fast elements are drawn on the screen.

Quality

Elements are drawn as well as the resolution of your screen will allow.

With this setting, complex pictures can take a long time to draw at Full view or any wider view of the drawing surface. See page 2-14 for a description of views.

Auto

Artline uses the Quality redraw at all views except Full view and any wider views, where it uses the Fast redraw. The Auto setting (the default) is intended to give you the best of the other two options—a precise redraw where the screen can display it and a fast redraw where the precise redraw would not show up well.

Fast

Elements are drawn as fast as possible, regardless of the current view. Curves might not appear smooth, but could appear as a series of line segments.

Double-Click

This option determines how fast you must press the mouse button for a double-click. Your selection is entirely a matter of personal preference.
Save Preferences Command

The **Save Preferences** command saves a new set of defaults for your next Artline work session.

Defaults are saved in a file called ARTLINE.INI, which is in the same directory as the Artline program file.

These are the defaults saved by the **Save Preferences** command:

- all choices in the Global Preferences dialog
- all choices in the Page Layout dialog
- current size and position of the window
- most recent directory paths for:
  - opening picture files (.GEM, .EPS)
  - loading image files (.IMG, .PCX, .TIF)
  - PostScript file output
  - loading fonts
  - loading color files
  - loading tools files
- current state of rulers and status line
- current state of grid and grid snap
- current position and state of guide lines
- PostScript output parameters
- image options:
  - foreground and background colors
  - pattern
  - scaling
  - image offsets
- current set of fonts and their attributes—Resident/Download/Vector
- current toolbox configuration

The next time you start Artline, all these defaults will be in effect.
Restoring the Original Defaults

When you first install it, Artline already has a “default set” of defaults.

If you have saved preferences and then want to restore the original set of defaults, you have two options:

- If you do not mind losing the defaults you have saved, delete the file ARTLINE.INI.
- If you do not want to lose the defaults you have saved, rename ARTLINE.INI to something like ARTINI.SAV or ARTLINE.INX.

In either case, Artline will create a new ARTLINE.INI the next time you start the program.

Layer Manager Command

The **Layer Manager** command displays the Layer Manager so you can add or modify layers or set their attributes.

Layers are described fully in Chapter 10.

Color Manager Command

The **Color Manager** command displays the Color Manager so you can add or modify colors and fountains, load or modify color files.

Color management is described fully in Chapter 12.
Font Manager

The **Font Manager** command displays the Font Manager.

![Font Manager Window]

**Typefaces**

This window lists the typefaces that are currently available. The names that appear in this list are the same as those appearing in the pop-up menu in the Create Text Element dialog.

You can select a typeface from the list, either to set attributes or to remove it from the list.

**To select a typeface:**

1. Scroll the window (if necessary) to bring the name into the window.

2. Click on the typeface’s name. Artline highlights the name to indicate that it is selected.
Attributes

In Artline's default setup, your printer receives text characters as patterns of lines and curves. Although you can still edit the text, from the printer's point of view the characters are no different from elements drawn with the Quill or other tools.

Text characters can, however, be very complicated patterns, and pictures that contain a great deal of text can take a long time to print.

If you have a PostScript printer, the Attributes options can increase the speed with which text is printed. Note, however, that the attributes are available only when printing with Artline's PostScript command and not with the Output program.

To set attributes, select a font name from the list and then click on one of the Attributes buttons.

Resident

PostScript printers have a set of resident fonts, for which all the information necessary to draw the characters is already in the printer. These fonts are often identified in a startup sheet that is printed when you first turn on the printer. Artline's names for the PostScript resident fonts are listed in Appendix A.

To increase printing speed, set the attribute of each of the resident fonts to Resident. When you print, Artline tells the printer what characters it wants, and the printer draws them from the resident set.

NOTE: In many PostScript printers the resident Courier font cannot reproduce the fill or style attributes you can set in Artline. Instead, the characters appear as thin lines. Test your printer by sending it the same Courier text, once with the font set to Resident and again with it set to Vector. If the resident Courier does not print correctly, leave Courier set to Vector.
Download

The Download option makes your PostScript printer process non-resident fonts as if they were resident. When PostScript output is started, the font information is sent to the printer (downloaded) with each picture and is kept in the printer’s memory.

The entire font is downloaded—all characters, not just the characters you are using in your picture. For that reason, downloading is most effective for pictures that contain a lot of text in a few non-resident fonts.

In some cases, downloading can increase printing time:

- if the picture contains only a few characters in each non-resident font;
  
  In this case, downloading the fonts could take longer than actually printing the picture.

- if the printer does not have enough memory for both the downloaded fonts and the picture.

Vector

Vector is the default attribute for all fonts. Characters are sent to the printer as lines and curves.

If you have a non-PostScript printer, all text is treated as Vector, regardless of the attributes set in this dialog.

If you have a PostScript printer, leave the attribute for non-resident fonts as Vector if:

- the picture contains only a few text characters;

- the picture contains a lot of text, but it is in several different fonts and only a few characters in each font are used.
Remove Typeface

This button removes the selected font from the typeface list.

The font file (the file with the .AF4 extension) is not deleted from your disk, so you can always restore the name to the list at a later time.

You can remove typefaces if memory or disk space are becoming limited or if you simply want a shorter list of fonts in the Create Text Item dialog.

Add Typeface

This button displays the Item Selector so you can add a font name to the list.

There are two things to remember when adding fonts:

- All fonts must be in the Artline .AF4 format. You cannot add .AFF fonts from GEM Artline (Release 1.0).

- Fonts must all be in your designated font directory. If you try to add a font from another directory, Artline displays an alert asking if you want the font file copied to your fonts directory. Click on OK if you want to add the font to the list.

Tools Manager Command

The Tools Manager command displays the Tools Manager so you can create your own custom toolbox.

The Tools Manager is described fully in Chapter 13.
PICTURES can be created in layers, as if they were made up of transparent sheets laid on top of each other.

Layers make complex pictures manageable and give you an extra measure of protection.

- You control which layers are visible. The entire picture does not always have to be on the screen.
- The work you do in one layer—adding or deleting elements, changing colors, drawing new elements—has no effect on elements in other layers.

The elements in each layer exist in a stack. See the discussion of stacks and layers, “Selecting Overlapping Elements,” in Chapter 2.
Limits on Layers

There is no limit on the number of layers you can create—except for the limitations imposed by your computer's memory and available disk space.

Layer Tool and Layer Manager

The Layer tool (described in Chapter 2) has two functions:
- activating layers
- adding new layers

The Layer Manager can also be used to activate or add layers, but it has these additional functions:
- changing layer order
- modifying layers
- removing layers
- deciding which layers will be displayed

Displaying the Layer Manager

To display the Layer Manager:

Choose the **Layer Manager** command from the Options Menu.

The Layer Manager window contains these parts:
To move the Layer Manager:

Drag the Layer Manager's title bar.

Each time you choose the **Layer Manager** command in the current work session, the Layer Manager appears where you last left it. At the beginning of your next Artline work session, the Layer Manager will again appear in its default location, the middle of the workspace.

To remove the Layer Manager from the workspace:

Click on the Layer Manager's close box or choose the **Close** command from the Layer Manager's File menu.

**Layer List**

The layer list identifies the layers in the current picture. The layers are listed in order from bottom to top—the first layer in the list is the bottom layer; the last layer in the list is the top layer.

If your picture has more layers than fit the list, use the arrows, scroll bar, or slider to scroll the list.

**Activating Layers**

To work in a given layer of your picture, you must first make that layer the *active* layer. The active layer is identified in the main title bar above the workspace.

- If you activate a layer with the Layer tool, Artline automatically updates the screen.
- If you activate a layer with the Layer Manager, the screen update depends on the state of the **Auto Redraw** and **Redraw** commands (page 10-20).

To activate a layer with the Layer tool:

1. Click on the Layer tool to display the pop-up list of the names of the layers in the current file.
2. Click on the name of the layer you want to activate.

You can also activate layers with the **PgUp** and **PgDn** keys.
To activate a layer with the Layer Manager:

1. Open the Layer Manager by choosing the **Layer Manager** command from the Options Menu.
2. Click on the layer’s name in the layer list.

You cannot work on your picture while the Layer Manager is open. For that reason, if you simply want to activate a layer, use the Layer tool.

However, if you want to activate a layer *and* do something else related to layers—for example, add a layer and modify an existing layer—use the Layer Manager.

### Adding Layers

When you start a new picture in Artline, there is one layer, called the *default layer*. You can add new layers with the Layer tool or the Layer Manager.

To add a layer with the Layer tool:

1. Click on the Layer tool to display the layer pop-up.
2. Click on the **New Layer** option. Artline displays the Add Layer dialog.

   ![Add Layer Dialog](image)

   *The new layer is automatically the active layer.*

3. Enter a name for the new layer into the dialog.
   
   The other options in the dialog—Background Layer and Link To—are for creating slides. See page 10-8.

4. Exit the Add Layer dialog.
To add a layer with the Layer Manager:

1. Display the Options menu and choose the **Layer Manager** command.

2. Display the Layer Manager’s Edit menu and choose the **Add Layer** command. The Add Layer dialog appears on top of the Layer Window.

3. Enter a name for the new layer into the dialog. The other options in the dialog are for creating slides. See page 10-8.

4. Exit the Add Layer dialog.

5. When you have added all the layers you want, click on the Layer Manager’s close box or choose the **Close** command from the Edit menu.

**NOTE:** Merging a file into your picture also adds at least one new layer. See the description of the **Merge File** command (page 3-4).

### Changing Layer Order

Using the Layer Manager, you can change the order of the layers on the drawing surface.

To change layer order:

1. Open the Layer Manager.

2. In the layer list, drag the layer’s name to the position you want.

3. Close the Layer Manager.
Copying and Moving Elements Between Layers

Elements can be copied or moved from one layer to other layers.

To *copy* elements from one layer to another:

1. Use the Layer tool to activate the layer containing the elements you want to copy.
2. Select the elements.
3. Display the Edit menu and choose the **Copy** command.
4. Use the Layer tool to activate the layer to which you want to copy the elements.
5. Display the Edit menu and choose the **Paste** command.

To *move* elements from one layer to another:

1. Use the Layer tool to activate the layer containing the elements you want to move.
2. Select the elements.
3. Display the Edit menu and choose the **Cut** command.
4. Use the Layer tool to activate the layer on which you want to place the elements.
5. Display the Edit menu and choose the **Paste** command.

You can use these steps to copy or move single elements, multiply selected or grouped elements, or even the entire contents of a layer.

Combining Elements into a Single Layer

You may find that you want to convert a multi-layer picture to a single-layer picture—in other words, to combine all the elements from all the layers into a single layer. You can do it, using the **Merge File** command from the File menu.
To combine elements into a single layer:

1. Save your picture. (This is a good practice to observe before any such changes.)

2. Display the File menu and choose the **New** command to clear the drawing surface.

3. Display the File menu and choose the **Merge File** command. Artline displays the Item Selector.

4. Select the file you want to combine to a single layer.

5. Artline displays this alert:

   ![Merging multiple-layer file. Merge to separate layers in the current file or combine to a single layer?](image)

6. Click on the **Combine** button.
   The file is merged into a single layer in the current picture.

7. Save the new picture.

8. The new picture has two layers, a default layer with nothing in it, and the new layer containing the picture you just merged. The new layer’s name is the name of the file you merged.

   If you want the new picture to have only one layer, use the Layer Manager to remove the default layer. See page 10-14.
Slides

Slides are pairs of layers—a foreground and a background—that are displayed together. You can combine many slides to create an entire slide presentation in a single file.

You can display slides on the screen with the Layer Manager’s Slides command (page 10-19), export slides to files (page 3-7), or produce PostScript output of your slides (page 3-13).

Creating Slides

A slide is created when one layer is designated a background layer and another layer—the foreground layer—is linked to it. You can create slides when you add new layers or with existing layers.

To designate a layer as a background layer:

☐ If you are adding the layer, click on the Background Layer check box in the Add Layer dialog.

☐ If the layer already exists:
  — 1 Open the Layer Manager.
  — 2 Select the layer’s name in the layer list.
  — 3 Display the Edit menu and choose the Modify Layer command.
  — 4 In the Modify Layer dialog, click on the Background Layer check box.
To link a layer to a background:

- If you are adding the layer, display the Link To menu in the Add Layer dialog. Choose the name of the layer you want as the background of the new layer.

![Add Layer Dialog]

- If the layer already exists:
  - 1 Open the Layer Manager.
  - 2 Select the layer’s name in the layer list.
  - 3 Display the Edit menu and choose the **Modify Layer** command.
  - 4 In the Modify Layer dialog, display the Link To menu. Choose the name of the layer you want as the background of this layer.

**NOTE:** You can link more than one layer to a single background. A typical background layer contains all elements that are found in every slide, and the foreground layers contain the elements that are unique to each individual slide. See the example on the next page.
This background... ...and these two foregrounds...

...combine as slides to create these two magazine covers.

This magazine is entirely fictitious and any resemblance to a real publication is unintentional.
Printing Slides

To print slides, you have these options:

- If you have a PostScript printer, you can print the slides directly to it. Choose the **PostScript** command (page 3-13) and set the Separation Options to “Slides.”

- If you do not have a PostScript printer, you can export the slides to files that can be printed. Choose the **Export** command (page 3-7) and set the Export Mode to “Slides.” Then choose either of these File Type options:
  - Multiple .GEM Files
    This option creates a separate file for each slide. You can print these files, and you can open them in Artline or include them in files created with programs that use .GEM files, like Presentation Team and Xerox Ventura Publisher.

    When exporting to multiple .GEM files, the filename you specify cannot be more than five characters long. Artline uses the remaining three characters for automatic numbering of the files—for example, SLIDE000.GEM, SLIDE001.GEM, and SLIDE002.GEM.

  - Multiple-Page .GMP File
    This option creates a single file with a separate page for each slide. Using the Output program, you can print your slides from this file. You cannot open a .GMP file in Artline or use it with other programs.

---

**CAUTION:** The disk space occupied by multiple .GEM files is usually more than the space occupied by a single .GMP file.
Slide Shows on the Screen

Using Artline, you can create “slide shows” for display on the screen. These can be especially effective on some of the large-screen high-resolution monitors available today.

To create a slide show:

1. Create the slides in Artline.
2. Export the slides to a .GMP file or to .GEM files.
   In most instances, it is easiest to export the slides to a .GMP file. You need only a single file in your output list, and the Screen Preferences apply to the pages of the .GMP file just as they do to the separate .GEM files.
3. Start the Output program (To Output command).
4. In Output, add the .GMP file or .GEM files to the output list, set your Screen Preferences, and start output to the screen.

If you are creating slides exclusively for screen output, make sure they conform to the screen's orientation (Portrait or Landscape). For most standard monitors, use Landscape orientation; for vertically oriented full-page monitors, use Portrait orientation.
Layer Manager Command Reference

The next two sections describe the commands in the Layer Manager's two menus.

Note that the Layer Manager menus list keyboard command equivalents. When the Layer Manager is open, these keyboard commands are activated, and the keyboard commands in Artline's main menus are inactive.

Edit Menu

This section describes the commands in the Layer Manager's Edit menu. Note the keyboard command equivalents for the first three commands.

Add Layer Command

The **Add Layer** command displays the Add Layer dialog. Use the dialog to add a new layer to your picture.

**Layer Name**

Each layer must have a name. Enter a name in this field or accept the name supplied.

**Background Layer**

Click on this check box if you want the new layer to be a background layer for slides. Slides are described on page 10-8.
Link To

This option makes the layer a slide foreground. Select a name from this pop-up menu to link the new layer to an existing background layer. You cannot link a foreground until you have created at least one background layer.

Modify Layer Command

You can also display the Modify Layer dialog by double-clicking on the layer’s name in the list.

The Modify Layer command displays the Modify Layer dialog so you can change the name of the current (active) layer or change its slide attributes. The Modify Layer dialog is identical to the Add Layer dialog.

You can use the Modify Layer command to give your layers unique names when you merge a file into your picture, resulting in layers with duplicate names. See the description of the Merge File command (page 3-4).

Remove Layer Command

The Remove Layer command removes the current layer from your picture. If the layer contains elements, Artline displays an alert warning you that the elements will also be deleted from the picture.

Removed layers are not placed in your computer’s memory or on the Clipboard. For that reason, once a layer is removed, it cannot be restored except by being reconstructed from scratch.

Close Command

The Close command closes the Layer Manager. You can also close the Layer Manager by clicking on the close box at the left end of the title bar.
Display Menu

This section describes the commands in the Layer Manager’s Display menu.

<table>
<thead>
<tr>
<th>Display</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>+C</td>
</tr>
<tr>
<td>Visible</td>
<td>+V</td>
</tr>
<tr>
<td>All</td>
<td>+L</td>
</tr>
<tr>
<td>Slides</td>
<td>+S</td>
</tr>
</tbody>
</table>

The menu’s first four commands give you control over how layers are displayed on the screen; your current choice is indicated with a marker. These display choices remain in effect after you have closed the Layer Manager. (The screen display commands have no effect on printed output other than PostScript EPSF. Printing of layers is controlled by the Export and PostScript commands described in Chapter 3.)

The menu’s last two commands control the redraw of layers while the Layer Manager is open.

Display Status

The current display status of the Layer Manager (Active, Visible, All, or Slides) is saved with the file. For example, a file that is saved in Slides mode will automatically be in Slides mode the next time you open it.
Display Markers: Circles and Light Bulbs

To the left of each layer name is a display marker, either a circle or a "light bulb." These markers indicate whether the layer will be displayed in the current display mode.

- The light bulb marker indicates that the layer will be displayed. The active layer is marked with a light bulb in all display modes.
- The empty circle indicates that the layer will not be displayed.

If Auto Redraw in the Layer Manager is turned off, changes in the display status of layers will not be reflected until you choose the Redraw command or until you close the Layer Manager. Auto Redraw is described on page 10-20.

All Command

The All command displays all the layers in the picture.

Active Command

The Active command displays only the active layer. Regardless of the number of layers in your picture, you see only one layer at a time.
Visible Command

The **Visible** command switches the Layer Manager into a special mode in which the only layers that are displayed are the active layer and any other layers that are specifically designated as *Visible*. This option makes it possible for you to:

- display a selection of the layers in your picture;
- view the layers in your picture as a series of overlays;
- print a selection of layers, using the Visible option in the **Export** command.

To set a layer’s visibility:

1. Open the Layer Manager.
2. (Optional) For greater convenience, turn off **Auto Redraw** in the Display menu, if it is on. The **Auto Redraw** command is described on page 10-20.
3. Choose the **Visible** command from the Display menu and look at the display markers next to each layer name.
4. Click on the display marker for each layer whose visibility status you want to change.
5. To set the visibility status of the current active layer, you must first de-activate it by clicking on one of the other names in the layer list. This gives you a clear view of the display marker.

You can only set or change the visibility of layers in Visible mode.
Displaying Selected Layers

You can use the Visible setting to display a selection of the layers in your picture. This can be useful when you want to see how various layers look in combination with each other.

To display selected layers:

1. Open the Layer Manager.
2. Switch the Layer Manager to **Visible** mode.
3. Turn on the display markers for the layers you want visible. Turn off the display markers for any layers you do not want visible.

By moving the Layer Manager to one side of the screen, you can continue to view layers without closing the Layer Manager each time you change a layer’s display status.

Using Layers as Overlays

Using the **Visible** command, you can “build up” your picture layer by layer, as if you were putting down a series of overlays. You can start by looking at the bottom layer, then add a layer, another layer, and so on.

To view layers as overlays:

1. Open the Layer Manager.
2. Turn on Auto Redraw (if it is not already on).
3. This process can only be done while the Layer Manager is open, so move it off to one side of the screen so that it blocks your view of the workspace as little as possible. Make sure the layer list is still accessible.
4. Choose **Visible** from the Display menu.
5. Activate the bottom layer (the first name in the list). The bottom layer will remain the active layer throughout all these steps.
6 Start by making sure that the display markers are turned off for other layers. At first you should see only the bottom layer.

7 Make the second layer Visible by clicking on its display marker. You now see the first two layers.

8 Make the third layer Visible. You now see the first three layers together.

9 Continue making layers Visible, one by one, until you see the complete picture.

Slides Command

The **Slides** command displays *slides* (page 10-8). When the **Slides** option is marked, activating layers (either with the Layer tool or from within the Layer Manager) has this effect:

- If the layer you activate is the foreground of a slide, the entire slide—foreground and background—is displayed.

- If the layer you activate is not the foreground of a slide, the layer is displayed by itself. In this case, the **Slides** command has the same effect as the **Active** command.
Auto Redraw Command

The Auto Redraw command is a toggle. Auto Redraw is either on (as indicated by a marker in the menu) or off.

Auto Redraw determines whether Artline redraws (updates) the screen when you make changes in the Layer Manager.

- When Auto Redraw is on, Artline redraws the screen every time you do something that changes what is displayed on the screen—like activating a layer or changing layer order.

- When Auto Redraw is off, the screen is redrawn only when you choose the Redraw command. Turning off Auto Redraw is useful when you are doing something that involves several steps, and you do not want the screen to redraw after each step.

The state of Auto Redraw has no effect when the Layer Manager is closed; the screen is always redrawn when changes warrant it.

Redraw Command

The Redraw command redraws the screen when Auto Redraw is turned off.

The Redraw command is only available when Auto Redraw is turned off and only when you have done something that would change the way layers are displayed on the screen.
Image Tracing

TRACING is a technique in which you use the Trace tool or Quill (or other tools) to create Artline pictures from bit-image files, typically created by scanning programs and paint programs.

Image Files and Vector Files

Image files are made up of individual dots called pixels. Some image files can be very detailed—scanned images of photographs, for example—but these image files can be extremely large, requiring a lot of memory to load and a lot of disk space to store.

Artline's files are called vector (or "object") files. Elements are stored as complete objects, rather than as a pattern of dots. An element drawn in Artline can be moved or rotated, can have its size or color changed, and other elements in the picture are not affected.

Tracing creates a vector "replica" of the bit-image original, making available all of Artline's editing capabilities and enabling you to take advantage of the full resolution of your output device.
Autotracing and Hand Tracing

There are two ways you can trace an image:
- interactive autotracing
- hand tracing

Interactive Autotracing

Using the Trace tool, you can make Artline trace an image, setting anchor points and drawing curves and lines automatically. Autotracing is interactive because you can stop the autotrace at any time and then:
- change the tracing precision;
- retrace the entire image;
- use different tracing precisions for different parts of the same tracing line.

Hand Tracing

You can trace an image by hand, using the Quill, Sketch tool, or other drawing tools to draw all the lines and curves. When tracing with the Quill, you choose where to place anchor points and where to drag tangent lines.

Loading Images

The image does not become part of your Artline file. It is simply there as a guide for tracing.

Before you can trace an image, you must load it, to make it visible on the screen. The image is “under” the drawing surface, as if you had placed a picture under a piece of tracing paper.

Images can be loaded for tracing in any of three formats:
- IMG (file extension .IMG)
- PCX (file extension .PCX)
- TIFF (file extension .TIF)

Images in other formats can be converted to IMG, PCX, or TIFF with several conversion utilities.
To load an image:

Choose the **Load Image** command from the Image menu. Artline displays the Item Selector so you can select the image file.

Selecting files with the Item Selector is described in Chapter 1.

**Image Frame**

When an image is loaded into Artline, it is contained within an invisible rectangle called the *image frame*. (To see the extent of the image frame, set the image background to a color other than white. See page 11-5.)
Image Options

After loading an image, you can set these image options:

- image color and fill pattern
- background color
- image scaling
- position of the image on the drawing surface

To set image options:

Choose the Image Options command from the Image menu. Artline displays the Image Options dialog.

Color & Patterns

These options set the color and pattern of the image and the color of the image background.

Image

This menu contains a list of colors that can be assigned to the image. The initial default color is black.

The set of colors that appears in the menu is always the same; it is independent of the currently loaded color file.
Pattern

This menu contains a list of patterns that can be assigned to the image. The initial default is a solid pattern.

The patterns are for your convenience, as it is sometimes hard to see the line as it traces around a solid pattern. The patterns do not affect tracing precision in any way.

Background

The background is the part of the area contained within the image frame that has no image pixels. In the illustration on page 11-3, the background is the shaded area.

The Background menu contains the same colors as the Image menu. The initial default is a white background.

Scaling

To make the image the most convenient size for tracing, you can scale it larger or smaller.

Uniform

In Uniform scaling, a single percentage (ranging from 1% to 999%) is applied to the image’s width and height. The image cannot be distorted.

Non-Uniform

In Non-Uniform scaling, two fields are available: Horizontal and Vertical. The image’s width (Horizontal) and height (Vertical) can be scaled separately, and the image can be distorted.
Image Options

Offsets

By default, an image appears at the upper left corner of the drawing surface. Using the Offsets fields, you can move the image to a specific location on the drawing surface. The unit of measure in both fields is taken from the current setting in the Page Layout dialog (page 3-10).

Horizontal

This setting moves the image the specified distance from the left edge of the drawing surface.

Vertical

This setting moves the image the specified distance down from the top edge of the drawing surface.

Saving Image Options

The current settings in the Image Options dialog are saved as defaults when you choose the Save Preferences command. See page 9-5.

If you do not want to save the options as defaults, but still want the information available the next time you open the file, use the Text tool to enter the options in an open part of the drawing surface. (Text with hollow fill draws most quickly.) Save this text with the picture, use the values for reference each time you load the image, and delete the text when you no longer need the information.
Autotracing

Autotracing is a fast and easy way of creating Artline elements from scanned images or other image files.

Typical steps for autotracing an image are:

1. Load the image. (See page 11-2.)
2. Set image options. (See page 11-4.)
3. Set the Tracing Options.
4. Select the Trace tool and begin tracing.
5. If necessary, use the Plane tool to fine-tune the final picture.

Tracing Options

Before you begin autotracing, set the options that determine how Artline will trace the image:

- image type
- gray levels (grayscale images only)
- gap size
- timing
- precision
- contrast

To set tracing options, double-click on the Trace tool. Artline displays the Tracing Options dialog:
Image

This setting describes the kind of image you are tracing.

Grayscale

The image consists of areas of even shades of gray.

When you select Grayscale, two additional options—Gray Levels and Contrast—become available. See “Tracing Grayscale Images” on page 11-14.

Line Art

The image contains only solid areas of black and white.

Gray Levels

This menu is available only when Grayscale has been selected for the Image Type. See “Tracing Grayscale Images” on page 11-14.

Gap Size

The gap size determines how closely autotrace follows any little “pits” and gaps in the outline of the image. The settings range from zero pixels to three pixels.

A gap size of zero causes autotrace to follow the outline closely (see the tracing on the left below). Increasing the gap size produces a smoother outline by causing autotrace to jump over irregularities in the scanned image. The tracing on the right was made at a gap size of three pixels.

When your image contains blocks of pixels that are close to each other, a small gap size can prevent the trace line from jumping from one block of pixels to the other.
Timing

An autotrace is a series of connected lines or curve segments. The Timing setting (measured in milliseconds) determines how long autotrace waits before starting the next curve segment.

In its default timing (0 ms), autotrace is continuous. Increasing the timing increases the amount of time required to trace the image, but it also allows you to stop the autotrace precisely where you want to stop it.

Precision

This percentage determines how closely autotrace follows the outline of the image. A Precision of 50% or 60% is often sufficient.

A lower percentage results in smoother curves with fewer anchor points. The tracing follows the general outline of the image.

A higher percentage produces a more exact tracing of the image, but also results in more anchor points. High Precision tracing (especially with the Gap Size set to zero) often follows all the irregularities of the edges of scanned images, producing an outline that is needlessly "fussy."

Contrast

This option is available only when Grayscale has been selected for the Image Type.

See “Gray Levels” (page 11-15).

Autotrace Direction

The line drawn by the Trace tool always leaves the image to its right.

☐ If you are tracing the outside of the image, the line moves clockwise.

☐ If you are tracing inside an image, the tracing line moves counterclockwise.
Autotracing Techniques

This section describes how you trace entirely around the outside or inside of an image. The next section describes how you trace a specified part of an image.

To autotrace, set tracing options and then:

1. Select the Trace tool in the toolbox.
2. Start the autotrace by clicking next to the image.
   If you click too far from the image, Artline displays the "Cannot find tracing image" alert.

   ![Cannot find tracing image. Click closer to the outline of the image or change the Grayscale tracing values.]

   If you click outside the image frame, Artline displays this alert:

   ![Cannot find tracing image. Click inside the image frame, close to the outline of the image you want to trace.]

3. When the image is traced, Artline displays the Preview Curve dialog. (See page 11-12.)
   If the autotrace reaches the point limit before finishing the tracing, Artline displays the alert shown below and then the Preview Curve dialog.

   ![The outline of this image is too long or too complex to trace in a single step. Try tracing the image in segments or at a lower precision.]
Trace Segments

A trace segment is a partial tracing of the image, where you set both the starting and finishing points.

To set a trace segment:

1. Select the Trace tool.
2. Drag a line from the trace segment’s starting point to its end point. Place the end point next to the image.

---

- If you place the end point inside the image frame (page 11-3) but not next to the image, the image will be traced completely or until the point limit is reached.
- If you place the end point outside the image frame, this alert is displayed:

  **Cannot trace segment.**
  The selected end point lies outside the image frame. Drag a new tracing segment line and place the end point next to the image.

---

3. When the segment is finished, the Preview Curve dialog is displayed. (See page 11-12.)
Stopping Autotrace

You can stop the Trace tool at any time by pressing the spacebar. Artline then displays the Preview Curve dialog. (See page 11-12.)

Preview Curve Dialog

Artline displays the Preview Curve dialog when:

- the image is fully traced;
- the point limit is reached;
- you stop the tracing.

The dialog has three exit buttons. The second and third are always OK and Cancel. The first varies according to the circumstances in which the dialog was displayed.

- If the dialog was displayed because the image has been completely traced or because the point limit was reached, the first exit button says “Retrace.”
  
  If you click on the Retrace button, the image is retraced from the beginning.

- If the dialog was displayed because you stopped the autotrace by pressing the spacebar, the first exit button says “Go On.”
  
  If you click on the Go On button, the tracing continues from the point at which it left off.

The Preview Curve dialog gives you these options:

- You can accept the tracing.
- You can change precision and retrace.
- You can trace part of the image at a different precision.
- You can delete tracing points and then continue.
- You can cancel the tracing.
Accepting the Tracing
If the tracing is satisfactory as it is, click on OK or press \( \text{J} \).

Changing Precision and Retracing
To change the tracing precision, click on the dialog’s arrow buttons: left-arrow to lower the precision or right-arrow to raise the precision.

If you hold the mouse button down over the arrow, the setting changes continuously until it reaches zero or 100%.

Click on the Retrace button to retrace the image.

If the Preview Curve dialog was displayed because the tracing reached the point limit, you can use the Preview Curve dialog to lower the precision and then retrace.

Tracing Part of the Image at a Different Precision
By stopping the tracing before it is finished, you can trace a continuous line at varying levels of precision. For example, you might start tracing at 80%, change to 40% for a region where you want to follow only the general outline of the image, and then conclude at 100%.

To stop the tracing and display the Preview Curve dialog, press the spacebar.

To change the precision, click on the left-arrow or right-arrow buttons as described above.

To continue the tracing, click on the Preview Curve dialog’s Go On button.

Deleting Tracing Points
When you stop a tracing or when the tracing is complete, you can delete anchor points by pressing the Backspace key or the left-arrow key on the numeric keypad, “stepping” the tracing backwards point by point.

Pressing the right-arrow or the Tab key advances the tracing one anchor point at a time.
Canceling the Tracing

To abandon a tracing, click on the Preview Curve dialog’s Cancel button. The current trace line is deleted in its entirety, but the Trace tool remains selected.

Line Widths—a Hint

Before you start tracing, you might want to set the default line width to No Outline, especially if:

- you want a solid color with no contrasting outline;
- the thickness of the outline might distort or obscure the shape of the traced element.

Tracing Grayscale Images

Grayscale images use dithering, patterns of white and black pixels, to create shades of gray. The Grayscale option in the Tracing Options dialog makes it possible for you to trace images composed of shades of gray.

Because autotracing recognizes only black and white, it must have some way of determining which of the grays to treat as black and which to treat as white—in other words, where the black-white “threshold” is.

When you click on the Grayscale radio button, two additional options become available:

- Gray Levels
- Contrast
Gray Levels

The Gray Levels menu lists a choice of 1, 4, 16, and 64 gray levels. If you know how your image was dithered or how many gray levels were used in creating a TIFF file, choose that value from the menu.

Contrast

The Contrast setting determines which gray values are treated as black and which are treated as white—in other words, where the tracing line will be.

In general, the lower the contrast setting, the lighter the gray value that will be traced.

In the illustration at the left, the outer circle—the lightest gray value—is traced at the lowest contrast setting.

Tips on Tracing Grayscale Images

If you do not know how your image was dithered or how many gray levels there are in your TIFF file, experiment with combinations of Gray Levels and Contrast settings until you get the tracing you want.

If the combination of settings is such that the grayscale area is seen by autotrace as white, this alert is displayed:

Cannot find tracing image. Click closer to the outline of the image or change the Grayscale tracing values.

Adjust the Gray Levels or Contrast (or both) and try again.

You may find that you have traced a single pixel. In that case, adjust the Gray Levels or Contrast (or both) and try again.
Finally, unless the grayscale image you are tracing is very complex, consider the possibility of tracing it by hand, as described next. Hand tracing gives you complete control over the traced outline, and it avoids any need to set Gray Levels or Contrast.

Hand Tracing

Before tracing an image, load the image and set image options.

Hand tracing gives you the greatest control over the appearance of the tracing, but it can be time-consuming, because you must draw each curve yourself.

In most cases, the Quill is the appropriate tool for tracing. You can use other drawing tools—for example, the Sketch tool, Rectangle tool, Circle tool, or Text tool—for parts of the image that are not suited to the Quill.

To hand trace an image:

1. Turn off the snap by displaying the View menu and choosing the Snap to Grid command. It is almost always easier to trace an image with the snap turned off.
2. Use the Magnifier to zoom in on the part of the image where you want to start tracing.
3. Select a tool from the toolbox.
Tips for Hand Tracing

When tracing an image by hand, keep these tips in mind:

- Use as few anchor points as possible. For example, use compound curves wherever you can. (This skill will come with practice.)

  Fewer anchor points mean that you are less likely to encounter the 255-point limit and also that the element will be easier to touch up when you're finished.

- As a rule, it is easier to trace with the fill color turned off (Colors command or the F10 keystroke).

- From time to time, check your tracing by hiding the image. Choose the Image command from the View menu or press F9. To re-display the image, choose the Image command or press F9 again.

- Be as accurate as you can, but remember that you can always go back and "fine tune" the curves afterwards.
THIS chapter describes how you work with Artline’s Color Manager. Using the Color Manager, you can:

- load a color file, including PANTONE colors;
- create or modify solid colors;
- create or modify fountains;
- add colors to a color file;
- create a new color file.

To display the Color Manager:

Choose the **Color Manager** command from the Options Menu.
Colors and Fountains

Artline's colors are available in two forms, as solid colors and as fountains.

Colors

Solid colors can be assigned to an element's interior or its outline. The colors currently available for use in your pictures are listed in:

- Fill Color tool
- Line Color tool
- Color Manager (in Colors mode)

Fountains

A fountain is a blending of one color into another. Fountains can only be assigned to an element's interior. The fountains currently available for use in your pictures are listed in:

- Fountain tool
- Color Manager (in Fills mode)

**NOTE:** A fountain is not the same thing as a blend (described in Chapter 8). A blend combines the colors and the shapes of two elements over a specified number of steps. A fountain is a color blend that can be assigned to a single element or many elements.
Colors and Fountain Availability

Colors and fountains that appear in the color tools and in the Color Manager can be there for any of three reasons:

- They are color file colors and fountains—they are part of the currently loaded color file.
- They are picture colors (or fountains)—they are used in the picture on the drawing surface but are not part of the color file.
- They are unaffiliated colors or fountains—you have created them but have not yet used them or saved them into a color file.

Color Files

Color files contain combinations of solid colors and fountains that you can load and use repeatedly. Several color files are provided with Artline, and you can create your own according to your needs.

When you load a color file, its solid colors are displayed in the Fill Color and Line Color tool palettes, and its fountains appear in the Fountain tool palette.

The name of the current color file appears in the Color Manager’s title bar.

The smallest possible color file is one that contains only black and white, but you can create color files with dozens of colors. The major limiting factors are disk space and the amount of time it takes to load a very large color file.

Colors and fountains that are part of the current color file are indicated in the Color Manager by a marker. (See the illustration on the next page.)
Picture Colors and Fountains

When you open a picture, any colors or fountains in the picture that are not in the current color file are automatically added to the colors that appear in the color tools and Color Manager.

Picture colors do not become a part of the color file unless you explicitly save them to the file. Adding colors to a color file is described on page 12-11. Adding fountains to a color file is described on page 12-19.

Unaffiliated Colors and Fountains

A color or fountain is "unaffiliated" when you have created it, but have not used it in the current picture or saved it to the current color file.

Presumably you intend to use or save the colors you create. If you do not, they will be lost when you:

- load another color file;
- open another picture;
- quit Artline.

Markers: Picture Colors and Unaffiliated Colors

Picture colors and unaffiliated colors are identified in the Color Manager by the absence of a marker between the color bar and the color name. You cannot tell whether a color is part of the color file by looking in the color tools (Fill Color, Fountain, or Line Color).
Color Models

A color model is a description of how the colors of the spectrum are created. In Artline you can create colors in any of three color models:

- CMY—Cyan/Magenta/Yellow
- RGB—Red/Green/Blue
- HSB—Hue/Saturation/Brightness

NOTE: The color models are not mutually exclusive. Color files (page 12-3) are all saved in the same format, so you can create colors using whichever model works best for you. There are no colors you can create with one model that you cannot create with the others.

For a comparison of the three color models, see the table on page 12-8.

CMY Color Model

The CMY model corresponds to the standard color model used for four-color printing, CMYK (the K stands for black). The CMY colors are also known as process colors.

In this model, colors are created by combining percentages of three colors: cyan, magenta, and yellow.

Zero percent of all three colors is white; 100% of all three colors is black.

Shades of gray are created by combining equal percentages of all three colors. The higher the percentage, the darker the gray.

See “Converting CMYK Colors to CMY” (page 12-8).
RGB Color Model

Most color computer monitors create colors by combining RGB values.

The RGB model creates colors by combining percentages of three colors: red, green, and blue.

Zero percent of all three colors is black; 100% of all three colors is white.

Shades of gray are created by combining equal percentages of all three colors. The higher the percentage, the lighter the gray.

HSB Color Model

In the HSB color model, the actual color is determined by the value in the Hue field, while the other two fields determine the relative lightness or darkness of the color.

Hue

This field determines the color.

The color percentages are arranged in a circle, starting and ending with red. Thus, 0% Hue is red, and 100% Hue is also red. In between, green is 33.3% Hue, and blue is 66.6% Hue. For a more detailed accounting of the Hue percentages, see the Color Model Comparison Table on page 12-8.

To see the effect of the Hue field, select the field, type 0 (zero) to set it to red, and then press the plus key on the numeric keypad. Each time you press the plus key, the percentage increases by 5%, and the color changes accordingly.

NOTE: These color percentages are based on Brightness and Saturation values of 100%. At less than 100% Brightness and Saturation, the colors are no longer “pure.”
Brightness

The Brightness value determines how much black is mixed with the color set by the current Hue percentage. At 100% Brightness, the color contains no black. At 0% Brightness, the color is pure black. Changes to the Saturation and Hue values have no effect.

Saturation

The Saturation value determines how much white is mixed with the color set by the current Hue percentage. At 100% Saturation, the color contains no white. At 0% Saturation, the color is pure white. Changes to the Hue values have no effect. Note, however, that changes to the Brightness percentage override the Saturation value. See the next section.

Gray Levels in the HSB Model

In the HSB color model, grays are created when the Saturation is 0% and the Brightness value is varied. (When the Saturation is 0%, changes to the Hue percentage have no effect.)

The higher the Brightness percentage, the lighter the shade of gray. A Brightness of 100% is pure white, and a Brightness of 0% is solid black.
Comparison of Color Models

The following table compares how the three color models produce the same colors.

<table>
<thead>
<tr>
<th>Color Model Comparison Table</th>
</tr>
</thead>
<tbody>
<tr>
<td>C</td>
</tr>
<tr>
<td>-----</td>
</tr>
<tr>
<td>white</td>
</tr>
<tr>
<td>black</td>
</tr>
<tr>
<td>red</td>
</tr>
<tr>
<td>yellow</td>
</tr>
<tr>
<td>green</td>
</tr>
<tr>
<td>cyan</td>
</tr>
<tr>
<td>blue</td>
</tr>
<tr>
<td>magenta</td>
</tr>
</tbody>
</table>

x = This setting has no effect.

Converting CMYK Colors to CMY

If you have a CMYK color you want to duplicate in Artline, you can convert it to the CMY model by adding the black value to each of the other colors. If this would produce a percentage greater than 100%, leave it at 100%.

<table>
<thead>
<tr>
<th>CMYK</th>
<th>CMY</th>
</tr>
</thead>
<tbody>
<tr>
<td>cyan</td>
<td>20</td>
</tr>
<tr>
<td>magenta</td>
<td>85</td>
</tr>
<tr>
<td>yellow</td>
<td>20</td>
</tr>
<tr>
<td>black</td>
<td>20</td>
</tr>
</tbody>
</table>
Creating and Modifying Colors

This section describes how you create new colors, modify existing colors, and add colors to color files.

Creating Colors

You can create a new color by choosing:

- the **New Color** option in either color tool;
- the **Add Color** command from the Color Manager’s Edit menu.

The **Add Color** command is available only when the Color Manager is in Colors mode (as opposed to Fills mode). The Color Manager is in Colors mode when the **Colors** command in the View menu is marked.

In either case, Artline displays the Add Color dialog.
Creating and Modifying Colors

To create a new color:

1. Enter a name directly into the Color Name field, or accept the name supplied by Artline.
2. Choose a color model.
   Color models are described on page 12-5.
3. Adjust the three percentage fields to create the color.

When you exit the Add Color dialog, the new color appears in the color tool palettes and in the color list in the Color Manager.

At this point, the new color is unaffiliated. You can make it a picture color by using it in the current picture, or you can add it to the current color file. Adding colors to a color file is described on page 12-11.

Modifying Colors

You can modify any color in the current color list.

To modify a color:

1. Open the Color Manager.
2. Display the Modify Color dialog by doing either of the following:
   - Double-click on the name of the color you want to modify.
   - Select the color you want to modify by clicking on its name. Then display the Color Manager's Edit menu and choose the Modify command.

Do not click on the color bar or the marker (if present) or you will change the status of the color.

The Modify Color dialog is identical to the Add Color dialog. You can use this dialog to:

- change the color's name;
- change the color model;
- modify the color by changing percent values.
Adding Colors to Color Files

Colors that do not have a marker between the color bar and the color name are not part of the color file.

To add a color to the current color file:

1. Click on the color bar of the color you want to add to the file. A marker will appear next to the color name.
2. When you have marked all the colors you want to add, save the color file by choosing the Save command from the Color Manager's File menu.

CAUTION: If you create a color and do not use it in a picture or save it to a color file, it will be lost when you load another color file, open another picture, or quit Artline.

Removing Colors from Color Files

You can remove a color from the current color file in either of two ways.

- You can delete the color using the Delete command in the Color Manager's Edit menu. A deleted color is no longer available for the current picture and, once you save the color file, is also removed from the color file.
- You can click on the color's color bar. Artline displays the following alert:

  ![Alert](image)

  Colors removed in this manner are still available for the current picture but will no longer be part of the color file if you save the file. (As a precaution against losing a color you actually want, you can use the Save As command to save the color file under a new name.)
Creating and Modifying Fountains

This section describes how you create new fountains, modify existing fountains, and include picture fountains into color files.

NOTE: In some places, notably in the color tools and in the Color Manager, Artline refers to fountains as *fills*.

Creating Fountains

You can create a new fountain by choosing:
- the **New Fill** option in the Fountain tool;
- the **Add Fill** command from the Color Manager’s Edit menu.

The **Add Fill** command is available only when the Color Manager is in Fills mode (as opposed to Colors mode). The Color Manager is in Fills mode when the **Fills** command in the View menu is marked.

In either case, Artline displays the Add Fill dialog.
To create a new fountain:

1. Enter a name directly into the name field, or accept the name supplied by Artline.

2. Choose the fountain’s start and end colors from the two pop-up menus.

3. If you are creating a Linear fountain, set its angle by entering a value directly into the Angle field, dragging the pop-up slider, or dragging the head of the arrow in the preview window. The preview window shows the fountain you are creating.

4. Choose the fountain’s Gradation and Type and, if you are sending your output to a PostScript device, set PostScript Fill Options.

   Gradation, Type, and PostScript Fill Options are described in the next sections.

5. Exit the Add Fill dialog.

The new fountain will now appear in the Fountain Tool palette and in the fountain list in the Color Manager.

At this point, the new fountain is unaffiliated. You can make it a picture fountain by using it in the current picture, or you can add it to the current color file. Adding fountains to a color file is described on page 12-19.
Gradation

The Gradation option determines how the start color blends to the end color.

Even

The transition from start color to end color takes place in even steps over the span of the fountain.

Log

The transition from start color to end color is logarithmic, beginning gradually and then changing rapidly toward the end of the fountain.

Type

Radial

A Radial fountain is circular, and the start color blends inward to the end color. When you choose Radial, the Angle field is unavailable.

Linear

In a Linear fountain, the colors blend as a series of bars of color. The Even and Log fountains above are both linear.
Creating and Modifying Fountains

PostScript Fill Options

PostScript Fill Options give you greater control over how fountains are printed on a PostScript device. You can set separate Fill Options for each fountain you create, and they override the Halftone Screen Options settings in the PostScript Options dialog (see page 3-17).

If, for example, you create a fountain with Fill Options, use it in a picture, and print the picture with default Halftone Screen Options in the PostScript Options dialog, the fountain will print according to the Fill Options, and the rest of the picture will use the device’s default settings.

**Fill Parameters**

**Standard**

The selected fountain has no special Fill Options; it will be printed using the Halftone Screen Options from the PostScript Options dialog.

**Special**

The selected fountain will be printed using the Screen Function, Screen Resolution, and Screen Angle options set in this dialog, regardless of the settings in the PostScript Options dialog.
Screen Function

This menu allows you to choose the PostScript device's default screen function or select a specific screen function.

Default

The selected fountain will be printed using the PostScript device's default Screen Function (usually a form of dot screen).

Line

The selected fountain will be printed with a line screen. Color fountains are created by altering the thickness of parallel lines of the start and end colors. Grayscale fountains are created by altering the thickness of parallel black and white lines.

Round Dot

The selected fountain will be printed with a dot screen. Color fountains are created by altering the size of dots of the start and end colors. Grayscale fountains are created by altering the size of black and white dots.

The illustrations below show a fairly coarse (30 lpi) line screen and dot screen of the same fountain.

<table>
<thead>
<tr>
<th>line screen</th>
<th>dot screen</th>
</tr>
</thead>
</table>

12-16  Artline User Reference Guide
Screen Angle

Screen Angle refers to the physical angle at which screens are printed.

Screen Resolution

This setting controls the sharpness of fountains. Screen Resolution for both dot screens and line screens is measured in lines per inch.

Because the resolution of output devices is fixed—for example, 300 dpi for a typical laser printer and 2540 dpi for a phototypesetter—increasing the screen resolution significantly reduces the number of available gray levels. This equation shows how the two are related:

\[
\text{lpi} = \frac{\text{dpi}}{\sqrt{\text{grays}}}
\]

or, stated another way:

\[
\text{grays} = \left( \frac{\text{dpi}}{\text{lpi}} \right)^2
\]

For example, on a 300 dpi printer, a screen resolution of 50 lpi produces thirty-six gray levels; a screen resolution of 100 lpi produces only nine gray levels. The resolution has doubled, but the number of gray levels is one fourth what it was.
Modifying Fountains

You can modify any fountain listed in the Color Manager.

To modify a fountain:

1. Open the Color Manager.
2. Display the Modify Fill dialog by doing either of the following:
   - Double-click on the name of the fountain you want to modify.
   - Select the fountain you want to modify by clicking on its name. Then display the Color Manager’s Edit menu and choose the Modify command.

Do not click on the color bar or the marker (if present) or you will change the status of the fountain.

The Modify Color dialog is identical to the Add Color dialog. You can use this dialog to:

- change the fountain’s name;
- change the start or end colors;
- change the fountain’s angle;
- change the Gradation or Type;
- change the PostScript Fill Options.
Creating and Modifying Fountains

Adding Fountains to Color Files

Fountains that do not have a marker between the color bar and the name are not part of the color file.

To add a fountain to the current color file:

1. Click on the color bar of the fountain you want to add to the file. A marker will appear next to the name.
2. When you have marked all the fountains you want to add, save the color file by choosing the Save command from the Color Manager’s File menu.

CAUTION: If you create a fountain and do not use it in a picture or save it to a color file, it will be lost when you load another color file, open another picture, or quit Artline.

Removing Fountains from Color Files

You can remove a fountain from the current color file in either of two ways.

☐ You can delete the fountain using the Delete command in the Color Manager’s Edit menu. A deleted fountain is no longer available for the current picture and, once you save the color file, is also removed from the color file.

☐ You can click on the fountain’s color bar. Artline displays the following alert:

![Alert](image)

The selected color will be removed from the current color file. The color will remain in the palette associated with this picture file.

Fountains removed in this manner are still available for the current picture but will no longer be part of the color file if you save the file. (As a precaution against losing a fountain you actually want, you can use the Save As command to save the color file under a new name.)
Creating Color Files

You can use the Color Manager to create entirely new color files of your own.

The following steps are suggested; you can make up your own variations as you gain experience.

To create a new color file:

1. To start with a “clean slate,” save any work you have on the drawing surface and then choose the **New** command from the main File menu.

2. Open the Color Manager.

3. Choose the **Reset** command from the Color Manager’s File menu.

   Artline displays an alert that all colors not used in the current picture will be deleted from the color list. Click on the alert’s OK button or press \.<

   The color list should now show only White and Black.

4. Create the colors and fountains for your new color file. Use the steps described earlier in this chapter under “Creating and Modifying Colors” (page 12-9) and “Creating and Modifying Fountains” (page 12-12).

5. As you create each color and fountain, add it to the eventual color file by clicking on the color bar next to its name. The marker between the color bar and the name indicates that the color is now part of the file.

6. Save the new color file using the **Save As** command in the Color Manager’s File menu.

**NOTE:** If there is anything in the paste buffer, its color (or colors) will still appear in the color list after you choose the **Reset** command. To remove those colors, **Cut** or **Copy** something black or white to the paste buffer, choose the **New** command again, and then **Reset** the Color Manager.
PANTONE Colors

Artline supports PANTONE colors through several files that were copied to your hard disk when you ran Setup.

Pantone, Inc. provides a set of standardized colors that make possible consistent color matching and reproduction. Using PANTONE colors in Artline pictures assures you of predictable results with commercial printers and Pantone-approved computer output devices.

Many corporations use the PANTONE system to specify their corporate colors.

To load a PANTONE color file:

1. Open the Color Manager.
2. Display the File menu and choose the Load command.
3. In the Item Selector, double-click on the name of the PANTONE file you want.

NOTE: Unless you have one of the printers or screens listed in the table on the next page, the colors that appear on the screen or in output to color printers may not match PANTONE-identified solid color standards. Use current PANTONE Color Reference Manuals for accurate color.

To purchase PANTONE Color Reference Manuals or other related materials, write to:

Pantone, Inc.
55 Knickerbocker Road
Moonachie NJ 07074
PANTONE Files

PANTONE files are designed for specific output devices, both screens and printers. Choosing the PANTONE file for the device most like the one you are using assures you of the best possible color reproduction on that device.

The PANTONE files support these devices:

<table>
<thead>
<tr>
<th>color file name</th>
<th>target device</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMYK-150.COL</td>
<td>150-line four-color process separations;</td>
</tr>
<tr>
<td></td>
<td>screen angles: $C = 105^\circ$, $M = 75^\circ$, $Y = 90^\circ$, $K = 45^\circ$</td>
</tr>
<tr>
<td>NEC-CMYK.COL</td>
<td>NEC Colormate PostScript printer;</td>
</tr>
<tr>
<td></td>
<td>$C = 42^\circ$, $M = 85^\circ$, $Y = 36^\circ$, $K = 24^\circ$;</td>
</tr>
<tr>
<td></td>
<td>screen frequency = 50 lpi</td>
</tr>
<tr>
<td>OCE-CMYK.COL</td>
<td>Océ Graphics G5232 Color PostScript Printer;</td>
</tr>
<tr>
<td></td>
<td>$C = 42^\circ$, $M = 85^\circ$, $Y = 36^\circ$, $K = 24^\circ$;</td>
</tr>
<tr>
<td></td>
<td>screen frequency = 50 lpi</td>
</tr>
<tr>
<td>OCECOLOR.COL</td>
<td>OcéColor Printer</td>
</tr>
<tr>
<td>QMS-10.COL</td>
<td>QMS® ColorScript™ 100 Model 10 Printer;</td>
</tr>
<tr>
<td></td>
<td>$C = 42^\circ$, $M = 85^\circ$, $Y = 36^\circ$, $K = 24^\circ$;</td>
</tr>
<tr>
<td></td>
<td>screen frequency = 50 lpi</td>
</tr>
<tr>
<td>QMS-30.COL</td>
<td>QMS ColorScript 100 Model 20/30 Printer;</td>
</tr>
<tr>
<td></td>
<td>$C = 42^\circ$, $M = 85^\circ$, $Y = 36^\circ$, $K = 24^\circ$;</td>
</tr>
<tr>
<td></td>
<td>screen frequency = 50 lpi</td>
</tr>
<tr>
<td>TEK-CQS.COL</td>
<td>Tektronix CQS printer</td>
</tr>
<tr>
<td>TEK-PX.COL</td>
<td>Tektronix Phaser PX printer</td>
</tr>
<tr>
<td>PNTMITSU.COL</td>
<td>monitors with Mitsubishi tubes</td>
</tr>
<tr>
<td>PNTSONY.COL</td>
<td>monitors with Sony tubes</td>
</tr>
</tbody>
</table>

For files that will be printed on a phototypesetter, use the 150-line PANTONE file CMYK-150.COL.
Color Manager Command Reference

The following sections describe the commands in the Color Manager's menus.

Note that the Color Manager menus list keyboard command equivalents. When the Color Manager is open, these keyboard commands are activated, and the keyboard commands in Artline's main menus are inactive.

File Menu

This section describes the commands in the Color Manager's File menu.

Reset Command

The Reset command changes the color list so that it contains only White and Black and any colors or fountains that are used in elements in the current picture or in the paste buffer.

Colors or fountains that are not in use are deleted from the list.

The Reset command can be used as the first step in starting a new color file (see page 12-20) or as a means of eliminating unused colors before saving a new color file.

Load Command

The Load command displays the Item Selector with a list of the available color file names. The color file you choose from the Item Selector replaces the current color file.
Merge Command

The **Merge** command displays the Item Selector with a list of the available color file names. The color file you choose from the Item Selector is merged with the current color file. The resulting color list contains the combined colors and fountains of both files.

If the two files contain colors whose values are identical but whose names are different, the name from the current file is retained; the colors are not duplicated.

Save Command

The **Save** command saves the marked colors and fountains in the color list to the file named in the Color Manager’s title bar.

Colors or fountains that are not marked are not saved to the file, but if they are used in a picture, they become part of the picture and are loaded with the picture.

Save As Command

The **Save As** command displays the Item Selector so you can:

- give a new color file a name and then save it for the first time;
- save an existing color file under a new name.

The second option usually occurs when you want to save a modified color file but still want to keep the original.

Close Command

The **Close** command closes the Color Manager and returns you to the Artline workspace. The colors and fountains in the Color Manager at the time you close it will appear in the color tool palettes.
Edit Menu

This section describes the commands in the Color Manager’s Edit menu.

### Delete Command

The **Delete** command removes a selected color or fountain from the color file. The deletion does not become permanent until you save the color file.

To select a color or fountain, click on its name in the color list. The black highlight bar indicates that the color is selected. Do not click on the marker (if present) or the color bar; that will simply change the color’s status.

### Duplicate Command

When the Color Manager is in Colors mode, the **Duplicate** command displays the Modify Color dialog so you can create a new color from the currently selected color. The Modify Color dialog is identical to the Add Color dialog (page 12-9).

The new color’s percentage values must be unique. If they are not, Artline displays an alert that the color was not added because it already exists in the current file.
When the Color Manager is in Fills mode, the **Duplicate** command displays the Modify Fill dialog so you can create a new fountain from the currently selected fountain. If you define a fountain whose start and end colors are the same as those in another fountain in the current file, Artline displays an alert that the fountain was not added because it already exists.

### Add Color/Fill Command

This command’s name and function depend on your current selection in the View menu.

- If you select **Colors**, the command is **Add Color**, and it displays the Add Color dialog so you can add a new color.
  
  Adding colors is described on page 12-9.

- If you select **Fills**, the command is **Add Fill**, and it displays the Add Fill dialog so you can add a new fountain.
  
  Adding fountains is described on page 12-12.

### Modify Command

The **Modify** command displays the Modify Color dialog or the Modify Fill dialog, depending on the currently selected color or fountain.

Modifying colors is described on page 12-10.

Modifying fountains is described on page 12-18.
View Menu

This section describes the commands in the Color Manager’s View menu.

Colors Command

The **Colors** command switches the Color Manager to its mode in which:

- the colors list shows the solid colors in the current picture file or in use on the drawing surface;
- the commands in the Edit and View menus apply only to solid colors. The **Add Color** command is available only in this mode.

Fills Command

The **Fills** command switches the Color Manager to its mode in which:

- the colors list shows the fountains in the current picture file or in use on the drawing surface;
- the commands in the Edit and View menus apply only to fountains. The **Add Fill** command is available only in this mode.
Sort by Name Command

The Sort by Name command sorts the color list alphabetically by the names of the colors.

Sort by Hue Command

The Sort by Hue command sorts the color list by the Hue values of the individual colors. See the description of the HSB color model (page 12-6).

The colors are sorted in ascending order from the lowest Hue percentage to the highest percentage.

Colors with the same Hue percentage are grouped together and sorted in descending order by their Brightness percentage.

Colors with the same Hue and Brightness values are sorted in ascending order by their Saturation percentage.

Sort by Bright Command

The Sort by Bright command sorts the color list according to the Brightness value in the HSB color model.
THIS chapter describes Artline's Tools Manager. You can use the Tools Manager to create special tools or custom toolboxes.

To display the Tools Manager:

Choose the **Tools Manager** command from the Options menu.

You can move the Tools Manager by dragging its title bar.

On color screens, the blue background of the toolbox becomes a gray background when the Tools Manager is open.
Tools Manager Functions

All tasks described in this chapter can be performed only when the Tools Manager is open. With the Tools Manager, you can:

- create new tools;
- add tools to the toolbox;
- save custom tools files;
- remove tools from the toolbox;
- change the size of the toolbox;
- change the arrangement of the tools in the toolbox;
- change or edit a tool’s icon.

Tools Files

Toolboxes are saved in files with the extension .TLS.

The Artline installation program installs a default tools file called ARTLINE.TLS in the \ARTLINE\TOOLS directory.

Using the Tools Manager, you can create and save your own special tools files. You can save them in the directory of your choice.

Default Toolbox

When you start Artline, the appearance of the toolbox is determined by the file ARTLINE.INI, which “remembers” how the toolbox was last configured and automatically loads that same configuration.

To change the default toolbox:

Load the toolbox you want as the new default just before you quit Artline. A new ARTLINE.INI is written each time you quit Artline, and the toolbox in place at that time automatically becomes the default.
Tools File Backups

The Global Preferences dialog includes an option that allows you to save a backup copy of your tools file (see page 9-2).

When the Make Backups Of check box for tools files is turned on, Artline keeps the last saved version of the tools file as a backup each time you choose the Save command from the File menu in the Tools Manager.

Backup tools files have the extension $LS.

The backup file options in the Global Preferences dialog are described on page 9-2.

Toolbox Design

This section describes:

- changing the size of the toolbox;
- changing the arrangement of the tools.

Toolbox Size

You may need to change the size of the toolbox before rearranging, adding, or removing tools.

You can change the width of the toolbox’s shaded background, making room for more or fewer columns of tools. You cannot change the toolbox’s height or its position at the left side of the workspace. (You can, however, hide the toolbox from view using the Toolbox command. See page 5-10.)

To change the size of the toolbox:

Drag the right side of the toolbox’s background to the left or right. Note that you cannot drag the background under the tools—in other words, you cannot make the toolbox narrower than the tools themselves.
Tool Arrangement

You can arrange the tools in the toolbox by dragging them to the position you want. The Tools Manager automatically "snaps" tools into position to make them easier to align. To turn off the snap, hold down the Ctrl key.

For precise placement of tools, select a tool and press one of the arrow keys on the numeric keypad. The selected tool moves by one-pixel increments each time you press an arrow key.

You can use the Tools Manager as a temporary holding place. For example, you can drag tools to the Tools Manager to make room while you rearrange the toolbox. When you are finished, drag the tools back to the toolbox.

Custom Tools

Using the Tools Manager, you can create custom versions of three kinds of tools:

- standard tools
- menu tools
- container tools

Standard Tools

A standard tool is any of the default Artline set of tools—like the Quill, the Rectangle tool, or the Plane.

Custom Standard Tools—Examples:

- a Rectangle tool that draws only rounded rectangles
- a Line tool that draws lines only at set angles
- a Trace tool with pre-set Tracing Options
Menu Tools

A menu tool is a tool that executes one of Artline’s menu commands, often with information pre-set into a dialog displayed by that command.

Custom Menu Tools—Examples:

- a Page Layout tool with specific options so you can switch rapidly to a particular layout
- an Image Options tool with pre-set options for image and background colors, scaling, and offsets
- a Rotate tool with a pre-set center of rotation and rotation angle and the Make Copy button toggled on

Container Tools

A container tool is a special tool that executes more than one menu command at a time. Containers are like the macros that are available in many word processors and other programs.

Container Tools—Examples:

- a tool combining the Load Image and Image Options commands—the latter with its options pre-set
  
  This container would display the Item Selector so you can select an image to load and then set the image’s colors, pattern, and scale, all in a single step.

- a tool combining the Grid, Guide Lines, and Status Line commands
  
  This container would toggle the grid, guide lines, and status line on or off in a single step.

- a tool combining the Rotate, Move, and Scale commands
  
  This container would rotate, move, and scale an element in a single step. With the Make Copy option turned on for each command, the container could produce many rotated, moved, and scaled elements.
Creating Tools

This section describes the steps for creating standard tools, menu tools, and container tools.

**NOTE:** The maximum number of tools that can be placed in a toolbox is sixty-three.

Standard Tools and Menu Tools

Creating a standard tool or a menu tool typically involves the same sequence of steps in the Tools Manager.

To create a standard tool or menu tool:

1. Choose the **Add** command from the Edit menu to display the Tool Attributes dialog.
   - Specify the tool's name, type (Standard or Menu), and function in the Tool Attributes dialog (see page 13-9).
2. Choose the **Function** command from the Edit menu.
   - Set parameters for the tool or command by filling out the dialog that is displayed. See the description of the tool or command for information on its associated dialog.
   - The Function command is available if the tool you are creating is either of the following:
     - a standard tool for which you can set options, like the Trace tool and the Rectangle tool;
     - a menu command that displays a parameter dialog, like the **Page Layout** and **Image Options** commands.
3. Choose the **Icon** command from the Edit menu if you want to create a custom icon for this tool. The Tools Manager's Icon Editor is described on page 13-12.
Creating Tools

4 Drag the finished tool from the Tools Manager to the toolbox.

5 Save the modified toolbox. If you do not save the file, the modifications to your toolbox could be lost. See page 13-19.
   — To overwrite the currently loaded tools file, choose the **Save** command from the Tools Manager’s File menu.
   — To save the modified toolbox under a new name, choose the **Save As** command from the File menu.

Container Tools

In creating a container tool, you create the container and the menu tools that go into it and then combine them.

To create a container tool:

1 Choose the **Add** command from the Edit menu to display the Tool Attributes dialog.
   Specify the tool’s name and type (Container) in the Tool Attributes dialog (see page 13-9).

2 Create the menu tools that will go into the container. Follow the steps listed previously under “Standard Tools and Menu Tools.”

3 Drag each finished menu tool to the container tool. When the container tool is highlighted, release the mouse button. The menu tool “drops” into the container tool.
When all the tools are inside the container, select the container tool and open it by choosing the **Function** command from the Edit menu. The Tools Manager is now in its “Container” editing mode, in which you can:

- **Duplicate** any menu tools that you want executed more than once;
- set the **Function** of selected menu tools;
- set the order in which the commands are executed.

The commands are executed from left to right, row by row. Drag the tools to place them in the order you want.

To leave “Container” editing mode, choose the **Close** command from the File menu or click on the close box.

If you want to create a custom icon for the new tool, choose the **Icon** command from the Edit menu to display the Tools Manager’s Icon Editor (see page 13-12.)

Drag the finished container tool to the toolbox.

Save the modified toolbox. If you do not save the file, the modifications to your toolbox could be lost. See page 13-19.

To overwrite the currently loaded tools file, choose the **Save** command from the Tools Manager’s File menu.

To save the modified toolbox under a new name, choose the **Save As** command from the Tools Manager’s File menu.
Tool Attributes

When you choose the **Add** command or the **Attributes** command (both are in the Tools Manager’s Edit menu), the Tool Attributes dialog is displayed.

![Tool Attributes](image)

**Icon Selector**

The Tool Attributes dialog has a hidden Icon Selector so you can assign existing icons to your custom tools. (You can also create new icons with the Icon Editor, which is described on page 13-12.) To display the Icon Selector, click on the tool icon in the dialog’s upper left corner.

![Icon Selector](image)

To bring other icons into view in the Icon Selector, use the scroll arrows, scroll bar, or slider.

Using the Icon Editor, you can create your own icons and add them to the Icon Selector, or you can delete icons you do not want.
To choose an icon from the Icon Selector:

Click on the icon you want and then click on the Icon Selector’s OK button. The icon in the Tool Attributes dialog is replaced by the one chosen from the Icon Selector.

For information on using the Icon Selector with the Icon Editor, see page 13-13.

Tool’s Name

Use this field to give the new tool a name. You have two options:

- You can type a name directly into this field.
- You can accept the name supplied automatically when you choose the tool’s function. See the description of the Function button in this dialog.

Type

From this menu, choose the type of tool you are creating:

- Standard Tool (described on page 13-4)
- Menu Tool (described on page 13-5)
- Container Tool (described on page 13-5)

Colors

The first pop-up sets the color for the tool icon’s design (the black pixels in the Icon Editor). The second pop-up sets the color for the tool icon’s background.

Function

This pop-up menu lists the available functions for Standard Tools and Menu Tools.

- If your Type choice is Standard Tool, the menu lists the names of the standard tools for which a tool can be made.
- If your Type choice is Menu Tool, the menu lists the commands for which a tool can be made.
Assign
These buttons are available only if you are creating a Standard Tool. To choose either option, click on the appropriate button.

Default Icon
The default icon for this tool, as determined by its Function, is assigned to the new tool. For example, the default icon for a Selector tool is the small arrow pointing up and to the left.

Default Name
The default name for this tool—the name listed in the Function menu—is assigned to the new tool.
Icon Editor

The Icon Editor is a tool with which you can design your own custom tool icons.

To display the Icon Editor:
Select a tool—either in the toolbox or in the Tools Manager—and then choose the **Icon** command from the Edit menu.

Workspace
The Icon Editor's workspace is where you draw the tool icons. See page 13-15.
Toolbox

The Icon Editor's toolbox contains these tools:

- grid switch
- eraser
- upload tool
- download tool
- delete tool
- end-of-list tool

Grid Switch

The grid switch turns the workspace's grid on and off. This grid is simply a drawing aid, like a template; it is not comparable to the grid in the main Artline workspace.

Eraser

Unless you have marked a block, clicking on the eraser clears the Icon Editor workspace entirely.

If you mark a block (page 13-16), clicking on the eraser deletes the block without affecting the rest of the icon.
Upload Tool

The upload tool copies a selected icon from the Icon Selector into the workspace.

When you click on the upload tool, the Icon Editor displays an alert asking if you want the icon currently in the workspace to be replaced.

☐ Click on OK if you do not mind losing the current icon.
☐ Click on Cancel if you do not want to lose the current icon. You can preserve it by first using the download tool or the end-of-list tool.

Download Tool

The download tool copies an icon from the workspace to the Icon Selector, replacing the icon currently selected there.

You can use the download tool to preserve an icon for later use. The download tool differs from the end-of-list tool in that it does not add to the total number of icons in the Icon Selector.

Delete Tool

The delete tool removes the currently selected icon from the Icon Selector. Deleted icons cannot be undeleted.

End-of-List Tool

The end-of-list tool copies an icon from the workspace to the end of the list of icons in the Icon Selector.

You can use the end-of-list tool to preserve an icon for later use. The end-of-list tool differs from the download tool in that it does not replace any icons in the Icon Selector but does add to the total number of icons.
Icon Editor

Icon Selector

The Icon Selector holds tool icons you can use as starting points for the icons you are creating.

- To copy a selected icon from the Icon Selector to the workspace, use the upload tool.
- To replace a selected icon in the Icon Selector with the icon in the workspace, use the download tool.
- To delete a selected icon from the Icon Selector, use the delete tool.
- To copy the icon in the workspace to the end of the list of tools in the Icon Selector, use the end-of-list tool.

Scrolling the Icon Selector

The Icon Selector can hold more icons than can be displayed at one time. You can scroll the icons in the Icon Selector by clicking on an arrow, clicking in the scroll bar, or dragging the slider.

Basic Drawing Techniques

Icons are made of individual black and white dots called pixels. In drawing an icon, you are actually changing pixels from white to black or from black to white; the action of the mouse changes the pixel to its opposite state.

To draw one pixel at a time:

Click in the Icon Editor’s workspace.

- If you click on a white pixel, it changes to black.
- If you click on a black pixel, it changes to white.
To draw more than one pixel at a time:

*Drag* in the Icon Editor's workspace.

- If you start on a white pixel, all pixels touched by the pointer are changed to black.
- If you start on a black pixel, all pixels touched by the pointer are changed to white.

**Marking Blocks**

You can mark rectangular areas of the Icon Editor workspace as a block, much as you would mark a block of text in a word processing program. Having marked a block, you can then delete it or move it.

To mark a block of pixels, hold down the **Alt** key as you drag a selector box around the area you want. The block is indicated by a gray pattern.

**Deleting Blocks**

To delete a block, click on the eraser in the Icon Editor's toolbox. Deleted blocks cannot be undeleted.
Moving Blocks

To move a block, drag it where you want it. The block will completely overwrite the area to which you move it.

Unmarking Blocks

To unmark a block, click anywhere in the Icon Editor workspace outside the block.

Drawing a Straight Line

To draw a horizontal or vertical straight line, hold down the Ctrl key as you drag in the Icon Editor workspace. Remember that the line will be the opposite color from your starting point. If you start on a white pixel, the line will be black. If you start on a black pixel, the line will be white, in effect erasing pixels in a straight line.

Drawing a Pixel Rectangle

To draw a rectangular outline, hold down the Shift key and drag. As you drag, the Icon Editor shows you a gray-colored preview of the rectangle. Like the straight line, the rectangle will be the opposite color from your starting point—a black rectangle if you start on a white pixel; a white rectangle if you start on a black pixel.
The next two sections describe the commands in the Tools Manager’s two menus.

Note that the Tools Manager menus list keyboard command equivalents. When the Tools Manager is open, these keyboard commands are activated, and the keyboard commands in Artline’s main menus are inactive.

**File Menu**

This section describes the commands in the Tools Manager’s File menu.

<table>
<thead>
<tr>
<th>File</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reset</td>
</tr>
<tr>
<td>Load...</td>
</tr>
<tr>
<td>Save</td>
</tr>
<tr>
<td>Save As...</td>
</tr>
<tr>
<td>Close</td>
</tr>
</tbody>
</table>

**Reset Command**

The **Reset** command replaces the current tools file with the tools in the file ARTLINE.TLS. When you choose the **Reset** command, Artline displays the following alert:

![Alert](image)

The alert’s Cancel button gives you the option of canceling the **Reset** command and returning to the Tools Manager to save any changes you have made to the current tools file.
Load Command

The **Load** command displays the Item Selector so you can load another tools file in place of the current one. When you choose the **Load** command, the Item Selector defaults to the .TLS extension and its directory window lists only files with that extension.

Save Command

The **Save** command saves the current selection and arrangement of tools in the toolbox into the currently loaded tools file.

If you have turned on backups of your tools files in the Global Preferences dialog (page 9-2), the previous version of the tools file is kept, with the extension $LS.

If tools file backups are not turned on, saving the current file overwrites the previous saved version.

**CAUTION:** Save any modifications to a tools file you want to keep. The changes to your toolbox are kept in ARTLINE.INI, but if something happens to ARTLINE.INI, your modified tools will be lost if you have not saved the tools file.

Save As Command

The **Save As** command displays the Item Selector so you can save the current selection and arrangement of tools in the toolbox:

- under a new name;
- to another directory or disk.
Close Command

Clicking on the close box has the same effect as choosing the Close command.

The effect of the Close command depends on what level of the Tools Manager you are working in:

- If you are in the Tools Manager’s main level, the Close command removes the Tools Manager from the screen and returns you to the Artline workspace.
- If you are editing a container tool in the function editor, the Close command returns you to the main level of the Tools Manager.

Edit Menu

This section describes the commands in the Tools Manager’s Edit menu. Except for Add and Organize, these commands are available only when a tool is selected, either in the toolbox or in the Tools Manager.

Add Command

The Add command displays the Tool Attributes dialog as the first step in adding a new tool.

The Tool Attributes dialog is described on page 13-9.

Delete Command

Be careful when deleting tools. Deleted tools cannot be undeleted.

The Delete command removes a selected tool from the Tool Manager window.

As a safeguard, you cannot delete a tool directly from the toolbox; you must first drag it into the Tools Manager.
Duplicate Command

The **Duplicate** command makes a copy of a selected tool in the Tools Manager. Note that you cannot duplicate a tool while it is in the toolbox; you must first drag it to the Tools Manager.

A duplicate tool retains all the characteristics of the original, including its attributes and function.

Container Tools

The **Duplicate** command is the easiest way to make a container tool that repeats the same action several times.

For example, to make a dozen rotated copies of an element, you would make a container tool that holds eleven copies of a **Rotate** command tool. (The original element plus eleven copies equals twelve.)

The Function settings for each **Rotate** command tool would:

- define the center of rotation;
- set the angle of rotation;
- turn the Make Copy option on.

Attributes Command

The **Attributes** command displays the Tool Attributes dialog, which is described on page 13-9.
Function Command

The **Function** command’s display varies according to the currently selected tool.

- **standard tool**
  The tool’s options dialog is displayed so you can set specific options for that tool—for example, the Tracing Options dialog (Trace tool) or the Plane Options dialog (Plane tool).

  If the tool does not have an options dialog, the **Function** command is not available.

- **menu tool**
  The dialog associated with the command is displayed so you can pre-set command parameters—for example, the Image Options dialog (**Image Options** command) or the Set Grid dialog (**Set Grid** command).

  If the command does not display a dialog, the **Function** command is not available.

- **container tool**
  The Tools Manager switches to container editing mode.
  Creating a container tool is described on page 13-7.

Icon Command

The **Icon** command displays the Tools Manager’s Icon Editor, described on page 13-12.

Organize Command

The **Organize** command arranges the tool icons into neat rows and columns.
**Resident PostScript Fonts**

This appendix lists the names of the resident PostScript fonts and the names of their Artline counterparts.

<table>
<thead>
<tr>
<th>PostScript font name</th>
<th>Artline font name</th>
</tr>
</thead>
<tbody>
<tr>
<td>ITC Avant Garde®</td>
<td>Advantage</td>
</tr>
<tr>
<td>ITC Bookman®</td>
<td>Booker</td>
</tr>
<tr>
<td>Courier</td>
<td>Courier</td>
</tr>
<tr>
<td>Helvetica®</td>
<td>Nimbus Sans</td>
</tr>
<tr>
<td>Helvetica® Narrow</td>
<td>Suisse Thin</td>
</tr>
<tr>
<td>New Century Schoolbook</td>
<td>Scholar</td>
</tr>
<tr>
<td>Palatino®</td>
<td>Palladio</td>
</tr>
<tr>
<td>Times® Roman</td>
<td>Nimbus Serif</td>
</tr>
<tr>
<td>ITC Zapf Chancery®</td>
<td>Zapf Chancery</td>
</tr>
<tr>
<td>ITC Zapf Dingbats®</td>
<td>Wombat</td>
</tr>
<tr>
<td>Symbol</td>
<td>Symbol</td>
</tr>
</tbody>
</table>
Artline and Memory

This appendix describes how Artline uses system memory, expanded memory, and disk space.

Memory and Disk Requirements

To run Artline, your computer must have the following minimum amounts of free system memory, available disk space, and expanded memory:

- free system memory
  On systems with expanded memory, a minimum of 510Kb is required. On systems without expanded memory, a minimum of 540Kb is required.

- available disk space
  A minimum of 512Kb of disk space must be available on the drive on which the Artline application and system software files are installed.

- expanded memory
  Expanded memory is not required. However, a minimum of 512Kb of expanded memory must be available for Artline to be able to use it.

In addition, the following settings are suggested minimums for your CONFIG.SYS file:

    FILES = 20
    BUFFERS = 20
Not Enough Memory

If you do not have enough free RAM and available disk space, Artline cannot be started. The screen will switch to graphics mode, but when Artline detects that there is not enough memory, this alert is displayed:

![Alert: Not enough memory to run Artline.]

Remove desk accessories or memory-resident programs.

To make memory available, remove any desk accessories or other memory-resident programs. If you need more memory, reduce the BUFFERS count in CONFIG.SYS.

Expanded Memory

Artline can use expanded memory (also referred to as EMS) for loading images and other functions.

When you purchase a board with additional memory for your system, the memory can be configured as RAM (up to the limit of your system), expanded memory, or extended memory. To use extended memory as EMS, you must convert it to EMS by adding an expanded memory driver to your CONFIG.SYS file. For example, the line

```
DEVICE=C:\DRDOS\EMM386.SYS
```

loads the DR DOS™ 5.0 expanded memory driver.

As mentioned above, note that expanded memory is not required in this version of Artline. If enough expanded memory is available, however, Artline will use it.
Paging Files

If you do not have EMS or if there is not enough expanded memory to use, Artline opens a temporary \textit{paging file} in the directory in which ARTLINE.APP is located. This paging file converts a portion of your hard disk to "virtual expanded memory" so that you can still use all of Artline's features.

Lost Clusters

If your computer "crashes" at any time (due to a power failure or other unforeseen circumstance), you may find that a portion of your disk space is occupied by "lost clusters" that should be deleted.

To detect lost clusters, type the following command from the operating system prompt:

\texttt{CHKDSK \texttt{[d:]}} /F

where [d:] is the identifier for the drive on which Artline is installed. If you are already logged on to that drive, you need not include the drive identifier in the \texttt{CHKDSK} command.

Refer to your operating system manual for a description of the \texttt{CHKDSK} command and how to use it to remove lost clusters.

Memory Status

To display a dialog that includes information on how memory is being used, choose the \textbf{Artline Info} command from the ARTLINE menu (at the right end of the menu bar).

This dialog tell whether expanded memory is being used and, if so, how much is being used.
Custom Toolboxes

This appendix describes the five custom toolboxes included with the Artline installation. These toolboxes are contained in the following files:

- 1_COLUMN.TLS
- 4_COLUMN.TLS
- ALIGN.TLS
- CUSTOM.TLS
- TRACE.TLS

The Artline installation program placed these files in the \ARTLINE\TOOLS directory on the same drive that contains the Artline application files.

You can use the custom toolboxes as they come "out of the box," or you can use them as templates, the starting point for creating your own toolboxes.

Opening and using custom toolboxes is described in Chapter 13.
The tools in 1_COLUMN.TLS are a subset of those contained in ARTLINE.TLS, arranged in a single column to give you a larger workspace. The tools' icons and functions are identical to those described in Chapter 2.

To use the Fill Color tool for fountains or line color, double-click on the tool and change its function in the Color Tool Options dialog (see page 2-44).
The tools file 4_COLUMN.TLS contains all but one of the tools contained in ARTLINE.TLS. (The absent tool is the Rounded Rectangle tool.)

This toolbox is primarily intended for low-resolution systems—such as those using CGA monitors—where the standard toolboxes are too “tall” for the screen.

- Selector, View tool, Layer tool, Magnifier
- Line tool, Quill, Sketch tool, Trace tool
- Rectangle tool, Circle tool, Plane, Text tool
- Fill Color tool, Fountain tool, Line Color tool, Line Width tool
- Flipper, Rolling Pin, Thumbtack, Rotator
The tools file ALIGN.TLS contains the same tools as ARTLINE.TLS, arranged in three columns, plus a special alignment tool.

- Selector, View tool, Magnifier
- Trace tool, Layer tool, Text tool
- Rectangle tool, Rounded Rectangle tool, Circle tool
- Quill, Sketch tool, Line tool
- Fill Color tool, Fountain tool, Line Color tool
- Plane, Rolling Pin, Line Width tool
- Flipper, Thumbtack, Rotator
The components of the alignment tool are shown below.

- Align top left, top center, top right
- Align left middle, center middle, right middle
- Align bottom left, bottom center, bottom right
- Align top (no horizontal change)
- Align middle (no horizontal change)
- Align bottom (no horizontal change)
- Align left, center, right (no vertical change)
- Align to Grid menu command tool

The **Align** command is described on page 6-9.

**CAUTION:** The alignment tool is made up of many small pieces carefully assembled. For that reason, we recommend that you not try to copy it to another toolbox or move it within this toolbox.
The tools file CUSTOM.TLS contains the same tools as ARTLINE.TLS, in the same arrangement, plus six extra tools described below.

Mask tool

Merge tool

StatusRuler tool

Blend tool

To Curves tool

Rotate Grow tool

Mask Tool

The Mask tool is a menu tool for the **Mask** command (page 8-1). The Draw Mask Element option is turned off.
Blend Tool

The Blend tool is a menu tool for the **Blend** command (page 8-8). This tool blends the selected elements in ten steps. The Reverse Curve Direction option is turned off.

Merge Tool

The Merge tool is a menu tool for the **Merge Elements** command (page 8-4).

To Curves Tool

The To Curves tool is a menu tool for the **Convert to Curves** command (page 8-18).

StatusRuler Tool

The StatusRuler tool toggles the current state of the status line and the rulers. For example, if both are turned off, clicking on the StatusRuler tool turns them on. If the status line is off and the ruler is on, clicking on the StatusRuler tool turns the status line on and the ruler off.

Rotate Grow Tool

The Rotate Grow tool is a container that holds six sets of the three commands described below:

- A **Rotate** command tool, with a 30° Rotation Angle around the Selection Center—Make Copy turned **on**.
- A **Scale** command tool, set for 110% Uniform scaling around the Selection Center—Make Copy turned **off**.
- A **Move** command tool, with both the Horizontal and Vertical distance set to 0.20 inches—Make Copy turned **off**.

When you click on this tool, the selected element is rotated 30° and copied, scaled 110%, and then moved down and to the right 0.20 inches—and then the sequence is repeated five more times.
The tools file TRACE.TLS contains a set of custom tools designed to expedite image tracing.

TRACE.TLS has five Trace tools with pre-set precision percentages of 0%, 25%, 50%, 75% and 100%. (Tracing precision is described on page 11-9.) Each tool has a gap size of zero and is set for Line Art.

TRACE.TLS includes tools for the following menu commands (references are to the pages on which the commands are described in detail):

- **Load Image** (4-1)
- **Image Options** (11-4)
- **Save As** (3-6) and **Save** (3-5)
- **Unload Image** (4-3)
- **[Hide/Show] Image** (5-2)
- **Cut** (7-2)
Index

The following is a list of the major entry categories in this Index, where much of the information in the *Artline User Reference Guide* can be found:

- alerts
- elements
- commands
- files
- dialogs
- tools

Dialogs illustrated in the guide are indexed by the name that appears in the dialog's title bar.
Alerts illustrated in the guide are indexed by the first line of text in the alert message.

**Misc.**

- $.SEM extension, 9-2
- $.LS extension, 9-2, 13-3
- $.OL extension, 9-2
- 1_COLUMN.TLS, C-2
- 4_COLUMN.TLS, C-3
- $ symbol, xviii

**A**

- **Abandon** command, 3-9
  - “Abandon/Save” alert, 3-2
- **Active** command (Layer Mgr), 10-16
  - Active Layer (Export command), 3-7
- **Add Color** command (Color Mgr), 12-9, 12-26
- **Add** command (Tools Mgr), 13-20
- **Add Fill** command (Color Mgr), 12-12, 12-26
- **Add Layer** command (Layer Mgr), 10-5, 10-13
- **Add Point** command (Plane tool pop-up), 2-58
  - adding colors, 12-9
  - adding fountains, 12-12
  - alerts, 1-19
    - exit buttons, 1-19
    - “Abandon/Save,” 3-2
    - “Cannot find tracing image,” 11-10, 11-15
    - “Cannot trace segment,” 11-11
    - “Merging multiple-layer file,” 3-4, 10-7
- **Align** command, 6-8
- **Align Horiz** command (Plane tool pop-up), 2-62
- **Align to Grid** command, 6-7
- **Align Vert** command (Plane tool pop-up), 2-62
- **ALIGN.TLS**, C-4
  - aligning elements, 6-8
  - alignment tool in ALIGN.TLS, C-4
- **All** command (Layer Mgr), 10-16
  - anchor points, 2-20
  - arrows (scrollers), 1-6
- **Artline Info** command, 3-2
- **ARTLINE.COL**
  - loaded by New command, 3-2
- **ARTLINE.INI**, 9-5 - 9-6, 13-2
  - ascender, 2-33
- **Attributes** command (Tools Mgr), 13-21
- **Auto (Create Text Item dialog)**, 2-33
- **Auto Redraw** command (Layer Mgr), 10-20
  - autotracing
    - See “tracing”
B
Backspace key
deleting points drawn with Quill, 2-27
backup files, 9-2
saving, 3-5
bit-image files, 11-1
Blend command, 8-8
Blend tool (CUSTOM.TLS), C-7
blends, 8-8
colors in, 8-12
converting to curves, 8-19
elements not permitted, 8-12
rainbow effect, 8-13
splitting, 8-20
Brightness (HSB color model), 12-7
Bring to Front command, 6-2
BUFFERS setting (CONFIG.SYS), B-1

C
Cancel button, 1-18
caps
See “line end styles”
CGA monitors, C-3
check boxes, 1-15
CHKDSK command, B-3
Circle tool, 2-39
circles
drawing, 2-40
drawing from center, 2-40
screen distortion, 2-40
click (mouse technique), 1-8
clip art, xvi
Clone command, 2-63, 7-5, 8-13
Close command (Color Mgr), 12-24
Close command (Layer Mgr), 10-3, 10-14
Close command (Tools Mgr), 13-20
clusters, B-3
CMY color model, 12-5
compared to RGB and HSB, 12-8
converting to CMYK, 12-8
Color & Patterns (Image Options dialog), 11-4
color correction, 3-19
color files, 12-3
adding colors, 12-11
adding fountains, 12-19
creating, 12-20
Color Manager, 12-1
Colors mode, 12-9
Fills mode, 12-12
modifying colors, 12-10
modifying fountains, 12-18
Color Manager command, 12-1
color models, 12-5
CMY, 12-5
color separation, 3-16
colors
adding to color file, 12-11
availability in Color Manager and tools, 12-3
creating, 12-9
deleting from color file, 12-25
hiding, 5-2
loading PANTONE, 12-22
modifying, 12-10
PANTONE, 12-21
picture, 12-4
removing from color file, 12-11
unaffiliated, 12-4
Colors command, 5-2
Colors command (Color Mgr), 12-9, 12-27
Colors mode (Color Mgr), 12-9
Combine menu (Color Mgr), 12-20
commands
available and unavailable, 1-13
choosing, 1-12
keyboard equivalents, 1-13
toggles, 5-1
Abandon, 3-9
Active (Layer Mgr), 10-16
Add (Tools Mgr), 13-20
Add Color (Color Mgr), 12-9, 12-26
Add Fill (Color Mgr), 12-12, 12-26
Add Layer (Layer Mgr), 10-5, 10-13
Add Point (Plane tool pop-up), 2-58
Align, 6-8
Align Horiz (Plane tool pop-up), 2-62
Align to Grid, 6-7
Align Vert (Plane tool pop-up), 2-62
All (Layer Mgr), 10-16
Artline Info, B-3
compound curves, 2-23
drawing, 2-24
CONFIG.SYS, B-1 - B-2
container tools, 13-5
creating, 13-7
contrast (tracing options), 11-15
Convert to Curves command, 8-18
Copy command, 7-3
copying elements, 2-9
corner points, 2-20
Courier font
  PostScript resident form, 9-8
creating color files, 12-20
creating colors, 12-9
creating fountains, 12-12
crop marks
  See “trim marks”
cross and crosshair (pointer forms), 2-22
Ctrl-click element selection, 2-4
curves
  adding lines, 2-25
  compound, 2-23 - 2-24
drawing, 2-23
editing, 2-56
re-opening, 2-27
simple, 2-23 - 2-24
solid tangent edits, 2-56
Custom (Create Text Item dialog), 2-33
Custom paper size, 3-15
custom toolboxes, C-1
  1_COLUMN.TLS, C-2
  4_COLUMN.TLS, C-3
  ALIGN.TLS, C-4
  CUSTOM.TLS, C-6
  TRACE.TLS, C-8
custom views, 2-16
CUSTOM.TLS, C-6
Cut command, 7-2
desk accessories, B-2
dialogs, 1-14
  check boxes, 1-15
clearing fields, 1-15
direct entry fields, 1-15
exit buttons, 1-18
exiting, 1-18
memory information, B-3
moving, 1-19
pop-up menus, 1-17
pop-up sliders, 1-17
radio buttons, 1-14
Add Color, 12-9
Add Fill, 12-12
Add Layer, 10-4, 10-9
Blend Elements, 6-13, 8-9
Color Manager, 12-1
Color Tool Options, 2-44
Create Text Element, 2-30, 6-13
Custom Page Size, 3-10
Custom Size, 2-32
Element Alignment, 6-8
Element Info, 6-12
Export Picture, 3-7
Font Manager, 9-7
Global Preferences, 9-2
Guide Lines, 5-9
Image Options, 11-4
Layer Manager, 10-2
Line Attributes, 2-48
Line Options, 2-41
Mask Elements, 6-13, 8-3
Modify Layer, 10-8
Move Elements, 7-6
Page Layout, 3-10
PostScript Options, 3-17
PostScript Output, 3-13
Preview Curve, 11-12
Rectangle Options, 2-38
Rotate Elements, 7-7
Rotator Options, 2-51
Run Application, 3-21
Scale Elements, 7-9
Selector Options, 2-11
Set Grid, 5-7
Text Along a Path, 6-13, 8-14
Tool Attributes, 13-9
Tools Manager, 13-1
Tracing Options, 11-7, 11-14
zingbats
See “Wombat characters”
direct entry fields, 1-15
direction points, 2-23, 2-56
directory path
changing in Item Selector, 1-22
directory tree, 1-22
disk space requirements, B-1
documentation set, xvi
dot screen (fountains), 12-16
dot screens, 3-17
double-click (mouse technique), 1-8
DR DOS 5.0 (operating system), B-2
drag (mouse technique), 1-9
Draw Mask Element (Mask Elements dialog), 8-3
drawing surface, 1-5
drop-down menus, 1-12
Duplicate command, 2-63, 7-5
Duplicate command (Color Mgr), 12-25
Duplicate command (Tools Mgr), 13-21
duplicating, 7-5
flipping, 2-64
groups, 6-5
information dialog, 6-12
locking, 6-4
masking, 8-1
merging, 8-4
moving, 7-6
moving from layer to layer, 10-6
moving or scaling with grid snap on, 5-6
moving with Element Info dialog, 6-12
pasting from buffer, 7-3
rainbow effect, 8-13
rotating, 2-50, 7-7
scaling, 2-7, 7-9
scaling with Element Info dialog, 6-12
selected, 2-2
selecting, 2-3
selecting (table), 2-5
selecting all, 2-4, 7-4
selecting element on bottom of stack, 2-4
selecting overlapping elements (F4 key), 2-4
splitting, 8-20
stacks, 1-10, 10-1
ungrouping, 6-6
unlocking, 6-4
ellipses
See “circles”
EMM386.SYS, B-2
EMS
See “expanded memory”
encapsulated PostScript, 3-14
EPS file format
opening in Artline, 3-3
EPSF, 3-14
ESC key
as Cancel button, 1-18 - 1-19
to redraw screen, 1-7
exit buttons, 1-18
J key shortcut, 1-18 - 1-19
Esc key shortcut, 1-18 - 1-19
“exit the dialog,” 1-18
expanded memory, B-2
drivers, B-2
requirements, B-1
virtual, B-3
Export command, 3-7
Active Layer option, 3-7
Multiple .GEM Files option, 3-9, 10-11
Multiple-Page .GMP File option, 3-9, 10-11
Selected Elements option, 3-8
Single-Sheet .GEM File option, 3-9
Slides option, 3-8, 10-11
Spot Colors option, 3-8
Visible Layers option, 3-7
exporting files, 3-7
extensions, 1-11

F

file formats
valid for Artline, 3-3
valid for merging, 3-5
File menu, 3-1
file types, 1-11
files
backup, 9-2
bit-image, 11-1
exporting, 3-7
merging, 3-4
merging from multiple layers, 3-4
merging from one layer, 3-4
opening, 3-3, 9-3
saving, 3-5
saving for first time, 3-6
saving to directory or disk, 3-6
saving under new name, 3-6
vector, 11-1
FILES setting (CONFIG.SYS), B-1
Fill Color tool, 2-42
New Color option, 12-9
fills
See “fountains”
Fills command (Color Mgr), 12-12, 12-27
Fills mode (Color Mgr), 12-12
flip line, 2-64
Flipper tool, 2-64
copying elements, 2-64
font attributes
Download, 9-9
Resident, 9-8
Vector, 9-9
font filters, xvi
Font Manager, 9-7
Font Manager command, 9-7
fonts
adding, 9-10
Artline equivalents of resident PostScript
set, A-1
attributes, 9-8
downloading to PostScript, 9-9
removing, 9-10
Fountain tool, 2-42
New Fill option, 12-12
fountains, 12-2
adding to color file, 12-19
creating, 12-12
even (gradation), 12-14
grouped elements, 6-6
hiding, 5-3
linear, 12-14
log (gradation), 12-14
modifying, 12-18
multi-color rainbow effect, 8-13
PostScript Fill Options, 12-15
radial, 12-14
removing from color file, 12-19
See also “colors”
Fountains command, 5-3
full box, 1-7
full view, 2-17
Function command (Tools Mgr), 13-22

G
gap size, 11-8
.GEM file format, 3-3
gradation (fountains), 12-14
grey levels (tracing options), 11-15
grayscale images, 11-8
tracing, 11-14
grid, 5-6, 6-7
setting spacing, 5-7
snap, 5-6
spacing, 5-7
Grid command, 5-6
grid snap, 5-6
turn off for tracing, 11-16
Group command, 6-5
groups, 6-5
maximum nested levels, 6-6
nesting, 6-6
guide lines, 5-8
  aligning to, 6-8
  moving, 2-10
  position, 5-9
  rotating around, 7-7
  scaling relative to, 7-10
Guide Lines command, 5-8

halftone screen frequency, 3-18
handles, 2-2
  effects of dragging (scaling), 2-7
HSB color model, 12-6
  Brightness, 12-7
  compared to CMY and RGB, 12-8
  Hue, 12-6
  Saturation, 12-7
Hue (HSB color model), 12-6

Icon command (Tools Mgr), 13-22
Icon Editor (Tools Mgr), 13-12
Icon Selector (Tools Mgr), 13-9, 13-15
icons
  drawing, 13-15
Image command, 4-3, 5-2
image files, 11-1
image frame, 11-3
Image menu, 4-1
image options, 11-4
  saving, 11-6
Image Options command, 4-3, 11-4
images
  grayscale, 11-8
  hiding, 5-2
  line art, 11-8
  loading, 4-1, 11-2
  options, 4-3, 11-4
  tracing, 4-1
  unloading, 4-3
  valid formats, 11-2
.IMG extension, 4-1
IMG file format, 11-2
.IMG files
  valid formats for tracing, 4-2

insufficient memory, B-2
Item Selector, 1-20
  changing directory path, 1-22
  choosing files, 1-23
  Directory line, 1-21
  editing keys, 1-22
  list window, 1-21
  wildcards, 1-21

Join Points command (Plane tool pop-up), 2-59
junction points, 2-20

keyboard commands, 1-13
keyboard shortcuts, 1-13

Landscape page orientation (Page Layout), 3-11
Landscape paper orientation (PostScript output), 3-15
Layer Manager, 10-1
  circle marker, 10-16
  closing, 10-3
  display markers, 10-16
  displaying, 10-2
  light bulb marker, 10-16
Layer Manager command, 10-2
Layer tool, 2-13, 10-2
layers, 10-1
  activating, 10-3
  activating with PgUp and PgDn, 2-13
  adding, 10-4
  changing order, 10-5
  combining into single layer, 10-6
  default, 10-4
  display markers, 10-16
  display status saved with file, 3-5, 10-15
  displaying as overlays, 10-18
  displaying selected layers, 10-18
  limits on number, 10-2
printing slides, 10-11
slide background, 10-8
slide foreground, 10-9
slides, 10-8
Visible status, 10-17
leading
See “line spacing”
line art images, 11-8
line attributes
setting, 2-48
Line Color tool, 2-42
   New Color option, 12-9
line end styles, 2-48
line screen (fountains), 12-16
line screens, 3-17
line spacing, 2-32
   Auto, 2-33
   Custom, 2-33
   Solid, 2-33
   table, 2-33
Line tool, 2-41
line width
   screen and printer limitations, 2-47
Line Width tool, 2-47
linear fountains, 12-14
lines
   adding curves, 2-25
List (color selector), 2-45
Load command (Color Mgr), 12-23
Load command (Tools Mgr), 13-19
Load Image command, 4-1, 11-3
loading images, 11-2
Lock command, 2-54, 6-4
lost clusters, B-3

memory
dialog showing usage, B-3
not enough to start Artline, B-2
memory requirements, B-1
memory-resident programs, B-2
menu bar, 1-3
menu tools, 13-5
   creating, 13-6
menus
displaying, 1-12, 9-3
drop-down, 1-12
pull-down, 1-12
undisplaying, 1-13
Combine, 8-1
Edit, 7-1
Element, 6-1
File, 3-1
Image, 4-1
Options, 9-1
View, 5-1
Merge command (Color Mgr), 12-24
Merge Elements command, 8-4
Merge File command, 3-4
Merge tool (CUSTOM.TLS), C-7
merged elements, 8-4
   characteristics, 8-5
   splitting, 8-20
merging files with layers, 3-4
minus (-) key
direct entry fields, 1-16
Modify Color dialog
displaying, 12-10, 12-18
Modify command (Color Mgr), 12-10, 12-18, 12-26
Modify Layer command (Layer Mgr), 10-14
modifying colors, 12-10
modifying fountains, 12-18
moiré patterns, 3-18
mouse techniques, 1-8
   click, 1-8
double-click, 1-8
   drag, 1-9
Move command, 7-6
Multiple .GEM Files (Export command), 3-9, 10-11
Multiple-Page .GMP File (Export command), 3-9, 10-11
nested groups
  maximum number of levels, 6-6
New Color option (Fill Color and Line Color tools), 12-9
New command, 3-2
New Fill option (Fountain tool), 12-12
New Layer (Layer tool), 10-4
New View option (View tool), 2-16
notational conventions, xviii

Offsets (Image Options dialog), 11-6
Offsets (Page Layout dialog), 3-11
OK button, 1-18
Open command, 3-3
opening files, 3-3
Options menu, 9-1
Organize command (Tools Mgr), 13-22
Output, xvi
  displaying slides, 10-12
  starting, 3-24

Page Layout command, 3-10
page orientation, 3-11
paging files, B-3
Palette (color selector), 2-45
PANTONE colors, 12-21
  loading, 12-22
paste buffer, 7-2
Paste command, 7-3
PCX file format, 4-1, 11-2
.PCX files
  valid formats for tracing, 4-2
PgDn key
  activating layers, 2-13, 10-3
  direct entry fields, 1-16
PgUp key
  activating layers, 2-13, 10-3
  direct entry fields, 1-16
picture colors, 12-4
pixels, 11-1, 13-15

Plane tool, 2-53
  selecting points, 2-54
  turns off fill and lines, 2-53
plus (+) key
  direct entry fields, 1-16
points
  anchor points, 2-20
  corner points, 2-20
  deleting, 2-27
  junction points, 2-20
  mapping in blends, 8-10
  moving with grid snap on, 5-6
  selecting with Plane, 2-54
  tangent points, 2-20
polygons
  drawing, 2-25
pop-up menus, 1-17
pop-up sliders, 1-17
Portrait page orientation (Page Layout), 3-11
Portrait paper orientation (PostScript output), 3-15
PostScript command, 3-13
PostScript file output, 3-14
PostScript Fill Options, 12-15
PostScript fonts
  Artline equivalents, A-1
PostScript output, 3-13
  color separation, 3-16
  paper orientation, 3-15
  paper size, 3-15
  picture scaling, 3-15
  resolution, 3-18
  slides, 3-16, 10-11
PostScript printers, 9-8
  resident fonts, 9-8
precision (tracing options), 11-9
preferences, 9-2
  restoring original set, 9-9
  saved in ARTLINE.INI, 9-5
  saving, 9-5
Preferences command, 9-2
process colors, 12-5
pull-down menus, 1-12
Quill tool, 2-22
adding curves to lines, 2-25
adding lines to curves, 2-25
closing elements, 2-24
drawing curves, 2-23
drawing polygons, 2-25
pointer forms, 2-22
re-opening curves, 2-27
Quit command, 3-24
quitting Artline, 3-24

radial fountains, 12-14
radio buttons, 1-14
Rectangle Options dialog, 2-38
Rectangle tool, 2-36
rectangles
drawing, 2-36
drawing from center, 2-37
redrawing the screen, 1-7
Redraw command (Layer Mgr), 10-20
Redraw Speed (Global Preferences dialog), 9-4
registration marks (Page Layout dialog), 3-11
registration marks (PostScript Output dialog), 3-20
Remove Layer command (Layer Mgr), 10-14
Repeat command, 7-12
Reset command (Color Mgr), 12-20, 12-23
Reset command (Tools Mgr), 13-18
resident fonts, 9-8
Reverse Curve Direction (Blend Elements dialog), 8-10
RGB color model, 12-6
compared to CMY and HSB, 12-8
rolling pin tool, 2-65
root directory, 1-22
Rotate command, 7-7
Rotate Grow tool (CUSTOM.TLS), C-7
Rotator tool, 2-50
rounded rectangle
drawing, 2-36
Rounded Rectangle tool, 2-38
rulers, 5-3
Rulers command, 5-3
Saturation (HSB color model), 12-7
Save As command, 3-6
Save As command (Color Mgr), 12-24
Save As command (Tools Mgr), 13-19
Save command, 3-5
Save command (Color Mgr), 12-24
Save command (Tools Mgr), 13-19
Save Preferences command, 9-5
saving files, 3-5
backup files, 3-5
Scale command, 7-9
Scaling (Image Options dialog), 11-5
scaling elements, 2-7
screen, 1-2
drawing surface, 1-5
full box, 1-7
menu bar, 1-3
redrawing, 1-7
scrollers, 1-6
size box, 1-7
surround, 1-5
title bar, 1-3
toolbox, 1-2
window, 1-2
workspace, 1-5
Screen Angle (PostScript Fill Options dialog), 12-17
screen angle (PostScript output), 3-18
Screen Function (PostScript Fill Options dialog), 12-16
Screen Resolution (PostScript Fill Options dialog), 12-17
scroll bars, 1-6
scrollers, 1-6
arrows, 1-6
scroll bars, 1-6
sliders, 1-7
Select All command, 2-4, 7-4
Selected Elements (Export command), 3-8
selecting elements, 2-12
selecting overlapping elements (F4 key), 2-4
selection frame, 2-2
Selector Options, 2-11
Selector tool, 2-2
using other tools as, 2-12
Send to Back command, 6-2
Set Grid command, 5-7
Set Guide Lines command, 5-9
Shift key
  direct entry fields, 1-16
  pop-up sliders, 1-17
simple curves, 2-23
drawing, 2-24
Single-Sheet .GEM File (Export command), 3-9
size box, 1-7
Sketch tool, 2-28
sliders, 1-7
slides, 10-8, 10-19
  background layer, 10-8
  creating, 10-8
  foreground layer, 10-9
  limit on length of filename (Export), 3-9
  printing, 10-11
  screen displays, 10-12
Slides (Export command), 3-8, 10-11
Slides command (Layer Mgr), 10-19
Smooth command (Plane tool pop-up), 2-60
Snap to Grid command, 5-6
Solid (Create Text Item dialog), 2-33
Sort by Bright command (Color Mgr), 12-28
Sort by Hue command (Color Mgr), 12-28
Sort by Name command (Color Mgr), 12-28
Split Element command, 8-20
Split Point command (Plane tool pop-up), 2-59
spot colors, 3-8
Spot Colors (Export command), 3-8
squares
  drawing, 2-37
  drawing from center, 2-37
  screen distortion, 2-37
stacks, 1-10, 10-1
standard tools, 13-4
  creating, 13-6
status line, 5-4
Status Line command, 5-4
StatusRuler tool (CUSTOM.TLS), C-7
Step in Back command, 6-2
Step in Front command, 6-2
surround, 1-5
Symbol characters
  not displayable in text window, 2-35
Symmetric command (Plane tool pop-up), 2-60

tangent lines, 2-23, 2-56
tangent points, 2-20, 2-23, 2-56
text
  converting to curves, 8-18
  editing keys (table), 2-35
  group after converting to curves, 8-18
  line spacing, 2-32
  masking with, 8-3
  merging with, 8-7
  placing along a path, 8-14
  PostScript printers, 9-8
  re-opening for editing, 2-35
text along a path, 8-14
  converting to curves, 8-18
  splitting, 8-20
Text Along Path command, 8-14
text characters
  creating with Merge, 8-7
Text tool, 2-30
Thumtack, 2-63
  aligning to, 6-8
  rotating around, 7-7
  scaling relative to, 7-10
TIFF file format, 4-1, 4-2, 11-2
TIFF preview
  EPSF output, 3-14
Title bar, 1-3
.TLS extension, 13-2
To App command, 3-21
To Curve command (Plane tool pop-up), 2-59
To Curves tool (CUSTOM.TLS), C-7
To Line command (Plane tool pop-up), 2-58
To Output command, 3-24
toggles, 5-1
Tool Attributes dialog (Tools Mgr), 13-9
tool icons
  selecting, 13-9, 13-15
toolbox, 1-2
  arranging tools, 13-4
  changing default, 13-2
  changing size, 13-3
  custom, C-1
  default, 13-2
  hiding, 2-2, 5-10
low-resolution systems, C-3
See also "custom toolboxes"
**Toolbox command**, 2-2, 5-10

- **tools**
  - container, 13-5
  - creating custom, 13-6 - 13-7
  - drawing icons, 13-15
  - maximum allowed in toolbox, 13-6
  - menu, 13-5
  - moving, 13-4
  - standard, 13-4
  - Circle, 2-39
  - Fill Color, 2-42
  - Flipper, 2-64
  - Fountain, 2-42
  - Layer, 2-13
  - Line, 2-41
  - Line Color, 2-42
  - Line Width, 2-47
  - Magnifier, 2-17
  - Plane, 2-53
  - Quill, 2-22
  - Rectangle, 2-36
  - Rotator, 2-50
  - Rounded Rectangle, 2-38
  - Selector, 2-2
  - Sketch, 2-28
  - Text, 2-30
  - Thumbtack, 2-63
  - Trace, 2-29
  - View, 2-14

- **tools files**, 13-2
- **Tools Manager**, 13-1
  - Icon Editor, 13-12
- **Tools Manager command**, 13-1

- **trace segments**, 11-11
- **Trace tool**, 2-29
- **TRACE.TLS**, C-8

**tracing**
- advancing or backing up, 11-13
- autotrace contrast, 11-15
- autotrace options, 11-7
- autotrace precision, 11-9
- autotrace techniques, 11-10
- autotracing, 11-2
- autotracing—typical steps, 11-7
- canceling autotrace, 11-14
- changing autotrace precision, 11-13
- direction of autotrace line, 11-9
- gray levels, 11-15

- **grayscale images**, 11-14
- **hand tracing**, 11-2, 11-16
- **image frame**, 11-3
- **image options**, 11-4
- **loading the image**, 11-2
- **saving image options**, 11-6
- **stopping autotrace**, 11-12
- **trace segments (part of the image)**, 11-11
- **valid image file formats**, 4-2, 11-2

- **trim marks (Page Layout dialog)**, 3-11
- **trim marks (PostScript Output dialog)**, 3-20

- **typefaces**
  - See “fonts”

**U**

- **undercolor removal**, 3-19
- **Undo command**, 7-2
- **Ungroup command**, 6-6
- **Unload Image command**, 4-3
- **Unlock command**, 6-4

**V**

- **vector files**, 11-1
- **View menu**, 5-1
- **View Tool**, 2-14
- **views**
  - defining, 2-16
- **virtual expanded memory**, B-3
- **Visible command (Layer Mgr)**, 10-17
- **Visible Layers (Export command)**, 3-7

**W**

- **wildcards**, 1-21
- **window**, 1-2
  - moving, 1-3
- **Wombat characters**
  - not displayable in text window, 2-35
- **workspace**, 1-5

**Z**

- **zooming**, 2-17